MapleSim User's Guide

Copyright

Maplesoft, MapleSim, and Maple are all trademarks of Waterloo Maple Inc.

© Maplesoft, a division of Waterloo Maple Inc. 2008-2014. All rights reserved.

No part of this book may be reproduced, stored in a retrieval system, or transcribed, in any form or by any means — electronic, mechanical, photocopying, recording, or otherwise. Information in this document is subject to change without notice and does not represent a commitment on the part of the vendor. The software described in this document is furnished under a license agreement and may be used or copied only in accordance with the agreement. It is against the law to copy the software on any medium except as specifically allowed in the agreement.

Linux is a registered trademark of Linus Torvalds.

Macintosh is a trademark of Apple Inc., registered in the U.S. and other countries.

Microsoft, Excel, and Windows are registered trademarks of Microsoft Corporation.

Modelica is a registered trademark of the Modelica Association.

All other trademarks are the property of their respective owners.

This document was produced using Maple and DocBook.

Contents

Introduction ................................................................................................ xiii
1 Getting Started with MapleSim ................................................................. 1
  1.1 Physical Modeling in MapleSim ............................................................. 1
    Topological or “Acausal” System Representation .................................... 1
    Mathematical Model Formulation and Simplification ............................. 1
    Advanced Differential Algebraic Equation Solvers ................................. 1
    Acausal and Causal Modeling ................................................................. 2
  1.2 The MapleSim Window ......................................................................... 6
  1.3 Basic Tutorial: Modeling an RLC Circuit and DC Motor ......................... 7
    Building an RLC Circuit Model .............................................................. 8
    Specifying Component Properties ......................................................... 11
    Adding a Probe .................................................................................. 12
    Simulating the RLC Circuit Model ......................................................... 13
    Building a Simple DC Motor Model ....................................................... 14
    Simulating the DC Motor Model .......................................................... 16
2 Building a Model ...................................................................................... 17
  2.1 The MapleSim Component Library ....................................................... 17
    Viewing Help Topics for Components ................................................... 18
    Updating Models Created in MapleSim 4 or Earlier ................................ 18
  2.2 Browsing a Model ............................................................................... 18
    Model Tree ....................................................................................... 19
    Model Navigation Controls .................................................................. 19
  2.3 Defining How Components Interact in a System .................................... 20
  2.4 Specifying Component Properties ....................................................... 21
    Specifying Parameter Units .................................................................. 21
    Specifying Initial Conditions .................................................................. 22
  2.5 Creating and Managing Subsystems ................................................... 24
    Example: Creating a Subsystem ............................................................ 24
    Viewing the Contents of a Subsystem .................................................... 26
    Adding Multiple Copies of a Subsystem to a Model ............................... 26
    Editing Subsystem Definitions and Shared Subsystems .......................... 29
    Working with Stand-alone Subsystems .................................................. 34
  2.6 Global and Subsystem Parameters ...................................................... 37
    Global Parameters ............................................................................... 37
    Subsystem Parameters .......................................................................... 39
    Creating Parameter Blocks .................................................................... 40
    Creating Parameter Sets ........................................................................ 45
    Using Advanced Parameter and Variable Settings .................................. 46
  2.7 Attaching Files to a Model ................................................................. 51
  2.8 Creating and Managing Custom Libraries .......................................... 51
    Example: Creating a Custom Library from an Existing Model ................ 52

iii
5.8 Working with a Maple Standard Worksheet .............................................. 145

6 MapleSim Tutorials .................................................................................... 147

6.1 Tutorial 1: Modeling a DC Motor with a Gearbox ...................................... 147
   Adding a Gearbox to a DC Motor Model .................................................. 147
   Simulating the DC Motor with the Gearbox Model .................................... 149
   Grouping the DC Motor Components into a Subsystem .............................. 150
   Assigning Global Parameters to a Model .................................................. 150
   Changing Input and Output Values .......................................................... 152

6.2 Tutorial 2: Modeling a Cable Tension Controller ....................................... 153
   Building a Cable Tension Controller Model .............................................. 154
   Specifying Component Properties ........................................................... 155
   Simulating the Cable Tension Controller .................................................. 156

6.3 Tutorial 3: Modeling a Nonlinear Damper ................................................ 157
   Generating a Spring Damper Custom Component ...................................... 157
   Providing Damping Coefficient Values ..................................................... 158
   Building the Nonlinear Damper Model ..................................................... 158
   Assigning a Parameter to a Subsystem ..................................................... 161
   Simulating the Nonlinear Damper with Linear Spring Model ....................... 162

6.4 Tutorial 4: Modeling a Planar Slider-Crank Mechanism .............................. 164
   Creating a Planar Link Subsystem .......................................................... 165
   Defining and Assigning Parameters ......................................................... 168
   Creating the Crank and Connecting Rod Elements ..................................... 169
   Adding the Fixed Frame, Sliding Mass, and Joint Elements ........................ 169
   Specifying Initial Conditions .................................................................... 170
   Simulating the Planar Slider-Crank Mechanism ......................................... 171

6.5 Tutorial 5: Using the Custom Component Template ................................... 172
   Example: Modeling a Temperature Dependent Resistor ............................... 173
   Example: Compliant Contact and Piecewise Functions ............................... 177
   Example: Custom Ports ........................................................................ 182
   Advanced Uses for Custom Components .................................................. 187

6.6 Tutorial 6: Using the External C Code/DLL Custom Component Template ..... 192

6.7 Tutorial 7: Using the Equations Template ................................................. 197
   Template Description ........................................................................... 198
   Generating the Equations for the Spring Damper ....................................... 201
   Manipulating the Equations for the Spring Damper ................................... 204

6.8 Tutorial 8: Modeling Hydraulic Systems .................................................. 204
   Computational Issues ........................................................................... 205
   Basic Hydraulic Library Components ..................................................... 205
   Basic Hydraulic Equations .................................................................... 207
   Analysis of Simple Hydraulic Networks .................................................. 209
   Overview of Controlling Hydraulic Flow Path ......................................... 212
   Mechanical and Hydraulic Systems ......................................................... 213
   Overview of Compressibility of Hydraulic Liquids .................................... 221
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Fluid Inertia Models</td>
<td>222</td>
</tr>
<tr>
<td>Overview of Water Hammer Models</td>
<td>224</td>
</tr>
<tr>
<td>Overview of Hydraulic Custom Components</td>
<td>232</td>
</tr>
<tr>
<td>7 Reference: MapleSim Keyboard Shortcuts</td>
<td>235</td>
</tr>
<tr>
<td>Glossary</td>
<td>239</td>
</tr>
<tr>
<td>Index</td>
<td>241</td>
</tr>
</tbody>
</table>
List of Figures

Figure 1.1: Causal Model Block Diagram ............................................................. 2
Figure 1.2: Acausal Model Block Diagram ........................................................... 3
Figure 1.3: Simple Through and Across Variable Model ...................................... 3
Figure 1.4: Simple Through and Across Variable Electrical Model ....................... 3
Figure 1.5: RLC Circuit .................................................................................... 4
Figure 1.6: RLC MapleSim Circuit ..................................................................... 5
Figure 1.7: MapleSim Window ........................................................................... 6
Figure 1.8: Voltage Response Plot ..................................................................... 14
Figure 1.9: Rotational EMF ............................................................................. 15
Figure 1.10: Plots of DC Motor Torque and Speed ............................................. 16
Figure 2.1: Model Tree .................................................................................... 19
Figure 2.2: Model Navigational Controls ........................................................... 19
Figure 2.3: Specifying Units using the Unit Conversion Block ............................... 22
Figure 2.4: Initial Conditions ........................................................................... 23
Figure 2.5: Subsystem Group ........................................................................... 24
Figure 2.6: Creating a Subsystem ................................................................... 25
Figure 2.7: Creating Multiple Subsystems ......................................................... 27
Figure 2.8: Subsystem Definition ..................................................................... 28
Figure 2.9: Adding Multiple Subsystems to a Model ........................................... 29
Figure 2.10: DC Motor Subsystem ................................................................... 31
Figure 2.11: Copy Subsystem Dialog .................................................................. 36
Figure 2.12: Attachments ............................................................................... 51
Figure 2.13: Verifying Force Arrows ................................................................. 63
Figure 2.14: Center of Mass Placement Best Practice ......................................... 63
Figure 2.15: Hydraulic Model .......................................................................... 64
Figure 3.1: MapleSim Templates ....................................................................... 68
Figure 3.2: Equations Defining a Custom Component ......................................... 71
Figure 3.3: Port Mappings ............................................................................... 71
Figure 3.4: Variable to Port Mapping ................................................................. 72
Figure 3.5: Generated Custom Component ....................................................... 73
Figure 3.6: Completed Custom Component Model ............................................. 73
Figure 3.7: Double Mass-Spring-Damper Equations .......................................... 76
Figure 3.8: Port Mapping for Double Mass-Spring-Damper .................................. 76
Figure 3.9: Resistor Port Mapping ..................................................................... 78
Figure 3.10: Nonlinear Spring-Damper Custom Component ............................... 82
Figure 4.1: Simulation Process ......................................................................... 89
Figure 4.2: Simulation Results Progress Messages ............................................ 96
Figure 4.3: Snapshots in the Advanced Simulation Settings .................................. 97
Figure 4.4: The Stored Results Palette and Snapshots ....................................... 98
Figure 4.5: Simulation Graphs .......................................................................... 99
Figure 4.6: Custom Plot Window ..................................................................... 100
Figure 4.7: Plot One Quantity Versus Another .................................................... 102
Figure 4.8: 3-D Workspace ............................................................................. 106
Figure 4.9: 3-D View Controls ................................................................. 107
Figure 4.10: Perspective View Double Pendulum ......................................... 107
Figure 4.11: Orthographic View Double Pendulum ...................................... 108
Figure 4.12: Implicit Geometry Double Pendulum ....................................... 109
Figure 4.13: Attached Shapes ..................................................................... 109
Figure 6.1: Cable Tension Controller .......................................................... 156
Figure 6.2: Nonlinear Damper Model ......................................................... 159
Figure 6.3: Planar Slider-Crank Mechanism ............................................... 164
Figure 6.4: Temperature Dependent Resistor ............................................... 174
Figure 6.5: Falling Ball .............................................................................. 177
Figure 6.6: Bouncing Ball Dynamics .......................................................... 178
Figure 6.7: Bouncing Ball .......................................................................... 180
Figure 6.8: Bouncing Ball Result ............................................................... 182
Figure 6.9: Custom Ports .......................................................................... 184
Figure 6.10: Using a Custom Port .............................................................. 185
Figure 6.11: Centrifugal Pump Head Flow Rate Curve .................................. 188
Figure 6.12: Centrifugal Pump Custom Component ...................................... 189
Figure 6.13: External C Code Definition for Windows ................................... 193
Figure 6.14: External C Code Definition for Unix ......................................... 193
Figure 6.15: Arguments Table .................................................................... 194
Figure 6.16: Flow Through a Pipe .............................................................. 210
Figure 6.17: Controlling Flow Path ............................................................. 213
Figure 6.18: Fixed Flow Rate Source .......................................................... 214
Figure 6.19: Translational Motion with Fixed Pressure Source .................... 216
Figure 6.20: Fixed Pressure Source Results ............................................... 218
Figure 6.21: Translational Fixed Flange Hydraulic component .................... 218
Figure 6.22: Rotational Fixed Flange Hydraulic component ....................... 219
Figure 6.23: Pascal's Principle Example ...................................................... 221
Figure 6.24: Hydraulic Liquids Compressibility ........................................... 221
Figure 6.25: System Without Fluid Inertia .................................................. 223
Figure 6.26: System With Fluid Inertia ....................................................... 223
Figure 6.27: System With and Without Fluid Inertia .................................... 224
Figure 6.28: Water Hammer ...................................................................... 225
Figure 6.29: Discretized Pipeline Segment ................................................ 226
Figure 6.30: Water Hammer Pressure Flow Rate ........................................ 229
Figure 6.31: Pressure Surge With an Accumulator ....................................... 232
Figure 6.32: Head Flow Rate ................................................................. 233
Figure 6.33: Centrifugal Pump Custom Component Equations .................... 233
Figure 6.34: Gravity Head Custom Component Equations ............................ 234
List of Tables

Table 1.1: Through and Across Variable Domain Types ........................................... 4
Table 1.2: MapleSim Window Components .......................................................... 6
Table 2.1: MapleSim Component Library ........................................................... 17
Table 2.2: Domain-Specific Connection Line Colors ............................................. 20
Table 2.3: 2-D Math Notation Key Combinations ................................................. 57
Table 3.1: Port Map ........................................................................................ 72
Table 3.2: Signal Flow Components ................................................................... 74
Table 3.3: Characteristics of Through and Across Variables ................................. 77
Table 3.4: Through and Across Variable Mathematical Relationship .................... 77
Table 3.5: Resistor Variables and Parameters ....................................................... 77
Table 4.1: Simulation Settings .......................................................................... 91
Table 4.2: Advanced Simulation Settings ............................................................ 93
Table 4.3: 3-D Visualization Parameter Values ................................................... 104
Table 4.4: Multibody Parameter Values ............................................................. 105
Table 4.5: 3-D Workspace Controls .................................................................. 106
Table 5.1: MapleSim Templates ...................................................................... 125
Table 6.1: Temperature Dependent Resistor Components ..................................... 176
Table 6.2: Bouncing Ball Multibody Components ............................................... 181
Table 6.3: Centrifugal Pump Data ..................................................................... 188
Table 6.4: Circular Pipe Parameters ................................................................... 188
Table 6.5: Centrifugal Pump Components ........................................................... 189
Table 6.6: External C Code DLL Custom Components and Required Settings ........ 196
Table 6.7: Spring Damper Components and Required Settings ............................. 201
Table 6.8: Basic Hydraulic Library Components ............................................... 206
Table 6.9: Bernoulli and Darcy Equation Notation .............................................. 208
Table 6.10: Circular Pipe Parameters ................................................................. 209
Table 6.11: Hydraulic Components and Required Settings .................................... 210
Table 6.12: Spool Valve ................................................................................. 212
Table 6.13: Translational Motion with Fixed Flow Rate Sources ............................ 215
Table 6.14: Translational Motion with a Fixed Pressure Source ............................ 217
Table 6.15: Actuating Multibody Components ................................................... 219
Table 6.16: Hydraulic Liquids Compressibility Components ................................. 222
Table 6.17: Confined Hydraulic System Components .......................................... 222
Table 6.18: Fluid Inertia ................................................................................. 222
Table 6.19: Fluid Properties Values .................................................................. 226
Table 6.20: Water Hammer Parameters ............................................................ 227
Table 6.21: Accumulator Parameters Custom Component .................................... 231
Table 7.1: Opening, Closing, and Saving a Model ............................................... 235
Table 7.2: Building a Model in the Block Diagram View ...................................... 235
Table 7.3: Browsing a Model in the Block Diagram View .................................... 235
Table 7.4: Browsing a Model in the 3-D View ................................................... 236
Table 7.5: Simulating a Model ................................................................. 236
Table 7.6: Modifying the Plot Window Layout ........................................ 237
Introduction

MapleSim Overview

MapleSim™ is a modeling environment for creating and simulating complex multidomain physical systems. It allows you to build component diagrams that represent physical systems in a graphical form. Using both symbolic and numeric approaches, MapleSim automatically generates model equations from a component diagram and runs high-fidelity simulations.

Build Complex Multidomain Models

You can use MapleSim to build models that integrate components from various engineering fields into a complete system. MapleSim features a library of over 300 modeling components, including electrical, hydraulic, mechanical, and thermal devices; sensors and sources; and signal blocks. You can also create custom components to suit your modeling and simulation needs.

Advanced Symbolic and Numeric Capabilities

MapleSim uses the advanced symbolic and numeric capabilities of Maple™ to generate the mathematical models that simulate the behavior of a physical system. You can, therefore, apply simplification techniques to equations to create concise and numerically efficient models.

Pre-built Analysis Tools and Templates

MapleSim provides various pre-built templates in the form of Maple worksheets for viewing model equations and performing advanced analysis tasks, such as parameter optimization. To analyze your model and present your simulation results in an interactive format, you can use Maple features such as embedded components, plotting tools, and document creation tools. You can also translate your models into C code and work with them in other applications and tools, including applications that allow you to perform real-time simulation.

Interactive 3-D Visualization Tools

The MapleSim 3-D visualization environment allows you to build and animate 3-D graphical representations of your multibody mechanical system models. You can use this environment to validate the 3-D configuration of your model and visually analyze the behavior of your system under different conditions and at different simulation start times.

Related Products

MapleSim 7 requires Maple 18.02.
Maplesoft™ also offers a suite of toolboxes, add-ons, and other applications that extend the capabilities of Maple and MapleSim for engineering design projects. For a complete list of products, visit http://www.maplesoft.com/products.

**Related Resources**

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MapleSim Installation Guide</td>
<td>System requirements and installation instructions for MapleSim. The <strong>MapleSim Installation Guide</strong> is available in the <strong>Install.html</strong> file on your MapleSim installation DVD.</td>
</tr>
<tr>
<td>MapleSim Help System</td>
<td>Provides the following information:</td>
</tr>
<tr>
<td></td>
<td>• <strong>MapleSim User's Guide</strong>: conceptual information about MapleSim, an overview of MapleSim features, and tutorials to help you get started.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Using MapleSim</strong>: help topics for model building, simulation, and analysis tasks.</td>
</tr>
<tr>
<td></td>
<td>• <strong>MapleSim Component Library</strong>: descriptions of the modeling components available in MapleSim.</td>
</tr>
<tr>
<td>MapleSim Examples</td>
<td>Model examples from various engineering domains. These models are available in the <strong>Examples</strong> palette in the <strong>Libraries</strong> tab on the left side of the MapleSim window.</td>
</tr>
<tr>
<td>MapleSim User's Guide Examples</td>
<td>Model and Tutorial examples used in the User's Guide. These models are available in the <strong>Examples &gt; User's Guide Examples</strong> palette in the <strong>Libraries</strong> tab on the left side of the MapleSim window and are listed by chapter, in the order that they appear in the User's Guide.</td>
</tr>
<tr>
<td>MapleSim Online Resources</td>
<td>Training webinars, product demonstrations, videos, sample applications, and more. For more information, visit <a href="http://www.maplesoft.com/products/maplesim">http://www.maplesoft.com/products/maplesim</a>.</td>
</tr>
<tr>
<td>MapleSim Model Gallery</td>
<td>A collection of sample models, custom components, and analysis templates that you can download and use in your MapleSim projects. For more information, visit <a href="http://www.maplesoft.com/products/maplesim/modelgallery/">http://www.maplesoft.com/products/maplesim/modelgallery/</a></td>
</tr>
</tbody>
</table>

For additional resources, visit http://www.maplesoft.com/site_resources.

**Getting Help**

To request customer support or technical support, visit http://www.maplesoft.com/support.
Customer Feedback

Maplesoft welcomes your feedback. For comments related to the MapleSim product documentation, contact doc@maplesoft.com.
1 Getting Started with MapleSim

In this chapter:
• Physical Modeling in MapleSim (page 1)
• The MapleSim Window (page 6)
• Basic Tutorial: Modeling an RLC Circuit and DC Motor (page 7)

1.1 Physical Modeling in MapleSim

Physical modeling, or physics-based modeling, incorporates mathematics and physical laws to describe the behavior of an engineering component or a system of interconnected components. Since most engineering systems have associated dynamics, the behavior is typically defined with ordinary differential equations (ODEs).

To help you develop models quickly and easily, MapleSim provides the following features:

**Topological or “Acausal” System Representation**

The signal-flow approach used by traditional modeling tools requires system inputs and outputs to be defined explicitly. In contrast, MapleSim allows you to use a topological representation to connect interrelated components without having to consider how signals flow between them.

**Mathematical Model Formulation and Simplification**

A topological representation maps readily to its mathematical representation and the symbolic capability of MapleSim automates the generation of system equations.

When MapleSim formulates the system equations, several mathematical simplification tools are applied to remove any redundant equations and multiplication by zero or one. The simplification tools then combine and reduce the expressions to get a minimal set of equations required to represent a system without losing fidelity.

**Advanced Differential Algebraic Equation Solvers**

Algebraic constraints are introduced in the topological approach to model definition. Problems that combine ODEs with these algebraic constraints are called Differential Algebraic Equations (DAEs). Depending on the nature of these constraints, the complexity of the DAE problem can vary. An index of the DAEs provides a measure of the complexity of the problem. Complexity increases with the index of the DAEs.

The development of generalized solvers for complex DAEs is the subject of much research in the symbolic computation field. With Maple as its computation engine, MapleSim uses
advanced DAE solvers that incorporate leading-edge symbolic and numeric techniques for solving high-index DAEs.

**Acausal and Causal Modeling**

Real engineered assemblies, such as motors and powertrains, consist of a network of interacting physical components. They are commonly modeled in software by block diagrams. The lines connecting two blocks indicate that they are coupled by physical laws. When simulated by software, block diagrams can either be causal or acausal.

**Causal Modeling**

Many simulation tools are restricted to causal (or signal-flow) modeling. In these tools, a unidirectional signal, which is essentially a time-varying number, flows into a block. The block then performs a well-defined mathematical operation on the signal and the result flows out of the other side. This approach is useful for modeling systems that are defined purely by signals that flow in a single direction, such as control systems and digital filters.

\[ y := f(x) \]

**Acausal Modeling**

Modeling how real physical components interact requires a different approach. In acausal modeling, a signal from two connected blocks travels in both directions. The programming analogy would be a simple equality statement:

\[ y = f(x) \]

The signal includes information about which physical quantities (for example, energy, current, torque, heat and mass flows) must be conserved. The blocks contain information about which physical laws (represented by equations) they must obey and, hence, which physical quantities must be conserved.
MapleSim allows you to use both approaches. You can simulate a physical system (with acausal modeling) together with the associated logic or control loop (with causal modeling) in a manner that suits either task best.

### Through and Across Variables

When using the acausal modeling approach, it is useful to identify the through and across variables of the component you are modeling. In general terms, an across variable represents the driving force in a system and a through variable represents the flow of a conserved quantity. The through variable also establishes the flow direction for the sign convention of the conserved quantity.

For an example of sign convention and how arrow direction represents a force acting on the model, under the Libraries tab, browse to the Examples > User's Guide Examples > Chapter 1 menu, and then open the Constant Acceleration, Sign Convention and Arrow Convention examples.

In the following example, in an electrical circuit, the through variable, $i$, is the current and the across variable, $V$, is the voltage drop:
The following table lists some examples of through and across variables for other domains:

**Table 1.1: Through and Across Variable Domain Types**

<table>
<thead>
<tr>
<th>Domain</th>
<th>Through</th>
<th>Across</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical</td>
<td>Current ($A$)</td>
<td>Voltage ($V$)</td>
</tr>
<tr>
<td>Magnetic</td>
<td>Magnetic Flux ($Wb$)</td>
<td>MMF ($A$)</td>
</tr>
<tr>
<td>Mechanical (translational)</td>
<td>Force ($N$)</td>
<td>Velocity ($\frac{m}{s}$)</td>
</tr>
<tr>
<td>Mechanical (rotational)</td>
<td>Torque ($N.m$)</td>
<td>Angular Velocity ($\frac{rad}{s}$)</td>
</tr>
<tr>
<td>Hydraulic</td>
<td>Flow ($\frac{m^3}{s}$)</td>
<td>Pressure ($\frac{N}{m^2}$)</td>
</tr>
<tr>
<td>Heat flow</td>
<td>Heat flow ($W$)</td>
<td>Temperature ($K$)</td>
</tr>
</tbody>
</table>

As a simple example, the form of the governing equation for a resistor is

$$V = R \cdot i$$

This equation, in conjunction with Kirchhoff’s conservation of current law, allows a complete representation of a circuit.

$$R \cdot i_a = V_b - V_a \text{ and } i_b + i_a = 0$$

To extend this example, the following schematic diagram describes an RLC circuit, an electrical circuit consisting of a resistor, inductor, and a capacitor connected in series:

![Figure 1.5: RLC Circuit](image)

If you wanted to model this circuit manually, it can be represented with the following characteristic equations for the resistor, inductor, and capacitor respectively:

$$R \cdot i_R = V_a - V_b$$
By applying Kirchhoff's current law, the following conservation equations are at points \( a \), \( b \), and \( c \):

\[
L \frac{d}{dt} i_L = (V_b - V_c)
\]

\[
i_c = C \frac{d}{dt} V_c
\]

These equations, along with a definition of the input voltage (defined as a transient going from 0 to 1 volt, 1 second after the simulation starts)

\[
V_a = \begin{cases} 
0.0 & 0.0 \leq t < 1.0 \\
1.0 & t \geq 1.0
\end{cases}
\]

provide enough information to define the model and solve for the voltages and currents through the circuit.

In MapleSim, all of these calculations are performed automatically; you only need to draw the circuit and provide the component parameters. These principles can be applied equally to all engineering domains in MapleSim and allow you to connect components in one domain with components in others easily.

In the Basic Tutorial: Modeling an RLC Circuit and DC Motor (page 7) section of this chapter, you will model the RLC circuit described above and explore the capabilities of MapleSim to mix causal models with acausal models. The following figure shows how the RLC circuit diagram appears when it is built in MapleSim.
For another example of how a model can be represented using causal and acausal components, under the Libraries tab, browse to the Examples > User's Guide Examples > Chapter 1 menu, and then open the Double Mass Spring Damper example.

1.2 The MapleSim Window

The MapleSim window contains the following panes and components:

![MapleSim Window](image)

Figure 1.7: MapleSim Window

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main Toolbar</strong></td>
<td>Contains tools for running a simulation, attaching MapleSim analysis templates to your model, and performing other common tasks.</td>
</tr>
<tr>
<td><strong>Navigation Toolbar</strong></td>
<td>Contains tools for browsing your model and subsystems hierarchically, changing the model view, and viewing corresponding Modelica® code.</td>
</tr>
<tr>
<td><strong>Model Workspace Toolbar</strong></td>
<td>Contains tools for laying out and selecting objects, and adding elements such as annotations and probes.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Model Workspace</td>
<td>The area in which you build and edit a model in a block diagram view.</td>
</tr>
<tr>
<td>Palettes Pane</td>
<td>Contains expandable menus with tools that you can use to build a model and manage your MapleSim project. This pane contains two tabs:</td>
</tr>
<tr>
<td></td>
<td>• Libraries: contains palettes with sample models and domain-specific components that you can add to models.</td>
</tr>
<tr>
<td></td>
<td>• Definitions: contains palettes of the subsystems and custom components in your model.</td>
</tr>
<tr>
<td></td>
<td>• Project: contains palettes with tools to help you browse and build a model, and manage parameter sets, probes, and documents that you attach to a model.</td>
</tr>
<tr>
<td>Console</td>
<td>Use buttons on the Console Toolbar to display the following panes:</td>
</tr>
<tr>
<td></td>
<td>• Help: displays the Help topic associated with a modeling component.</td>
</tr>
<tr>
<td></td>
<td>• Message Console: displays progress messages indicating the status of the MapleSim engine during a simulation and allows you to clear the console using Clear Console (X).</td>
</tr>
<tr>
<td></td>
<td>• Debugging: displays diagnostic messages as you build your model identifying the subsystem in which the errors are located.</td>
</tr>
<tr>
<td>Console Toolbar</td>
<td>Contains controls for selecting and controlling the types of messages shown in the console (? ? ?).</td>
</tr>
<tr>
<td>Parameters Pane</td>
<td>Contains the following tabs:</td>
</tr>
<tr>
<td></td>
<td>• Inspector: allows you to view and edit modeling component properties, such as names and parameter values, and specify simulation options and probe values.</td>
</tr>
<tr>
<td></td>
<td>• Settings: allows you to specify simulation options, such as, the duration of the simulation and optional parameter values for the solver, simulation engine, and 3-D Workspace.</td>
</tr>
<tr>
<td></td>
<td>The contents of this pane change depending on your selection in the Model Workspace.</td>
</tr>
</tbody>
</table>

### 1.3 Basic Tutorial: Modeling an RLC Circuit and DC Motor

This tutorial introduces you to the modeling components and basic tools in MapleSim. It illustrates the ability to mix causal models with acausal models.
In this tutorial, you will perform the following tasks:

1. Build an RLC circuit model.
2. Set parameter values to specify component properties.
3. Add probes to identify values of interest for the simulation.
4. Simulate the RLC circuit model.
5. Modify the RLC circuit diagram to create a simple DC motor model.
6. Simulate the DC motor model using different parameters.

For an example of the RLC Circuit model, under the Libraries tab, browse to the Examples > User's Guide Examples > Chapter 1 menu, and then open the RLC Circuit example. The model you build is identical to the RLC Circuit model.

Building an RLC Circuit Model

To build the RLC circuit, you add components in the Model Workspace and connect them in a system to form a diagram. In this example, the RLC circuit model contains ground, resistor, inductor, capacitor, and signal voltage source components from the Electrical component library. It also contains a step input source, which is a signal generator that drives the input voltage level in the circuit.

To build an RLC circuit:

1. In the Libraries tab at the left of the Model Workspace, click the triangle beside Electrical to expand the palette. In the same way, expand the Analog menu, and then expand the Passive submenu.
2. From the Electrical > Analog > Passive menu, drag the Ground component to the Model Workspace.

3. Add the remaining electrical components to the Model Workspace.
   - From the Electrical > Analog > Passive > Resistors menu, add the Resistor component.
From the Electrical > Analog > Passive > Inductors menu, add the Inductor component.

From the Electrical > Analog > Passive > Capacitors menu, add the Capacitor component.

From the Electrical > Analog > Sources > Voltage menu, add the Signal Voltage component.

4. Drag the components in the arrangement shown below.

5. To rotate the Signal Voltage component clockwise, right-click (Control-click for Macintosh®) the Signal Voltage component in the Model Workspace and select Rotate Clockwise.

6. To flip the Signal Voltage component horizontally, right-click (Control-click for Macintosh) the component again and select Flip Horizontal. Make sure that the positive (blue) port is at the top.

7. To rotate the Capacitor component clockwise, right-click (Control-click for Macintosh) the Capacitor icon in the Model Workspace and select Rotate Clockwise.

You can now connect the modeling components to define interactions in your system.

8. Hover your mouse pointer over the Ground component port. The port is highlighted in green.

9. Click the Ground input port to start the connection line.

10. Hover your mouse pointer over the negative port of the Signal Voltage component.
11. Click the port once. The **Ground** component is connected to the **Signal Voltage** component.

12. Connect the remaining components in the arrangement shown below.

13. You can now add a source to your model. Expand the **Signal Blocks** palette, expand the **Sources** menu and then expand the **Real** submenu.

14. From the palette, drag the **Step** source and place it to the left of the **Signal Voltage** component in the **Model Workspace**. The step source has a specific signal flow, represented by the arrows on the connections. This flow causes the circuit to respond to the input signal.

15. Connect the **Step** source to the **Signal Voltage** component. The complete RLC circuit model is shown below.

---

**Specifying Component Properties**

To specify component properties, you can set parameter values for components in your model.
To specifying component properties:

1. In the Model Workspace, click the Resistor component. The Inspector tab at the right of the Model Workspace displays the name and parameter values of the resistor.

2. In the R field, enter 24, and press Enter. The resistance changes to $24\,\Omega$.

3. Specify the following parameter values for the other components. You can specify units for a parameter by selecting a value from the drop-down menu found beside the parameter value field.
   - For the Inductor, specify an inductance of $160\,mH$.
   - For the Capacitor, specify a capacitance of $200\,\mu F$.
   - For the Step source, specify a $T_0$ value of $0.1\,s$.

Adding a Probe

To specify data values for a simulation, you can attach probes to lines or ports to the model. In this example, you will measure the voltage of the RLC circuit.

To add a probe:

1. In the Model Workspace Toolbar, click Attach Probe (_attach probe_).
2. Hover your mouse pointer over the line that connects the Inductor and Capacitor components. The line is highlighted.
3. Click the line once. The probe appears in the Model Workspace.
4. Drag the probe to an empty location on the Model Workspace, and then click the workspace to position the probe.
5. Select the probe. The probe properties appear under the Inspector tab to the right of the Model Workspace.
6. Under the Inspector tab, select the Voltage check box to include the voltage quantity in the simulation graph.
7. To display a custom name for this quantity in the Model Workspace, enter Voltage as shown below and press Enter.
The probe with the custom name is added to the connection line.

For another example of how to use a probe value in a simulation, under the Libraries tab, browse to the Examples > User's Guide Examples > Chapter 1 menu, and then open the Sensors and Probes example.

**Simulating the RLC Circuit Model**

Before simulating your model, you can specify the simulation duration run time.

To simulate the RLC circuit:

1. Click the Settings tab at the top of the Parameters Pane and in the Simulation section, set the simulation duration time \( t_d \) to 0.5 s.

2. In the Advanced Simulation section, clear the Compiler check box.

3. Click Run Simulation \( \) in the Main Toolbar. MapleSim generates the system equations and simulates the response to the step input.

When the simulation is complete, the voltage response is plotted in a graph.
4. Save the model as **RLC_Circuit1.msim**. The probes and modified parameter values are saved as part of the model.

**Building a Simple DC Motor Model**

You will now add an electromotive force (EMF) component and a mechanical inertia component to the RLC circuit model to create a DC motor model. In this example, you will add components to the RLC circuit model using the search feature.

**To build a simple DC motor:**

1. In the **Libraries** tab, type **EMF** in the **Search** field located above the palettes. A drop-down list displays matches for your search results.
2. Select **Rotational EMF** from the drop-down list. The **Rotational EMF** component appears in the square beside the search field.

3. Drag the **Rotational EMF** component to the modeling workspace and place it to the right of the **Capacitor** component.

4. In the **Search** field, search for **Inertia**.

5. Add the **Inertia** component to the **Model Workspace** and place it to the right of the **Rotational EMF** component.

6. Connect the components as shown below.

![Figure 1.9: Rotational EMF](image)

**Note:** To connect the positive blue port of the **Rotational EMF** component, click the port once, drag your mouse pointer to the line connecting the capacitor and inductor, and then click the line.

7. In the **Model Workspace**, click the **Rotational EMF** component.

8. Click the **Inspector** tab and in the **Parameters** section, set the value of the transformation coefficient \( k \) to \( 10 \frac{N\cdot m}{A} \).

9. Click the **Step** component and change the value of the parameter, \( T_0 \), to 1 s.
Simulating the DC Motor Model

To simulate the DC motor:

1. In the **Model Workspace**, delete **Probe1**.
2. In the **Model Workspace Toolbar**, click **Attach Probe** (_attach probe_).
3. Hover your mouse pointer over the line that connects the **Rotational EMF** and **Inertia** components.
4. Click the line, and then click on an empty area of the workspace to position the probe.
5. Select the probe, and in the **Inspector** tab, select the **Speed** and **Torque** check boxes and clear the **Angle** check box. The probe, with an arrow indicating the direction of the conserved quantity flow, is added to the model. The direction of the conserved quantity flow (Torque) can be reversed by selecting the probe and then clicking on **Reverse Probe** (_reverse probe_) in the **Inspector** tab.
6. Rename the probe **Output**.
7. Click a blank area in the **Model Workspace**.
8. In the **Settings** tab, set the simulation duration time \( t_d \) to 5 s.
9. Click **Run Simulation** (_run simulation_) in the **Main Toolbar**. The following graphs appear.

![Figure 1.10: Plots of DC Motor Torque and Speed](image)

10. Save the model as **DC_Motor1.msim**.
2 Building a Model

In this chapter:

• The MapleSim Component Library (page 17)
• Browsing a Model (page 18)
• Defining How Components Interact in a System (page 20)
• Specifying Component Properties (page 21)
• Creating and Managing Subsystems (page 24)
• Global and Subsystem Parameters (page 37)
• Attaching Files to a Model (page 51)
• Creating and Managing Custom Libraries (page 51)
• Annotating a Model (page 54)
• Entering Text in 2-D Math Notation (page 56)
• Creating a Data Set for an Interpolation Table Component (page 58)
• Best Practices: Building a Model (page 59)

2.1 The MapleSim Component Library

The MapleSim component library contains over 500 components that you can use to build models. All of these components are organized in palettes according to their respective domains: electrical, magnetic, hydraulic, 1-D mechanical, multibody, signal blocks, and thermal. Most of these components are based on the Modelica Standard Library 3.1.

<table>
<thead>
<tr>
<th>Library</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Blocks</td>
<td>Components to manipulate or generate input and output signals.</td>
</tr>
<tr>
<td>Electrical</td>
<td>Components to model electrical analog circuits, single-phase and multiphase systems, and electric machines.</td>
</tr>
<tr>
<td>1-D Mechanical</td>
<td>Components to model 1-D translational and rotational systems.</td>
</tr>
<tr>
<td>Multibody</td>
<td>Components to model multibody mechanical systems, including force, motion, and joint components.</td>
</tr>
<tr>
<td>Hydraulic</td>
<td>Components to model hydraulic systems such as fluid power systems, cylinders, and actuators.</td>
</tr>
<tr>
<td>Thermal</td>
<td>Components to model heat flow and heat transfer.</td>
</tr>
<tr>
<td>Magnetic</td>
<td>Components to model magnetic circuits.</td>
</tr>
</tbody>
</table>
The library also contains sample models that you can view and simulate, for example, complete electrical circuits and filters. For more information about the MapleSim library structure and modeling components, see the MapleSim Component Library in the MapleSim Help system.

To extend the default library, you can create a custom modeling component from a mathematical model and add it to a custom library. For more information, see Creating Custom Modeling Components (page 67).

Viewing Help Topics for Components

In the Help pane below the Model Workspace, you can view the Help topic for each component from the MapleSim Component Library. To display the Help pane, click Component Help at the bottom of the MapleSim window. You can then select a component that you have added to the Model Workspace to view its Help topic. Alternatively, to view Help topics in a separate Help system window, you can perform one of the following tasks:

- Right-click (Control-click for Macintosh) a modeling component in any of the palettes and select Help from the context menu.
- Search for the help pages for components in the MapleSim Help system.

Updating Models Created in MapleSim 4 or Earlier

In MapleSim 4 or earlier, components from the Modelica Standard Library 2.2.1 were included in the MapleSim Component Library. In MapleSim 4.5, the Modelica Standard Library 2.2.1 was replaced by the Modelica Standard Library 3.1.

If you created a model in MapleSim 4 or earlier, you can open it in MapleSim 4.5 or later; it will then be updated automatically to use equivalent components from the Modelica Standard Library 3.1. For more information, see Using MapleSim > Updating Models Created in MapleSim 4.5 or Earlier in the MapleSim Help system.

Note: Models that contain components from the Modelica Standard Library 3.1 cannot be used in MapleSim 4 or earlier.

2.2 Browsing a Model

Using the Model Tree palette or model navigation controls, you can browse your model to view hierarchical levels of components in the Model Workspace. You can browse to the top level for an overall view of your system. The top level is the highest level of your model: it represents the complete system, which can include individual modeling components and subsystem blocks that represent groups of components. You can also browse to sublevels in your model to view the contents of individual subsystems or components.
Model Tree

To browse your model, you can use the Model Tree palette in the Project tab located on the left side of the MapleSim window. Each node in the model tree represents a modeling component, subsystem, or connection port in your model. For example, the model tree of a DC motor is shown below.

![Figure 2.1: Model Tree](image)

To browse your model and view the parameters associated with a component or subsystem, expand and double-click the nodes in the model tree. You can click the Main node to view the top level of your model and the child nodes to view the contents of a component or subsystem.

Model Navigation Controls

Alternatively, you can use the model navigation controls located above the Model Workspace Toolbar to browse between modeling components, subsystems, and hierarchical levels in a diagram displayed in the Model Workspace.

![Figure 2.2: Model Navigational Controls](image)
From the drop-down menu, select the name of the subsystem or modeling component that you want to view in the **Model Workspace**. You can click **Main** to browse to the top level of your model. You can also browse directly to subsystems in your model. For example, by clicking **DC Motor** in the example shown above, you can view the DC motor subsystem contents in the **Model Workspace**.

### 2.3 Defining How Components Interact in a System

To define interactions between modeling components, you connect them in a system. In the **Model Workspace**, you can draw a connection line between two connection ports.

You can also draw a connection line between a port and another connection line.

MapleSim permits connections between compatible domains only. By default, each line type appears in a domain-specific color.

#### Table 2.2: Domain-Specific Connection Line Colors

<table>
<thead>
<tr>
<th>Domain</th>
<th>Line Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mechanical 1-D rotational</td>
<td>Black</td>
</tr>
<tr>
<td>Mechanical 1-D translational</td>
<td>Green</td>
</tr>
<tr>
<td>Mechanical multibody</td>
<td>Black</td>
</tr>
<tr>
<td>Electrical analog</td>
<td>Blue</td>
</tr>
<tr>
<td>Electrical multiphase</td>
<td>Blue</td>
</tr>
<tr>
<td>Magnetic</td>
<td>Orange</td>
</tr>
<tr>
<td>Digital logic</td>
<td>Purple</td>
</tr>
<tr>
<td>Boolean signal</td>
<td>Pink</td>
</tr>
<tr>
<td>Causal signal</td>
<td>Navy blue</td>
</tr>
<tr>
<td>Integer signal</td>
<td>Orange</td>
</tr>
<tr>
<td>Thermal</td>
<td>Red</td>
</tr>
</tbody>
</table>
The connection ports for each domain are also displayed in specific colors and shapes. For more information about connection ports, see the MapleSim Component Library > Connectors Overview in the MapleSim Help system.

Components can have either scalar or vector connection ports. A scalar port has only one quantity associated with it while a vector port can have more than one quantity associated with it. Connections can be made between two scalar ports or between two vector ports having the same dimension. To make a connection between a vector port and a scalar port, you will need to use an intervening component that can convert a vector input/output to a scalar output/input. For more information, see Using MapleSim > Building a Model > Connecting Vector and Scalar Components in the MapleSim Help system.

2.4 Specifying Component Properties

To specify component properties, you can set parameter values for components in your model. When you select a component in the Model Workspace, the configurable parameter values for that component appear in the Inspector tab located on the right side of the MapleSim window.

**Note:** Not all components provide editable parameter values.

You enter parameter values in 2-D math notation, which is a formatting option that allows you to add mathematical text such as superscripts, subscripts, and Greek characters. For more information, see Entering Text in 2-D Math Notation (page 56).

**Note:** Most parameters in the MapleSim Component Library have default values. However, for some parameters, these default values are simply placeholders that may not represent realistic values for use in a simulation. These placeholder values use a blue font to distinguish them from other parameter values. You should replace these values with values that are more suitable for your simulation. For more information, see Using MapleSim > Building a Model > Specifying Parameters in the MapleSim Help system.

**Specifying Parameter Units**

You can use the drop-down menus beside parameter fields with dimensions to specify units for parameter values. For example, the image below displays the configurable parameter fields for a Mass component. You can optionally specify the mass in kg, lb, m, g, or slug, and the length in m, cm, mm, ft, or in.
When you simulate a model, MapleSim automatically converts all parameter units to the International System of Units (SI). You can, therefore, select more than one system of units for parameter values throughout a model.

If you want to convert the units of a signal, use the Unit Conversion Block component from the Signal Converters menu in the Signal Blocks palette. This component allows you to perform conversions in dimensions such as time, temperature, velocity, pressure, and volume. In the following example, a Unit Conversion Block component is connected between a translational Position Sensor and Feedback component to convert the units of an output signal.

![Figure 2.3: Specifying Units using the Unit Conversion Block](image)

If you include an electrical, 1-D mechanical, hydraulic, or thermal sensor in your model, you can also select the units in which to generate an output signal.

**Specifying Initial Conditions**

You can set parameter values to specify initial conditions for components from all domains in MapleSim. When you select a component that contains state variables in the Model Workspace, the available initial condition fields appear in the Inspector tab, along with the other configurable parameter values for that component.
For example, the image below displays the initial velocity, position, and acceleration fields that you can set for a \textbf{Mass} component.

![Initial Conditions](image)

**Figure 2.4: Initial Conditions**

### Specifying How Initial Conditions are Enforced

You can determine how the initial conditions that you specified for a particular component are enforced. The options are \texttt{ignore}, \texttt{guess}, and \texttt{enforce}. You can select these options for initial condition parameters individually by clicking the buttons beside the applicable initial condition fields.

If you select the \texttt{ignore} option, the parameter value that you enter in the initial condition field is ignored and the solver uses a default value for the initial condition, typically zero. This option is the default setting for all of the initial condition fields.

If you select the \texttt{guess} option, the solver treats the parameter value you entered in the initial condition field as a best guess value. In other words, the best guess value is a starting point for determining the initial configuration of the system for which there is a solution to the set of equations that describe the system. The solver initially computes a solution to the system of equations using this best guess value; however, if no solution is found, the solver computes a solution to the system of equations using an initial condition value that is close to the best guess value.

If you select the \texttt{enforce} option, the solver uses the parameter value that you enter in the initial condition field as a start value for the simulation. Similar to the \texttt{guess} option, the solver searches for a solution to the system of equations using the parameter value you entered in the initial condition field. However, unlike the \texttt{guess} option, if there is no solution, no other value is substituted, and an error message appears.
For more information about selecting these options, see *Best Practices: Enforcing Initial Conditions (page 65)*.

For an example of how initial conditions are enforced, under the Libraries tab, browse to the Examples > User's Guide Examples > Chapter 2 menu, and then open the Relative Positions example.

### 2.5 Creating and Managing Subsystems

A subsystem (or compound component) is a set of modeling components that are grouped in a single block component. A simple DC motor subsystem is shown below.

![Subsystem Group](image)

**Figure 2.5: Subsystem Group**

You can create a subsystem to group components that form a complete system, for example, a tire or DC motor. You can also create a subsystem to improve the layout of a diagram in the Model Workspace, add multiple copies of a system to a model, analyze a component group in Maple or to quickly assign parameters and variables. You can organize your model hierarchically by creating subsystems within other subsystems.

After you create a subsystem you will be able to assign parameters and variables to all components in that subsystem using the Advanced Parameter Settings and Advanced Variable Settings tools in the Inspector tab.

For best practices on creating subsystems in MapleSim, see *Best Practices: Laying Out and Creating Subsystems (page 59)*.

**Example: Creating a Subsystem**

In the following example, you will group the electrical components of a DC motor model into a subsystem.
To create a subsystem

1. Under the Libraries tab on the left side of the MapleSim window, expand the Examples > User's Guide Examples > Chapter 2 menu, and then open the Simple DC Motor example.

2. Using the Selection Tool located above the Model Workspace, draw a box around the electrical components.

3. From the Edit menu, select Create Subsystem (or right-click the boxed area and select Create Subsystem).

4. In the dialog box, enter DC Motor.

5. Click OK. A white block, which represents the DC motor, appears in the Model Workspace.

In this example, you created a stand-alone subsystem, which can be edited and manipulated independently of other subsystems in your model. If you want to add multiple copies of the same subsystem to your model and edit those subsystems as a group, you can create a subsystem definition. For more information, see Adding Multiple Copies of a Subsystem to a Model (page 26).
**Viewing the Contents of a Subsystem**

To view the contents of a subsystem, double-click the subsystem icon in the Model Workspace. The detailed view of a subsystem appears.

In this view, a broken line indicates the subsystem boundary. You can edit the connection lines and components within the boundary, add and connect components outside of the boundary, and add subsystem ports to connect the subsystem to other components. If you want to resize the boundary, click the broken line and drag one of the sizing handles displayed around the box.

To browse to the top level of the model or to other subsystems, use the controls in the Navigation Toolbar.

**Adding Multiple Copies of a Subsystem to a Model**

If you plan to add multiple copies of a subsystem to a model and want all of the copies to have the same configuration, you can create a subsystem definition. A subsystem definition is the base subsystem that defines the attributes and configuration that you want a series of subsystems to share.
For example, if you want to add three DC motor subsystems that all have identical components and resistance values in your model, you would perform the following tasks:

1. Build a DC motor subsystem with the desired configuration in the **Model Workspace**.
2. Use that subsystem configuration to create a subsystem definition and add it to the **Definitions** tab.
3. Add copies of the DC motor subsystem to your model using the subsystem definition as a source.

To add copies of the DC motor subsystem to your model, you can drag the DC Motor subsystem definition icon from the **Definitions** tab and place it in the **Model Workspace**. The copies that you add to the **Model Workspace** will then share a configuration that is identical to the subsystem definition in the **Definitions** tab; the copies in the **Model Workspace** are called *shared subsystems* because they share and refer to the configuration specified in their corresponding subsystem definition.

![Figure 2.7: Creating Multiple Subsystems](image)

Shared subsystems that are copied from the same subsystem definition are *linked*, which means that changes you make to one shared subsystem will be reflected in all of the other shared subsystems that were created from the same subsystem definition. The changes are also reflected in the subsystem definition entry in the **Definitions** tab. A shared subsystem is indicated on the model workspace by the icon 🗑️.

Using the example shown above, if you change the resistance parameter of the **Resistor** component in the **DC Motor** shared subsystem from 24Ω to 10Ω, the resistance value of
the Resistor component in the DC Motor₁ and DC Motor₃ shared subsystems and the DC Motor subsystem definition in the Definitions tab will also be changed to 10Ω.

For more information, see Editing Subsystem Definitions and Shared Subsystems (page 29).

Example: Adding Subsystem Definitions and Shared Subsystems to a Model

In the following example, you will create a DC Motor subsystem definition and add multiple shared subsystems to your model.

Adding a Subsystem Definition to the Definitions Tab

To add a subsystem definition

1. In the Model Workspace, right-click (Control-click for Macintosh) the stand-alone DC motor subsystem that you created in Example: Creating a Subsystem (page 24).

2. From the context menu, select Convert to Shared Subsystem.

3. Enter DC Motor as the name for the subsystem definition and click OK.

4. Under the Definitions tab on the left side of the Model Workspace, expand the Components palette.

The subsystem definition is added to the Components palette and the subsystem in the Model Workspace is converted into a shared subsystem called DC Motor₁. This shared subsystem is linked to the DC Motor subsystem definition.

5. Save this model as DCMotorSubsystem.msim. You will be building on this model in Example: Editing Shared Subsystems that are Linked to the Same Subsystem Definition (page 29).

You can now use this subsystem definition to add multiple DC motor shared subsystems to your MapleSim model.
Tip: If you want to use a subsystem definition in another model, add the subsystem definition to a custom library. For more information, see Creating and Managing Custom Libraries (page 51).

Adding Multiple DC Motor Shared Subsystems to a Model

To add multiple DC Motor shared subsystems to a model, drag the DC Motor subsystem definition icon from the Definitions tab and place it in the Model Workspace.

![Figure 2.9: Adding Multiple Subsystems to a Model](image)

When you create a new stand-alone subsystem or add shared subsystems to a model, a unique subscript number is appended to the subsystem name displayed in the Model Workspace. As shown in the image above, subscript numbers are appended to the names of each DC Motor shared subsystem. These numbers can help you to identify multiple subsystem copies in your model.

Editing Subsystem Definitions and Shared Subsystems

If you edit a shared subsystem in the Model Workspace, your changes will be reflected in the subsystem definition that is linked to the shared subsystem, as well as other shared subsystems that were copied from the same subsystem definition.

Example: Editing Shared Subsystems that are Linked to the Same Subsystem Definition

In this example, you will create a model that contains two DC Motor shared subsystems, and then edit the resistance values and icons for the shared subsystems. These shared subsystems are linked to the DC Motor shared subsystem definition that was created in Example: Adding Subsystem Definitions and Shared Subsystems to a Model (page 28). You will verify that when you change one of the component values and the icon for one DC Motor shared subsystem, the other DC Motor shared subsystems in your model--as well as any new DC Motor shared subsystems that you add in the future--will contain the changes.
Note: Before doing this example, you should have already gone through and stored the results from Example: Adding Subsystem Definitions and Shared Subsystems to a Model (page 28).

To use shared subsystems:

1. In MapleSim, open the DCMotorSubsystem.msinn file that you created in Example: Adding Subsystem Definitions and Shared Subsystems to a Model (page 28).

2. Under the Definitions tab, expand the Components palette, and then drag a second DC Motor shared subsystem onto the workspace, placing it below the existing DC Motor shared subsystem.

3. Under the Libraries tab, expand the 1-D Mechanical > Rotational > Common menu, and then drag a second Inertia component onto the workspace, placing it below the existing Inertia component.

4. Make the following connections between the newly added components and the existing components in the model.

5. In the Model Workspace, double-click the DC Motor$_1$ shared subsystem. The detailed view of the shared subsystem appears.
Note that a heading with the subsystem definition name (DC Motor) followed by the shared subsystem name (DC Motor\textsubscript{1}) appears at the top of the Model Workspace. In the detailed view of all shared subsystems, this heading also appears to help you identify multiple subsystem copies in your model. Also, when you select a shared subsystem, its subsystem definition name appears in the Type field in the Inspector tab.

6. Select the Resistor component (R\textsubscript{1}) and, in the Inspector tab, click Parameters. Change the resistance value to 50Ω.

7. In the Navigation Toolbar, click Icon ( ).

8. Using the Rectangle Tool ( ) in the Model Workspace Toolbar, click and drag your mouse pointer to draw a shape in the box.
9. In the Navigation Toolbar, click Diagram (Diagram).

10. Click Main in the Navigation Toolbar to browse to the top level of the model. Both of the DC Motor shared subsystems now display the square that you drew.

11. In the Definitions tab on the left side of the MapleSim window, expand the Components palette. As shown in the image below, your changes are also reflected in the DC Motor entry in this palette.

If you double-click the DC Motor subsystems in the Model Workspace and select their Resistor components, you will see that both of the shared subsystems now have a resistance value of 50Ω.

12. From the Definitions tab, drag a new copy of the DC Motor subsystem and place it anywhere in the Model Workspace. Verify that the new copy displays the square that you drew and its resistance value is also 50Ω, and then delete it from the workspace.
13. Save this model as **DCMotorSharedSubsystem.msim**. You will be building on this model in *Example: Removing the Link Between a Shared Subsystem and its Subsystem Definition (page 33)*.

**Example: Removing the Link Between a Shared Subsystem and its Subsystem Definition**

If your model contains multiple shared subsystems that are linked and you want to edit one copy only, you can remove the link between a shared subsystem and its subsystem definition, and edit that subsystem without affecting others in the **Model Workspace**.

**Note:** Before doing this example, you should have already gone through and stored the results from *Example: Editing Shared Subsystems that are Linked to the Same Subsystem Definition (page 29)* and saved the results from that example.

**To remove shared subsystem link:**

1. Open the **DCMotorSharedSubsystem.msim** model that you created in *Example: Editing Shared Subsystems that are Linked to the Same Subsystem Definition (page 29)*.

2. In the **Model Workspace**, right-click (Control-click for Macintosh) the **DC Motor_2** shared subsystem.

3. Select **Convert to Stand-alone Subsystem**. The **DC Motor_2** subsystem is no longer linked to the **DC Motor** subsystem definition in the **Definitions** tab; it is now called **copy of DC Motor_1**.

4. Double-click the **DC Motor_1** shared subsystem.

5. Click **Icon**.

6. Using the **Rectangle Tool**, click and drag your mouse pointer to draw a shape in the box in the **Model Workspace**.

7. Click **Diagram** and then click **Main** to browse to the top level of the model. Your change is shown in the **DC Motor_1** shared subsystem in the **Model Workspace** and the **DC Motor** subsystem definition in the **Definitions** tab. Note that your change is not shown in the **copy of DC Motor_1** subsystem that is no longer linked to the **DC Motor** subsystem definition.

**Tip:** When you convert a shared subsystem to a stand-alone subsystem, it is a good practice to assign the stand-alone subsystem a meaningful name that clearly distinguishes it from existing shared subsystems and subsystem definitions.
Working with Stand-alone Subsystems

Stand-alone subsystems are subsystems that are not linked to a subsystem definition. You can create a stand-alone subsystem in two ways: by creating a new subsystem as shown in Example: Creating a Subsystem (page 24) or by converting a shared subsystem to a stand-alone subsystem as shown in Example: Removing the Link Between a Shared Subsystem and its Subsystem Definition (page 33). Stand-alone subsystems can be edited independently without affecting other subsystems in the Model Workspace.

To identify a subsystem as a stand-alone subsystem, select a subsystem in the Model Workspace and examine the Inspector tab. If that subsystem is a stand-alone subsystem, the Type field reads Standalone Subsystem.

![Inspector Tab for Standalone Subsystem](image)

Stand-alone subsystems will not show the shared subsystem icon (¶) on the Model Workspace. Also, if you double-click a stand-alone subsystem to browse to its detailed view, no heading is shown for the subsystem in the Model Workspace.

When you copy and paste a stand-alone subsystem in the Model Workspace, you can optionally convert that subsystem into a shared subsystem and create a new subsystem definition. For more information, see Example: Copying and Pasting a Stand-alone Subsystem (page 35).

Example: Resolving Warning Messages in the Debugging Console

When you convert a shared subsystem into a stand-alone subsystem, the subsystem is highlighted in the Model Workspace and a warning message appears, informing you that the link to the subsystem definition has been removed.

Note: This example is an extension of Example: Removing the Link Between a Shared Subsystem and its Subsystem Definition (page 33).

To resolve a warning message

1. Click Diagnostic Information (¶) at the bottom of the MapleSim window to display the debugging console. The following warning message appears in the console.
2. To work with the copy of DC Motor1 subsystem as a stand-alone subsystem, right-click (Control-click for Macintosh) the warning message and select Ignore duplication warnings for “copy for DC Motor1” to hide the warning message from the debugging console.

**Tip:** If you want to view warning messages that you hid from the debugging console, click Reset IgnoredWarnings ( ) below the console. All of the warning messages that you previously hid will appear in the debugging console again.

Alternatively, if you want to link the copy of DC Motor1 stand-alone subsystem to the DC Motor subsystem definition again, you can right-click (Control-click for Macintosh) the warning message and select Update “copy of DC Motor1” to use the shared subsystem “DC Motor”.

**Example: Copying and Pasting a Stand-alone Subsystem**

**Note:** This example is an extension of Example: Removing the Link Between a Shared Subsystem and its Subsystem Definition (page 33).

**To copy and paste a stand-alone subsystem:**

1. In the Model Workspace, copy and paste the copy of DC Motor1 stand-alone subsystem. A dialog box appears. (See Figure 2.11.)

2. Select Convert the above stand-alone subsystem to a shared subsystem (Recommended). A new subsystem definition called DC Motor 1 is added to the Definitions tab.
In the Model Workspace, the copy of DC Motor\textsubscript{1} stand-alone subsystem has been converted to a shared subsystem called copy of DC Motor\textsubscript{1} and another copy of that shared subsystem called copy of DC Motor\textsubscript{2} has been added to the Model Workspace. Both the copy of DC Motor\textsubscript{1} and copy of DC Motor\textsubscript{2} shared subsystems are linked to the new DC Motor\textsubscript{1} subsystem definition. Therefore, if you edit either copy of DC Motor\textsubscript{1} or copy of DC Motor\textsubscript{2} in the Model Workspace, your changes will not be reflected in subsystems that are linked to the original DC Motor subsystem definition.

Note: Alternatively, you can select Replicate the above stand-alone subsystem as a new stand-alone subsystem to add another stand-alone subsystem that can be edited independently without affecting the other subsystems in the Model Workspace.
2.6 Global and Subsystem Parameters

MapleSim lets you define global and subsystem parameter values, and assign them to components using the Add or Change Parameters editor, parameter blocks, parameter sets, and the Advanced Parameter Settings and Advanced Variable Settings in the Inspector tab.

Global Parameters

If your model contains multiple components that share a common parameter value, you can create a global parameter. A global parameter allows you to define a common parameter value in one location and then assign that common value to multiple components in your model.

The following example describes how to define and assign a global parameter. To view a more detailed example, see Tutorial 1: Modeling a DC Motor with a Gearbox (page 147) in Chapter 6 of this guide.

Example: Defining and Assigning a Global Parameter

If your model contains multiple Resistor components that have a common resistance value, you can define a global parameter for the resistance value in the parameter editor view.

To define and assign a global parameter:

1. In the Libraries tab, expand the Electrical palette, expand the Analog menu, expand the Passive menu, and then expand the Resistors menu.

2. From the palette, drag three copies of the Resistor component into the Model Workspace.

3. In the Navigation Toolbar, click Parameters ( ), or click the workspace and from the Inspector tab, click Add or Change Parameters. The Main subsystem default settings screen appears. You will use this screen to define the global parameter and assign it to the Resistor components in your model.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Default Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Subsystem Composition

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Value</th>
<th>Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>1</td>
<td>Ω</td>
<td>Resistance at temperature T_ref</td>
</tr>
</tbody>
</table>
4. Click the first field under the **Name** column in the **Main subsystem default settings** table.

5. Enter **GlobalResistance** as the global parameter name and press **Enter**.


7. Enter **Global resistance variable** as the description and press **Enter**.

---

The global parameter for the resistance value is now defined. You can now assign the common **GlobalResistance** parameter value to the individual **Resistor** components that you added to the **Model Workspace**.

8. In the **R₁ component** table and **R₂ component** table, enter **GlobalResistance** as the resistance value.

---

The resistance value of the parameter **GlobalResistance** (2, as defined in the **Main subsystem default settings** table) has now been assigned to the resistance parameters of the **R₁** and **R₂** components.

The **R₁** and **R₂** components will now inherit any changes made to the **GlobalResistance** parameter value in the **Main subsystem default settings** table. For example, if you change the default value of the **GlobalResistance** parameter to 5 in the **Main subsystem default settings** table, the resistance parameters of the **R₁** and **R₂** components will also be changed.
to 5. Any change to the \texttt{GlobalResistance} parameter value will not apply to the \( R_3 \) component because it has not been assigned \texttt{GlobalResistance} as a parameter value.

\textbf{Subsystem Parameters}

You can create a subsystem parameter if you want to create a common parameter value to share with multiple components in a subsystem. Similar to global parameters, a subsystem parameter is a common value that you define in the parameter editor view and assign to components.

There are two ways to assign subsystem parameters; one is by clicking \texttt{Parameters} and the other is by using the \texttt{Advanced Parameter Settings} tool in the \texttt{Inspector} tab. Parameters can only be assigned to components in the subsystem in which they are defined. If you click a subsystem in the \texttt{Model Workspace}, click \texttt{Parameters} or \texttt{Advanced Parameter Settings}, and define a parameter in the parameter editor view, the parameter that you define is assigned to components in the subsystem that you selected and any nested subsystems.

To view an example, see \textit{Tutorial 3: Modeling a Nonlinear Damper (page 157)} in Chapter 6 of this guide.

\textbf{Note:} If you create a parameter within a subsystem and assign its value to a component at the top level, the component at the top level will not inherit the parameter value.

\textbf{Example: Assigning a Subsystem Parameter to a Shared Subsystem}

If you assign a subsystem parameter to a shared subsystem in your model, the default subsystem parameter will also be assigned to other shared subsystems that are linked to it. However, after the default subsystem parameter is assigned, you can edit the subsystem parameter value for each shared subsystem separately without affecting other parameter values in the model.

\textbf{To assign a subsystem parameter to a shared subsystem}

1. In the \texttt{Examples} palette, expand the \texttt{Physical Domains > Multibody} menu, and then open the \texttt{Double Pendulum} model. This model contains two shared subsystems, \( L_1 \) and \( L_2 \), which are linked to a subsystem definition called \( L \).
2. Double-click the \( L_1 \) shared subsystem.
3. Click \texttt{Parameters}.
4. In the \texttt{L subsystem default settings table}, click the empty field at the bottom of the table.
5. Type \texttt{c} as the parameter name, keep the default value as \texttt{1}, and press \texttt{Enter}. 

2.6 Global and Subsystem Parameters • 39
6. Click **Diagram**. The new subsystem parameter, \( c \), appears in the **Inspector** tab for the \( L_1 \) shared subsystem.

7. In the top view of the model, select the \( L_2 \) subsystem and examine the **Inspector** tab. The new subsystem parameter is also displayed for the \( L_2 \) shared subsystem.

8. In the **Inspector** tab, change the value of \( c \) to **50**.

9. Click the \( L_1 \) shared subsystem in the **Model Workspace** and examine the **Inspector** tab. Note that the value of its parameter, \( c \), remains the same.

**Creating Parameter Blocks**

As an alternative to defining subsystem parameters using the methods described above, you can create a parameter block to define a set of subsystem parameters and assign them to components in your model. Parameter blocks allow you to apply parameters in multiple models at the top level of the **Model Workspace**.

The following image shows a parameter block that has been added to the **Model Workspace**.

When you double-click this block, the parameter editor view appears. This view allows you to define parameter values for the block.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Default Units</th>
<th>Description</th>
</tr>
</thead>
</table>

After defining parameter values, you can assign those values to the component parameters in your model.

To use parameter values in another model, you can add a parameter block to a custom library. For more information about custom libraries, see *Creating and Managing Custom Libraries* (page 51).

**Notes:**

- Parameter blocks must be placed in the same subsystem as the components to which you want to assign the parameter value.

- Parameter blocks at the same hierarchical level in a model cannot have the same parameter names. For example, two separate parameter blocks in the same subsystem cannot each contain a parameter called **mass**.
Example: Creating and Using a Parameter Block

In this example, you will create a set of parameters that can be shared by multiple components in your model. By creating a parameter block, you only need to edit parameter values in one location to compare results when you run multiple simulations.

To create and use a parameter block:

1. In the Libraries tab on the left side of the MapleSim window, expand the Examples palette, expand the Physical Domains menu, expand the 1-D Mechanical menu, and then open the PreLoad example.
2. Under the Settings tab, enter 0.012 seconds for $t_d$, the simulation duration time.
3. Click the SM1 Mass component on the workspace, and then click the Inspector tab. You will be using a parameter block to set values for the following parameters: $m$, $L$, $s_0$, and $v_0$.
4. From the Model Workspace Toolbar, click Add a parameter block ( ), and then click on a blank area in the Model Workspace.
5. Click the Inspector tab and enter the name SlidingMassParams for the parameter block.

7. Click the first field in the table and define a new symbolic parameter called MASS.
8. Press Enter. The remaining fields for this row are activated.
9. From the Type drop-down menu, select Mass [ [ kg ] ].
10. Enter a default value of 5.
11. From the Default Units drop-down menu, select kg.
12. Enter Mass of the sliding mass for the Description field.
13. In the same way, define the following parameters and values in the Parameters subsystem default settings table.
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Default Value</th>
<th>Default Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LENGTH</td>
<td>Length $[m]$</td>
<td>2</td>
<td>$m$</td>
<td>Length of the sliding mass</td>
</tr>
<tr>
<td>V0</td>
<td>Velocity $[\frac{m}{s}]$</td>
<td>1</td>
<td>$\frac{m}{s}$</td>
<td>Initial velocity of the sliding mass</td>
</tr>
<tr>
<td>S0</td>
<td>Position $[m]$</td>
<td>1</td>
<td>$m$</td>
<td>Initial position of the sliding mass</td>
</tr>
</tbody>
</table>

The parameter editor view appears as follows when the values are defined.

14. Click **Diagram** and then click **Main** in the **Navigation Toolbar**. When you select the parameter block in the **Model Workspace**, the defined parameters appear in the **Inspector** tab on the right side of the MapleSim window.

15. In the **Model Workspace**, select the $SM_1$ mass component in the diagram.
16. In the **Inspector** tab, assign the following values and press **Enter**.
The parameters of this Mass component now inherit the numeric values that you defined in the parameter block.

17. In the same way, assign the same values to the parameters of the SM₂ and SM₃ mass components in the model.

18. In the Model Workspace, delete the probe labeled Input.

19. Select the probe labeled Output.

20. In the Inspector tab, clear the check box beside Velocity.

21. To simulate the model, click Run Simulation (▶) in the Main Toolbar. The following graph appears.
22. In the **Model Workspace**, click the parameter block.

23. In the **Inspector** tab, change the mass to **3.5** and the initial velocity to **5**. Press **Enter**. These changes apply to all of the **Mass** components to which you assigned the symbolic parameter values.

24. Simulate the model again. Another simulation graph appears, which you can compare to your first graph.
Creating Parameter Sets

The parameters you create for your model can be stored as reusable Parameter Sets. Parameter Sets let you save, reuse, and compare different sets of parameters for the same model displayed in the workspace. At any time you can easily apply and run different simulations, saving new values for each model. A Parameter Set provides a snapshot of all the parameters in the Model Workspace.

Parameter Sets for your model are listed in the Project tab, under Parameter Sets as shown in the following figure.

You can use, save, reuse, and compare different sets of parameters for the same model by right-clicking (Control-click for Macintosh) on a Parameter Set. For more information, see
the Using MapleSim > Building a Model > Using Parameter Sets > Saving and Applying Parameter Sets section in the MapleSim Help system.

**Using Advanced Parameter and Variable Settings**

At the top level of your model, in the **Main subsystem default settings** window, you define the subsystem by adding parameters and setting their default values. An alternative is to directly assign subsystem parameters, variables, and initial conditions to components in your subsystem by using the **Advanced Parameter Settings** and **Advanced Variable Settings** tools in the **Inspector** tab. Advanced Settings lets you override one or more default values.

**Advanced Parameter Settings**

**Advanced Parameter Settings** lets you override the default values for selected subsystem components. If desired, you can parametrize the override using the parametrization feature ( ). A component override in one subsystem can be converted to a parameter visible in all the other subsystems.

In the following model an override was applied to the initial value of R and changed to the parameter **Rcommon**.

![Diagram](image)
Advanced Variable Settings

**Advanced Variable Settings** lets you specify initial conditions for subsystem components. When you select **Advanced Variable Settings** the initial condition fields appear for all configurable components for that subsystem.

**Example: Creating a Parameter Override**

To create a parameter override:

1. Under the **Libraries** tab on the left side of the MapleSim window, expand the **Examples** palette, expand the **User's Guide Examples > Chapter 2** menu, and then open the **Simple DC Motor** example.

2. Using the **Selection Tool** located above the **Model Workspace**, draw a box around the electrical components.

3. From the **Edit** menu, select **Create Subsystem** or right-click (Control-click for Macintosh) the boxed area and select **Create Subsystem**.

4. In the dialog box, enter **DC Motor**, and then click **OK**. The DC Motor subsystem appears.

5. Use the DC Motor subsystem to create the shared subsystem definition and add it to the **Definitions** tab.
6. Add three copies of the DC motor subsystem to your **Model Workspace** by dragging the DC Motor subsystem definition icon from the **Definitions** tab and placing it in the **Model Workspace**.

7. Create three additional DC Motor subsystems as shown below.
8. Click the DC Motor subsystem, and then click Advanced Parameter Settings under the Inspector tab. The Advanced Parameter Settings window appears, showing all of the subsystem components.

![Advanced Parameter Settings](image)

9. Expand R1 and enter a value of 100 for the Resistance parameter (R).

![Advanced Parameter Settings](image)

10. Click OK. The new parameter appears in the Inspector tab as an override.

![Inspector Tab](image)

11. To change this override to make it a reusable parameter, click Parametrize, enter Rcommon as the new parameter name, and then click OK. Rcommon appears in the Inspector tab as a parameter that can now be reused in the other subsystems. Note that it is no longer an override.

![Inspector Tab](image)
12. For each of the other subsystems, click the subsystem and enter values of 75Ω, 50Ω, and 25Ω for R<sub>common</sub> in DC Motor subsystems 3, 2, and 1 respectively.

13. For each of the subsystems, select the probe, and in the Inspector tab select the Speed check box and clear all of the other check boxes.

14. Click Run Simulation (▶) in the Main Toolbar. The following graphs appear for each of the subsystems.

### Specifying Initial Condition Overrides

You can set initial condition values to override existing initial conditions for specific subsystem components. When you select a component, the available initial condition fields and any existing overrides appear in the Inspector tab, along with the other configurable parameter values for that component.

When you select a subsystem and then click Advanced Variable Settings, all subsystem components appear. You can select a component and specify the initial conditions for that component. This feature is especially useful for models that contain multiple shared subsystems.
2.7 Attaching Files to a Model

You can use the Attachments palette in the Project tab to attach files of any format to a model (for example, spreadsheets or design documents created in external applications). You can save files attached in the Attachments palette as part of the current model and refer to them when you work with that model in a future MapleSim session. To save a file, right-click (Control-click for Macintosh) the category in which you want to save the attachment in the palette and select Attach File.

You can also attach a file to a model from the menu bar by selecting Edit > Attach File... . Using this method, by default, the file attaches to the Documents category. If you want to move this attachment, you can click and drag the entry to another category.

The following image shows an Attachments palette that contains files called Damper-Curve.csv and Data Generation.mw.

![Figure 2.12: Attachments](image)

You can also use the Attachments palette to open MapleSim templates to perform analysis tasks in Maple, create custom modeling components, and generate data sets for a model. For more information about performing analysis tasks, see Analyzing and Manipulating a Model (page 125) in this guide.

2.8 Creating and Managing Custom Libraries

You can create a custom library to save a collection of subsystems and custom modeling components that you plan to reuse in multiple files or MapleSim sessions. Custom libraries that you create appear in custom palettes in the Libraries tab on the left side of the MapleSim window and are saved as .msimlib files on your computer. These custom palettes will appear in the MapleSim window in future MapleSim sessions.

You can use the subsystems and components from the custom library palette when building a model, in the same way you add components from other palettes.
You can also share a custom library with other users. For example, if you store a custom
library on a network drive, other users with access to that location can load your custom
library in their MapleSim session.

Custom library palettes appear above the **Examples** palette and are indicated with an icon:
. A sample custom palette is shown below.

For information on creating custom libraries, see **Using MapleSim > Building a Model >
Custom Libraries > Creating a Custom Library** in the MapleSim Help system.

If you used a third-party tool to create models or model libraries based on the Modelica 3.1
programming language, you can import the .mo files for the models or model libraries into
MapleSim as .msimlib files. You can then use the imported models and libraries in your
MapleSim models as you would use any other modeling components. For more information,
see **Using MapleSim > Building a Model > Importing and Opening Modelica Models
and Libraries > Importing Modelica Libraries**.

**Example: Creating a Custom Library from an Existing Model**

In this example, you will create a custom library from an existing MapleSim model.

add a subsystem and an .mw attachment to a custom library to make them available in a
future MapleSim session.

**To create a custom library from a model:**

1. Under the **Libraries** tab, expand the **Examples** palette, expand the **Physical Domains
   > Multibody** menu, and then open the **5 DoF Robot** example.

2. This model has six shared subsystems, which are listed in the **Components** palette of
   the the **Definitions** tab.

3. Save the model.

4. From the **Tools** menu, select **Export to MapleSim Library**....
5. Enter the name **Robot** for the library under **Package**.
   **Note:** The package name that you specify will appear as the custom palette name in the MapleSim interface.

6. Click **OK**. You are now in *library edit mode* (indicated by the watermark on the workspace and the **Library** tab in the Parameters pane). A new custom library palette appears in the **Libraries** tab on the left side of the MapleSim window. The palette is empty because we have not defined a hierarchy for its elements.

7. Switch to the **Definitions** tab, and drag the components to the **Hierarchy** tab under the root name (Robot). If desired, organize the elements into subgroups.

8. Click **Reload** in the **Main Toolbar** to save your changes and reload the palette for the custom library in the **Library** tab with the updates. The custom library palette now contains all these components.
2.9 Annotating a Model

You can use the tools in the Model Workspace Toolbar to draw lines, arrows, and shapes. MapleSim also provides many tools for customizing the colors, line styles, and shape fills.

You can use the text tool ( ) in the Model Workspace Toolbar to add text annotations to your model. In text annotations, you can enter mathematical text in 2-D math notation and modify the style, color, and font of the text. For more information about 2-D math notation, see Entering Text in 2-D Math Notation (page 56).
Example: Adding Text Annotation to a Model

To add text annotation to a model:

1. Under the Libraries tab, expand the Examples palette, expand the User's Guide Examples > Chapter 2 menu, and then open the Simple DC Motor example.

2. From the Model Workspace Toolbar, click Text Tool (T).

3. In the Model Workspace, draw a text box for an annotation below the Step component.

When you release your left mouse button, the toolbar above the Model Workspace switches to the text formatting toolbar.

4. Enter the following text: This block generates a step signal with a height of 1.

5. Select the text that you entered and change the font to Arial.

6. Click anywhere outside of the text box.

7. Draw another text box below the Inertia component.

8. Enter the following text: Inertia with a $\omega_0$ value of 0 rad.

Tip: To enter the omega character ($\omega$), click Math on the context bar (or press F5) to switch to the 2-D math mode, type omega, and then press Esc. To enter the subscript, press Ctrl + Shift + the underscore key (Windows and Linux) or Command + Shift + the underscore key (Macintosh) followed by 0. Press the right arrow key to move the cursor from the subscript position. Toggle back to text entry mode by clicking Text on the context bar, and enter the remaining text.

9. Select the text that you entered and change the font to Arial.

10. Click anywhere outside of the text box to complete the annotation.
2.10 Entering Text in 2-D Math Notation

In parameter values and annotations, you can enter text in 2-D math notation, which is a formatting option for adding mathematical elements such as subscripts, superscripts, and Greek characters. As you enter text in 2-D math notation, you can use the command and symbol completion feature to display a list of possible Maple commands or mathematical symbols that you can insert.
The following table lists common key combinations for 2-D math notation:

<table>
<thead>
<tr>
<th>Task</th>
<th>Key Combination</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch between text and 2-D math mode (annotations only)</td>
<td>F5</td>
<td>-</td>
</tr>
<tr>
<td>Command and symbol completion (parameter values and annotations only)</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>1. Enter the first few characters of a symbol name, Greek character, or Maple command.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Enter the key combination for your platform:</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>• Esc, Macintosh, Windows, and Linux</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>• Ctrl + Space, Windows</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>• Ctrl + Shift + Space, Linux</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>3. From the menu, select the symbol or command that you want to insert.</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>Enter a subscript for a variable</td>
<td>Ctrl (or Command) + Shift + underscore (<em>)</em></td>
<td>( x_a )</td>
</tr>
<tr>
<td>Enter a superscript</td>
<td>caret (^)</td>
<td>( x^2 )</td>
</tr>
<tr>
<td>Enter a square root (annotations only)</td>
<td>Enter sqrt and press Ctrl (or Command for Macintosh) + Space.</td>
<td>( \sqrt{x} )</td>
</tr>
<tr>
<td>Enter a root (annotations only)</td>
<td>Enter nthroot and press Ctrl (or Command) + Space.</td>
<td>( n \sqrt[3]{x} )</td>
</tr>
<tr>
<td>Enter a fraction</td>
<td>forward slash (/)</td>
<td>( \frac{1}{8} )</td>
</tr>
<tr>
<td>Enter a piecewise, matrix, or vector row (annotations only)</td>
<td>Ctrl (or Command) + Shift + R</td>
<td>[3 8]</td>
</tr>
<tr>
<td>Enter a table column (annotations only)</td>
<td>Ctrl (or Command) + Shift + C</td>
<td>[6]</td>
</tr>
</tbody>
</table>

For more information, see Using MapleSim > Building a Model > Annotating a Model > Key Combinations for 2-D Math Notation in the MapleSim Help system.
2.11 Creating a Data Set for an Interpolation Table Component

You can create a data set to provide values for an interpolation table component in your model. For example, you can provide custom values for input signals and electrical Current Table and Voltage Table sources. To create a data set, you can either attach a Microsoft® Excel® spreadsheet (.xls or .xlsx) or comma-separated values (.csv) file that contains the custom values, or you can create a data set in Maple using the Data Generation Template or Random Data Template provided in the MapleSim templates dialog box.

For more information about interpolation table components, see the MapleSim Component Library > Signal Blocks > Interpolation Tables > Overview in the MapleSim Help system.

Example: Creating a Data Set in Maple

In this example, you will use the Data Generation Template to create a data set for a MapleSim 1D Lookup Table component. In this template, you can use any Maple commands to create a data set; however, for demonstration purposes, you will create a data set using a computation that has already been defined.

To create a data set in Maple:

1. Open a new MapleSim document.
2. In the Libraries tab, expand the Signal Blocks palette, and then expand the Interpolation Tables menu.
3. Add a 1D Lookup Table component to the Model Workspace.
4. In the Main Toolbar, click Templates (epad).
5. From the templates list, select Data Generation.
6. In the Attachment field, enter My First Data Set and click Create Attachment. The Data Generation Template opens in Maple.
7. To execute the entire worksheet, click (run) at the top of the Maple window.
8. At the bottom of the template, in the Data set name field, enter TestDataSet.
9. To make the data set available in MapleSim, click Attach Data in MapleSim.
10. In MapleSim, under the Project tab, expand the Attachments palette, and then expand the Data Sets category. The data set file appears in the list. You can now assign this data set to the interpolation table component in the Model Workspace.
11. In the Model Workspace, select the 1D Lookup Table component.
12. From the data source field, select attachment.
13. In the Inspector tab, from the data drop-down menu, select the TestDataSet.mpld file. The data set is now assigned to the 1D Lookup Table component.

14. Save the Data Generation Template in Maple and then save your model in MapleSim.

2.12 Best Practices: Building a Model

This section describes best practices to consider when laying out and building a MapleSim model.

Best Practices: Laying Out and Creating Subsystems

To start building your model, drag components from the palettes to the center of the Model Workspace. Drag the components into the arrangement that you want in the Model Workspace and then, if necessary, change their orientation so that the components are facing in the direction that you want. When you have established the position and orientation of the components, connect them in the Model Workspace.

When grouping components into subsystems, make sure that you include logical component groups that fit on one screen at a time. This will allow you to see all of the subsystem components at a certain level without scrolling.

Create Subsystems for Component Groups That You Plan to Reuse

Create subsystems for component groups that you plan to reuse throughout a diagram or in multiple files. For example, if you plan to include multiple planar link models in a pendulum system, you can create a link subsystem so that multiple copies of that component group could be added. If you wanted to add the link subsystem to another pendulum model, you can create a custom library to use the subsystem in another file.

Create Subsystems for Component Groups That You Plan to Analyze

Make sure that you create subsystems for component groups that you plan to analyze in more depth, test, or translate into source code. Several MapleSim templates allow you to analyze and retrieve equations from particular subsystems. The Code Generation Template allows you to generate source code from subsystems only.

For more information about performing analysis tasks, see Analyzing and Manipulating a Model (page 125) in this guide.

Use the Debugging Console to Identify Subsystem Copies and Unconnected Lines

You can display the debugging pane by clicking Debugging ( ) at the bottom of the MapleSim window.
After you run the simulation, the debugging pane displays diagnostic messages that can help you troubleshoot potential errors as you build a model. When you click **Run diagnostic tests** below the debugging pane (or from the **File** menu, select **Check Model**), MapleSim verifies whether your model contains unconnected lines or subsystems that have identical content but are not linked to a subsystem definition. When either of these issues are detected, a message that identifies the subsystem in which the issue is located appears in the debugging console. You can right-click (**Control**-click for Macintosh) the message in the debugging pane to display options that can help you to resolve the issue.

**Best Practices: Building Electrical Models**

**Include a Ground Component in Electrical Circuits**

In each electrical circuit model, you must add and connect a **Ground** component to provide a reference for the voltage signals.

**Verify the Connections of Current and Voltage Sources**

Simulation results can be affected by the way in which a current or voltage source is connected in your model. If you receive unexpected simulation results, verify the connections between electrical sources and other components in your model. All of the current sources in the MapleSim Component Library display an arrow that indicates the direction of the positive current.

![Diagram of a signal voltage source](image1)

Also, all of the voltage sources display a plus sign indicating the location of the positive voltage and a minus sign indicating the location of the negative voltage.

![Diagram of a resistor](image2)

Consider the following **Simple DC Motor** model. Note that the positive port of the **Signal Voltage** source at the left of the diagram is connected to the positive port of the **Resistor** component.
When this model is simulated, MapleSim returns the following results for the torque and speed quantities.

On the other hand, if the negative port of the **Signal Voltage** source is connected to the positive port of the **Resistor** component, as shown in the following model.

MapleSim returns different results for the speed and torque quantities.
Best Practices: Building 1-D Translational Models

Verify That All Force Arrows Are Pointed in the Same Direction

In MapleSim, all of the 1-D translational mechanical components are defined in a 1-D coordinate system with the positive direction defined as the direction of the gray arrow displayed by the component icon.

Any positive forces acting on the model cause the component to move in the direction of the arrow, so make sure that all of the arrows displayed by the 1-D translational mechanical components in your model point in the same direction. As an example, note that all of the force arrows are pointed to the right in the following model.
Figure 2.13: Verifying Force Arrows

For an example of sign convention and how arrow direction represents a force acting on the model, under the Libraries tab, browse to the Examples > User's Guide Examples > Chapter 2 menu, and then open the Constant Acceleration, Sign Convention and Arrow Convention examples.

**Best Practices: Building Multibody Models**

**Connect the Inboard Port of a Rigid Body Frame to a Center-of-mass Frame**

Make sure that you connect the inboard port of any Rigid Body Frame components in your model to the center-of-mass frame of a Rigid Body component. This ensures that the local reference frame used to describe displacements and rotations for the Rigid Body Frame component match with the center-of-mass reference frame defined on the Rigid Body component.

In the following planar link example, the Rigid Body Frame inboard ports (that is, the ports with the icon) are both connected to a Rigid Body component.

Figure 2.14: Center of Mass Placement Best Practice
Best Practices: Building Hydraulic Models

Define Fluid Properties

When building hydraulic models, you must define the properties of the fluid that will be used by placing the **Hydraulic Fluid Properties** component at the top level of your model or at the same level as a hydraulic subsystem. If you place this component at the top level of your model, all hydraulic components and subsystems in your model will inherit the fluid properties defined by that component instance; if you place the **Hydraulic Fluid Properties** component at the same level as a subsystem, all hydraulic components in that subsystem and all nested subsystems will inherit the properties defined by that component instance.

In the following example, all of the hydraulic components in the model inherit the fluid properties defined by the **Hydraulic Fluid Properties** component at the top-right of the diagram.

![Hydraulic Model](image)

Figure 2.15: Hydraulic Model

For a complete tutorial on how to model hydraulic systems, see *Tutorial 8: Modeling Hydraulic Systems (page 204).*
Best Practices: Enforcing Initial Conditions

In complex models, all of the initial conditions might not be independent of each other. In general, use the `enforce` option to strictly enforce as many initial conditions as you have degrees of freedom in your model. However, you can use the `guess` option for a specified initial condition parameter value to help the solver determine the desired starting configuration for your system faster.
3 Creating Custom Modeling Components

In this chapter:

- Understanding Custom Components (page 67)
- Creating Custom Components with Signal-Flow Behavior (page 70)
- Creating Custom Components with Physical Connections (page 76)
- Working with Custom Components in MapleSim (page 78)
- Example: Creating a Nonlinear Spring-Damper Custom Component (page 81)

3.1 Understanding Custom Components

The Custom Component template is an interactive Maple worksheet that lets you quickly create your own specialized MapleSim components without writing code, or having to rearrange your equations for every new model. Creating custom components extends the MapleSim component library, enabling you to create custom modeling components based on the mathematical models that you define. Custom components can use signals, ports with associated physical domains, or a combination of the two. You can also create libraries of custom components and create custom components to contain particular subsystems with specialized functionality.

You can use the Custom Component Template to define system parameters and variables, set the level of equation optimization, generate the equations, and then further analyze the resulting equations. The Custom Component templates contain pre-built embedded components that lets you extract, manipulate and analyze the symbolic system equations generated by any MapleSim model. Using various components from the library, you will create models, set initial conditions and component properties, and assign new values to parameters and variables.

For a complete tutorial on how to create domain specific custom components, see Tutorial 5: Using the Custom Component Template (page 172) Using the Custom Component Template.

There are several different Custom Component templates, each of which can be attached to a model available through the MapleSim Create Attachment templates dialog box, from the View > Create Attachment menu.
Creating a Simple Custom Component

The general process of creating a custom component for a MapleSim model consists of specifying the component equations for the custom component, component parameters and system model, specifying the port types and their values, and generating the component.

To create a custom component:

1. Start a new MapleSim model and click Edit > Create Attachment....
2. Select the Custom Component template and then click Create Attachment. The Maple Custom Component template is loaded.
3. If desired, customize the heading banner with a name, author, and date.
4. In the Equations area, enter the equations for your custom component. Equations, parameters and initial conditions are all entered here. Press Enter at the end of the line.

\[ eq := \begin{align*}
& s(t) = sa(t) - sb(t), \quad 0 = Fa(t) + Fb(t), \quad Fa(t) \\
& = \text{piecewise} \left( s(t) < 0, K \cdot s(t) + B \cdot \frac{d}{dt} s(t), 0 \right), \quad K = 1000, \quad B \\
& = 10 \end{align*} \]

5. In the Parameters section, assign default values and types to model parameters.
6. In the **Variables** section, assign initial values and types for model variables.

7. In the **Ports** section, add ports to the custom components by clicking **Add Port** as shown below. You can control the layout of ports.
   It is possible to define custom ports. To do so, you must first define the custom port using the **Custom Port** template. Then you can use the custom port in this template. For a complete tutorial on how to use custom ports, see *Example: Custom Ports* (page 182) in Chapter 6.

8. Provide the details for the port type, style, name, and port signals.

9. In the **Component Generation** section, enter a name for the component. This is the name shown in the **Definitions** tab in MapleSim for the custom component.

10. Click **Generate MapleSim Component** to create your component and to bring you back into the MapleSim environment. The custom component now appears in the **Definitions** tab under **Components**.

### Typical Uses

The Custom Component template is the most general template and is specifically designed to help you create custom components from algebraic expressions, differential equations, or systems of differential-algebraic equations. The Custom Component Template is a collection of pre-built controls and procedures associated specific Maple commands to easily create new MapleSim components. In addition to the Custom Component, the **Custom Discrete State Space** and the **Custom Discrete Transfer Function** templates implement specified transfer functions, and the **Modelica Custom Component** allows for the creation of a custom component via user-provided Modelica code.

Custom Component templates are more than just containers for your equations. You can also access all of Maple’s functionality to further develop your equations before you generate your Custom Component for your model. This includes access to Maple’s programming language, symbolic algebra functionality, and documentation tools to instantly analyze and verify the behavior of your component.

By using the Custom Component Template you create a custom component in Maple by performing the following tasks:

- Attach a custom component template to your model.
Define and enter your governing equations and properties that determine the behavior of the component (for example, parameters and port variables).

Specify ports for your component.

Define the associated port variable mappings.

Map variables from your equations to the ports.

Generate the component and make it available in MapleSim.

Test and analyze your mathematical model.

The Custom Component Template contains pre-built controls that allow you to perform these tasks with the same validation as for built-in components, preventing invalid connections and parameter values.

**Using The Custom Component Template**

For details on using this template, refer to the help page Using the MapleSim DAE Custom Component Template.

### 3.2 Creating Custom Components with Signal-Flow Behavior

Custom components simplify model construction by reducing the need to connect many signal-flow components together. This example shows how to create a custom component for a simple signal flow equation.

**Creating a Simple Signal-Flow Custom Component**

Create a custom component that implements the following equation

\[ \chi(t) = \gamma(t) + \zeta(t) \]

**To create a custom component**

1. Start a new MapleSim model and Click View > Create Attachment....
2. Select the Custom Component template and click Create Attachment.
3. In the Equations section enter the following equation:

   \[ eq := [\chi(t) = \gamma(t) + \zeta(t) ] \]

**Note:** The equation here is enclosed in square brackets because eq must be assigned a list of equations.

Pressing Enter on this line registers the change.
Figure 3.2: Equations Defining a Custom Component

Tip: The equations in the custom component do not have to be rearranged into an explicit form. For example, you could replace the equation with

\[ eq := x(t) + \log(x(t)^2) = y(t) + z(t) \]

for which there is no explicit solution for the output \( x(t) \). MapleSim solves for \( x(t) \) automatically.

4. Click Refresh All to update the tables.

5. In the Ports section, add three new ports by clicking Add Port three times and dragging them into following positions.

6. Click on the top port on the left-hand side to select it.

7. From the Type drop-down list, select Real Signal. For the Style, select the in radio button. The port is given the default name real_i.
8. Next, associate a variable with the port signal. Select $y(t)$ from the drop-down list as shown in Figure 3.4.

9. Assign the remaining port mappings using the settings in Table 3.1.

<table>
<thead>
<tr>
<th>Port Name</th>
<th>Port Type</th>
<th>Port Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>real_i</td>
<td>Signal Input</td>
<td>$y(t)$</td>
</tr>
<tr>
<td>real1_i</td>
<td>Signal Input</td>
<td>$z(t)$</td>
</tr>
<tr>
<td>real_o</td>
<td>Signal Output</td>
<td>$x(t)$</td>
</tr>
</tbody>
</table>

10. Under the Component Generation section, click Generate MapleSim Component. The custom component equations are generated and assigned to the model. The custom component icon appears in MapleSim under the Definitions tab, in the Components palette.
11. In the following model, drag the custom component into the workspace from the Components palette, connect two signal sources to the input ports on the left, and then place a probe on the right-most port (right-click and select Add Probe) using the components from Table 3.2.
### Table 3.2: Signal Flow Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Number of Components</th>
<th>Symbol</th>
<th>Library Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Component</td>
<td>1</td>
<td><img src="image" alt="Symbol" /></td>
<td>Definitions &gt; Components</td>
<td>Custom settings</td>
</tr>
<tr>
<td>Constant</td>
<td>1</td>
<td><img src="image" alt="Symbol" /></td>
<td>Signal Blocks &gt; Sources &gt; Real</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Sine Source</td>
<td>1</td>
<td><img src="image" alt="Symbol" /></td>
<td>Signal Blocks &gt; Sources &gt; Real</td>
<td>Use default settings</td>
</tr>
</tbody>
</table>

12. Click **Run Simulation (▶)** in the **Main Toolbar**. When the simulation is complete, the following graph appears.
Advantages of Acausal Mapping

Even though the custom component ports are specified as Signal Inputs and Signal Outputs, MapleSim is truly acausal; signals can be inputs or outputs regardless of the pin type. For example, if $\chi(t)$ and $z(t)$ were specified, and a probe was placed on $y(t)$, MapleSim would automatically rearrange the specified equation into $y(t) = \chi(t) + z(t)$.

The concept of signal inputs and outputs are necessary for the code generation capabilities of MapleSim, since the code is 'causalized', MapleSim expects inputs and provides outputs.
Using Differential Equations in Custom Components

Instead of using library components for your model, you can also use differential equations to define your custom component. For example, Figure 3.7 shows the equations that describe the motion of two coupled mass-spring-dampers subjected to a driving force.

\[
\begin{align*}
\text{eq} & := \left[ m_1 \frac{d^2}{dt^2} x_1(t) = -K_1 x_1(t) - B_1 \frac{d}{dt} x_1(t) - K_2 (x_1(t) - x_2(t)) - B_2 \left( \frac{d}{dt} x_1(t) - \frac{d}{dt} x_2(t) \right) \right. \\
& \quad \left. - \frac{d}{dt} x_2(t) \right], \quad m_2 \frac{d^2}{dt^2} x_2(t) = -K_2 (x_2(t) - x_1(t)) - B_2 \left( \frac{d}{dt} x_1(t) - \frac{d}{dt} x_2(t) \right) + F(t) \\
\text{params} & := [K_1 = 1, B_1 = 1, K_2 = 1, B_2 = 1, m_1 = 1, m_2 = 1] \\
\text{initialconditions} & := [x_1(0) = 0, x_2(0) = 0, \dot{x}_1(0) = 0, \dot{x}_2(0) = 0]
\end{align*}
\]

Figure 3.7: Double Mass-Spring-Damper Equations

Figure 3.8 shows how the parameters are mapped to component ports:

Figure 3.8: Port Mapping for Double Mass-Spring-Damper

3.3 Creating Custom Components with Physical Connections

When you create custom components based on physical connections, each connection port has two variables associated with it: the across variable and the through variable. The through variable represents a flow of a conserved quantity (such as heat, mass, current, force or torque) and the across variable represents the driving force in a system (temperature difference, pressure difference, voltage drop, velocity or relative angular velocity).
Table 3.3: Characteristics of Through and Across Variables

<table>
<thead>
<tr>
<th>Characteristics of Through Variables</th>
<th>Characteristics of Across Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conserved quantity (like heat or mass)</td>
<td>Drives the flow of the conserved quantity</td>
</tr>
<tr>
<td>Has a direction of flow</td>
<td>Is a scalar</td>
</tr>
<tr>
<td>Satisfies the relationship input = output + accumulation</td>
<td>Defined as the difference between two points within a physical domain</td>
</tr>
<tr>
<td>Uniform across a domain</td>
<td></td>
</tr>
</tbody>
</table>

Table 3.4 shows the mathematical relationships defining the connection between various across and through variables.

Table 3.4: Through and Across Variable Mathematical Relationship

<table>
<thead>
<tr>
<th>Domain</th>
<th>Governing Equation</th>
<th>Through Variable</th>
<th>Across Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ohm’s Law</td>
<td>$I = \frac{V}{R}$</td>
<td>$I$</td>
<td>$V$</td>
</tr>
<tr>
<td>Electrical Domain</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hagen–Poiseille equation</td>
<td>$\frac{d m}{d t} = \frac{\pi D^4 \rho}{128 L\mu} \cdot P$</td>
<td>$\frac{d m}{d t}$</td>
<td>$P$</td>
</tr>
<tr>
<td>Hydraulic Domain</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fourier's law</td>
<td>$\frac{d Q}{d t} = h A T$</td>
<td>$\frac{d Q}{d t}$</td>
<td>$T$</td>
</tr>
<tr>
<td>Thermal Domain</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Deriving the System Equations for a Resistor

Table 3.5 shows a model of a simple resistor with several variables and one parameter.

Table 3.5: Resistor Variables and Parameters

<table>
<thead>
<tr>
<th>Variable</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$i(t)$</td>
<td></td>
<td>Current</td>
</tr>
<tr>
<td>$v(t)$</td>
<td></td>
<td>Voltage difference</td>
</tr>
<tr>
<td>$v_{\text{Left}}(t)$</td>
<td></td>
<td>Voltage on the left port</td>
</tr>
<tr>
<td>$v_{\text{Right}}(t)$</td>
<td></td>
<td>Voltage on the right port</td>
</tr>
<tr>
<td>$R$</td>
<td></td>
<td>Resistance</td>
</tr>
</tbody>
</table>

Ohm’s Law defines the relationship between the voltage and the current as

$$v(t) = V_{\text{right}}(t) - V_{\text{left}}(t)$$

$$v(t) = i(t) \cdot R$$
Figure 3.9 shows the equations mapped to the custom component ports.

![Resistor Port Mapping](image)

The current $i(t)$ on the right port has a negative sign, representing flow out of the resistor. The current on the left port is positive, representing flow into the resistor. The resistance ($R$) is defined as a parameter available in the Parameter Inspector.

3.4 Working with Custom Components in MapleSim

In MapleSim, you can work with a custom component in the same way as you would work with a subsystem. You can perform the following tasks:

- Add Text and Pictures to a Custom Component
- Save a Custom Component as Part of the Current Model
- Add a Custom Component to a Custom Library
- Edit a Custom Component
- Open Custom Component Examples

Add Text and Pictures to a Custom Component

To customize the appearance of a custom component, you can change the default custom component icon. Select the custom component in the Model Workspace, click Icon \(\text{Icon}\) in the Navigation Toolbar, and use the drawing and annotation tools to add text and illustrations, and to import a custom picture.

To adding a picture to a Custom Component

1. Create a custom component and drag it onto the MapleSim workspace.

2. Right-click the custom component and select Open Component. The component opens in the workspace showing the port connections.
3. In the navigation toolbar, click **Icon**. The default image appears inside the component boundary.

4. Click on the image and then click on the **Drawing Fill** drop-down menu. A list of images appears displaying the Image Browse selection at the bottom.
5. Click Browse... The Load Image window appears.

6. Browse to and select an icon image and then click OK.

7. In the navigation toolbar, click Main to browse to the top level of your model. Your custom component (and all other instances of the same component) will reflect the new icon.

**Save a Custom Component as Part of the Current Model**

When you save a model, the custom component is saved as part of the model. If you run the Prune Model tool on your model, however, an unused custom component definition will be removed. To protect the custom component from potentially being cleaned up by the Prune Model feature, do one of the following:

- Move the custom component from the Components palette of the Definitions tab to the Hierarchy palette.
- Use the custom component in your model: drag the custom component from the Components palette to the Model Workspace.

For more information, see Using MapleSim > Building a Model > Pruning a Model in the MapleSim Help System.
Add a Custom Component to a Custom Library

If you want to use a custom component in a file other than the current model, add the component to a custom library. For more information, see *Creating and Managing Custom Libraries* (page 51).

Edit a Custom Component

If you want to edit a custom component that you have generated, make your changes in the corresponding Maple worksheet and regenerate the component.

To edit a custom component

1. In the MapleSim **Model Workspace**, double-click the custom component that you want to edit. The corresponding Custom Component Template opens in Maple.
2. In the Maple worksheet, edit the equations, properties, or port values.
3. At the bottom of the worksheet, click **Generate MapleSim Component**. Your changes are generated in the custom component displayed in MapleSim.
4. Save your changes in the .mw file and the .msim file to which you added the custom component.

3.5 Example: Creating a Nonlinear Spring-Damper Custom Component

In this example, you will use the Custom Component Template to create a nonlinear spring-damper custom component. The equations defined in this example are based on the **Translational Spring Damper** component in MapleSim. In this case, the stiffness and damping coefficients are replaced with input functions to the component.

To obtain the governing relationships, you can start with a free-body diagram. The diagram for the spring-damper system is shown in the following figure.
The end points, \(a\) and \(b\), can be defined as the ports for the component; the equations are derived relative to these ports. Therefore, the general equation of motion,

\[
d \cdot \frac{d}{dt} s_{\text{rel}}(t) + c \cdot s_{\text{rel}}(t) = F(t)
\]

where \(d\) is the damping coefficient, \(c\) is the stiffness of the spring, and \(s_{\text{rel}}\) is the relative displacement between the two ports \(s_a\) and \(s_b\), can be written as

\[
s_{\text{rel}}(t) = s_b(t) - s_a(t)
\]

Also, an examination of the net force on the system shows that \(F(t) = F_b(t)\), where

\[
F_a(t) + F_b(t) = 0
\]

All of the above relationships are required to define the system behavior.

**Opening the Custom Component Template**

The Custom Component template is part of the MapleSim templates accessed from the Main Toolbar.

To open the Custom Component Template:
1. In MapleSim, open the model to which you want to add the custom component.
2. Click **Templates** in the **Main Toolbar**.
3. In the **Select Template** list, select **Custom Component**.

4. In the **Attachment** field, enter **Nonlinear Spring-Damper** as the name for the template and click **Create Attachment**. The Custom Component Template opens in Maple.

**Defining the Component Name and Equations**

You can now specify the name that will appear for the component in the MapleSim interface and define the equations.

**To define the custom component:**

1. In the Component Description section of the template, specify a component name called **NonLinearSpringDamper**.

2. In the **Equations** section, define the nonlinear system by entering the following equations.

   ```maple
   > eq := [ d(t) * (diff(s_rel(t), t)) + c(t) * s_rel(t) = F(t),
             s_rel(t) = s_b(t) - s_a(t), v_rel(t) = diff(s_rel(t), t),
             F(t) = F_b(t), F_a(t) + F_b(t) = 0 ];
   ```

   Note that the equations are entered in a Maple list. The constants, \(d\) (damping) and \(c\) (stiffness) are replaced by the functions \(d(t)\) and \(c(t)\) to define them as input states to the system.

3. With your cursor on the equation, press **Enter**.

4. In the **Variables** section, click **Refresh All** to see an updated list of variables.

You can now assign these input and output variables to ports that you will include in your generated custom component.

**Defining Component Ports**

In the **Ports** section of the template, you assign input and output variables to ports that will appear in the generated component, and specify the layout of these ports.

**To define the ports:**

1. Click **Add Port** four times. Four squares, which represent the ports that you will lay out and define, appear in the diagram.
2. Drag the ports to position them with one on each side and two on the top of the diagram.

3. Select the port on the left side of the diagram.

4. From the **Type** drop-down menu, select **Translational**.

5. For the style of the port, select **b**. The port's default name is **tflange_b**.

6. First, define the signal **position**. Ensure **Position** is selected in the list under **Signal**. From the drop-down list under **Signal**, select **s[b](t)**.

7. Next, define the signal **force**. Select **Force** in the list under **Signal**. From the drop-down list under **Signal**, select **F[b](t)**. The left port is now defined as a translational flange and associated with the position variable **s[b](t)** and force variable **F[b](t)**.

8. Select the port on the right side of the diagram.

9. From the **Type** drop-down menu, select **Translational**.

10. For the style of the port, select **a**. The port's default name is **tflange_a**.

11. First, define the signal **position**. Ensure **Position** is selected in the list under **Signal**. From the drop-down list under **Signal**, select **s[a](t)**.

12. Next, define the signal **force**. Select **Force** in the list under **Signal**. From the drop-down list under **Signal**, select **F[a](t)**. The left port is now defined as a translational flange and associated with the position variable **s[a](t)** and force variable **F[a](t)**.

13. Select the port at the top left of the diagram.
14. From the **Port Type** drop-down menu, select **Real Signal**. The port's default name is `real_i`.

15. Under **Signal**, select `c(t)` from the drop-down menu. This port is now defined as a signal input and associated with the stiffness variable `c(t)`.

16. Select the port at the top right of the diagram.

17. From the **Port Type** drop-down menu, select **Real Signal**. The port's default name is `real1_i`.

18. Under **Signal**, select `d(t)` from the drop-down menu. This port is now defined as a signal input and associated with the damping variable `d(t)`.

The ports will be displayed in this arrangement when you generate the custom component in MapleSim.

**Generating the Custom Component**

In the **Component Generation** section, specify the name of the custom component as **NonlinearSpringDamper**.

To generate the custom component, click **Generate MapleSim Component**. The generated custom component appears in MapleSim in the **Components** palette of the **Definitions** tab.
You can add the custom component to a model by dragging it into the **Model Workspace**.

*Tutorial 3: Modeling a Nonlinear Damper (page 157)* in Chapter 6 uses this custom component in a model.
4 Simulating and Visualizing a Model

In this chapter:

• How MapleSim Simulates a Model (page 87)
• Simulating a Model (page 89)
• Simulation Progress Messages (page 96)
• Managing Simulation Results and Snapshots (page 96)
• Customizing Plot Window Configurations (page 98)
• Visualizing a Multibody Model (page 103)
• Best Practices: Simulating and Visualizing a Model (page 123)

4.1 How MapleSim Simulates a Model

Modelica Description

The equations for many components in the MapleSim library are described using the Modelica physical modeling language. On the other hand, the equations for multibody components are generated by a special-purpose engine, which uses advanced mathematical techniques to ensure that the equations are as concise and efficient as possible, and then converted to Modelica.

For more information about Modelica, visit http://www.modelica.org

Model Description

Each component in your model contains a system of equations that describes its behavior; these systems of equations can consist of purely algebraic equations or differential equations. Also, a component may define any number of events, which can change the component behavior during a simulation by enabling or disabling part of the equations in the system or changing state values. Connections between two or more components generate additional equations that describe how these components interact.

System Equations

The topology equations (how the components interact) as well as the terminal (component) equations are then collected into one large system and parameter values are also substituted in. Now, the MapleSim simulation engine has a potentially large system of hybrid differential algebraic equations. This means that the system has differential equations with algebraic constraints, as well as discrete events.
Simplified Equations

A process called index reduction reduces the algebraic constraints as much as possible. At the core of this phase is an algorithm that constructs an index-1 DAE system, modified with other symbolic simplification techniques, to reduce the number of equations and variables. Many of these techniques deal with handling of hybrid systems.

You can set initial values for some of the variables by specifying parameter values for certain components in the Inspector tab on the right side of the MapleSim window. If the specified initial conditions are not consistent, an error will be detected during the simulation.

Integration and Event Handling

When all of these preprocessing steps are complete, the integration and event handling process begins. Based on the solver type you chose, a sophisticated DAE solver numerically integrates the system of equations. For the variable solver, algebraic constraints are constantly monitored to avoid constraint drift, which would otherwise affect the solution accuracy. For fixed solver type, algebraic constraints are monitored at each fixed time step.

During integration, inequality conditions that are part of the model are monitored and an event is triggered when one or more of these conditions change. Whenever such an event is encountered, the numeric solver stops and the simulation engine computes a new configuration of the system of equations based on the event conditions. This step also involves recomputing initial conditions for the new system configuration. The solver is then restarted and continues to numerically solve the system until another event is triggered or the simulation end time is reached.

Note: Event handling occurs for both variable and fixed step solvers. The difference is that for fixed step solvers, events are only processed at fixed time steps, whereas with a variable solver, the solver will adjust the time step so that events are processed at exactly the time they occur during the integration.

Simulation Results

In the last step of the simulation process, the results are generated and displayed using graphs showing the quantities of interest and, optionally for multibody mechanical systems, a 3-D animation.
The simulation process is summarized in the following chart:

![Simulation Process Diagram](chart.png)

**Figure 4.1: Simulation Process**

Note that the information in this section is a simplified description of the simulation process. For more information on the DAE solvers used by the simulation engine, see the `dsolve, numeric` topic in the Maple Help system.

### 4.2 Simulating a Model

To view the behavior or response of physical properties (for example, current or voltage), add probes to connection lines, ports, or components in your 2-D or 3-D model. In MapleSim, probes allow you to identify the variables of interest that are associated with connection ports.
If you add a probe to measure a through variable, an arrow appears to indicate the direction of the positive flow in the Model Workspace.

You can specify the simulation duration, the type of solver to use, and other parameter values for the solver, simulation engine, and 3-D Workspace. After running a simulation, a graph appears for each specified quantity.

You can change the original probe or parameter values and run another simulation to compare the results.

For an example of sign convention and how arrow direction represents a force acting on the model, under the Libraries tab, browse to the Examples > User's Guide Examples > Chapter 4 menu, and then open the Constant Acceleration, Sign Convention and Arrow Convention examples.

Simulation and Advanced Simulation Settings

The parameters used for your simulation are found under the Settings tab in the Parameters pane. From here you can access the Simulation and Advanced Simulation settings sections.

For a description of the Multibody and 3-D Visualization settings see 3-D Visualization and Multibody Settings (page 103).

Simulation Settings

In the Simulation section you can specify the simulation duration time, the number of plot points, the solver, and other parameters specific to the solver. See Table 4.1 for a listing and description of the parameters available in the Simulation settings section.
Table 4.1: Simulation Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$t_d$</td>
<td>10s</td>
<td>The duration time of the simulation. You can specify any positive value, including floating-point values. <strong>Note:</strong> The duration time is not the same as the end time of your simulation. The end time for the simulation is given by $t_d + t_s$, where $t_s$ is the start time for the simulation (see Table 4.2).</td>
</tr>
</tbody>
</table>
| Solver Type | Variable | The type of solver to use for the simulation.  
- **Variable:** use a variable time step to maintain error tolerances.  
- **Fixed:** use a fixed time step and disregard integration error.  
**Note:** The fixed step solvers are identical to those used by MapleSim's exported code. |
| Solver | Variable: CK45 (semi-stiff)  
Fixed: Euler | DAE solver used during the simulation. The following choices are available when **Solver Type** is set to **Variable**.  
- **CK45 (semi-stiff):** use a semi-stiff DAE solver (ck45 method).  
- **RKF45 (non-stiff):** use a non-stiff DAE solver (rkf45 method).  
- **Rosenbrock (stiff):** use a stiff DAE solver (Rosenbrock method).  
If your model is complex, you may want to use a stiff DAE solver to reduce the time required to simulate a model.  
The following choices are available when **Solver Type** is set to **Fixed**.  
- **Euler:** use a forward Euler solver.  
- **Implicit Euler:** use an implicit Euler solver (suitable for stiff systems).  
- **RK2:** use a second-order Runge-Kutta solver.  
- **RK3:** use a third-order Runge-Kutta solver.  
- **RK4:** use a fourth-order Runge-Kutta solver. |
| $\epsilon_{abs}$ | $1 \cdot 10^{-5}$ | The limit on the absolute error tolerance for a successful integration step if you are using a variable solver to run the simulation. You can specify a floating-point value for this option. |
The limit on the relative error tolerance for a successful integration step if you are using a variable solver to run the simulation. You can specify a floating-point value for this option.

Uniform size of the sampling periods if you are using a fixed-step solver to run the simulation. You can specify a floating-point value for this option.

Minimum number of points to be plotted in a simulation. The data points are distributed evenly according to the simulation duration value. You can specify a positive integer. Additional points can be added for events (see Plot Events in Table 4.2).

The simulation engine uses a 'Plot points' value which is a maximum of:

- the 'Plot points' setting or
- '3D Sample Rate' [fps] * simulation duration (if '3-D Animation' is enabled), or
- '3D Sample Rate' [fps] * '3-D Playback Time' (if '3-D Animation' is enabled and '3-D Playback Time' is specified)

**Note:** This option allows you to specify the number of points for display purposes only. The actual number of points used during the simulation may differ from the number of points in the simulation graph.

### Advanced Simulation Settings

In the Advanced Simulation section you can specify the simulation start time, a state snapshot to use, compilation options, and other settings. Some of these settings are specific to the solver type (variable or fixed) selected in the Simulation settings. See Table 4.2 for a listing and description of the parameters available in the Advanced Simulation settings.
Table 4.2: Advanced Simulation Settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Solver Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( t_s )</td>
<td>0</td>
<td>All</td>
<td>The simulation start time. You can specify any floating-point value, including negative values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> The simulation start time affects the end time of your simulation, but not the duration time for the simulation, ( t_d ). The end time for the simulation is given by ( t_d + t_s ).</td>
</tr>
<tr>
<td>Use Snapshot</td>
<td>None</td>
<td>All</td>
<td>A snapshot captures the state of your simulation at a specific time. If you use a snapshot in your simulation, you can override the initial conditions used in your model and replace them with the state your model was in at the time of the snapshot. See <em>Managing Simulation Results and Snapshots</em> (page 96) for more information on snapshots.</td>
</tr>
<tr>
<td>Baumgarte</td>
<td></td>
<td>All</td>
<td>Apply Baumgarte constraint stabilization to your model. Select to enter values for the derivative gain (alpha) and the proportional gain (beta) that are appropriate for your model.</td>
</tr>
<tr>
<td>Jacobian</td>
<td>Symbolic</td>
<td>All</td>
<td>Choose between a symbolic or numeric approximation to the system Jacobian. A symbolic formulation results in faster and more accurate simulations but can take longer to formulate. <strong>Note:</strong> A numeric formulation can only be used with stiff solvers (Rosenbrock or Implicit Euler).</td>
</tr>
<tr>
<td>Projection</td>
<td></td>
<td>All</td>
<td>Apply constraint projection to your model. Select to project back the solution found at each step of the simulation to the constraint manifold. The projection ends when either the maximum number of Projection Iterations is reached or the defection falls below the Projection Tolerance.</td>
</tr>
<tr>
<td>Projection Iterations</td>
<td>50</td>
<td>All</td>
<td>The maximum number of constraint projection iterations. <strong>Note:</strong> This parameter is only available when Projection is selected.</td>
</tr>
<tr>
<td>Projection Tolerance</td>
<td>0.000010</td>
<td>Fixed</td>
<td>The tolerance value at which the projection iterations are terminated. You can specify any positive floating-point value.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Solver Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------</td>
<td>-------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Event Projection</td>
<td></td>
<td>Fixed</td>
<td>Select to have constraint projection occur during event iterations, but with slower integration results. Not selecting, may cause the simulation to fail if the event changes the solution to the point of not allowing the application of constraint projection at the next step.</td>
</tr>
<tr>
<td>Event Iterations</td>
<td>100</td>
<td>All</td>
<td>The maximum number of event iterations allowed before the integrator throws an error. You can specify any positive integer value.</td>
</tr>
<tr>
<td>Event Hysteresis</td>
<td>1.0 \times 10^{-7}</td>
<td>Fixed</td>
<td>The width of the event hysteresis band. You can specify a floating-point value greater than or equal to zero. If set to zero, this parameter is disabled.</td>
</tr>
<tr>
<td>Index 1 Error Control</td>
<td></td>
<td>Variable</td>
<td>When selected, error control is applied to all algebraic variables. By default, error control is only applied to algebraic variables that trigger events, are plotted, or are outputs of functions.</td>
</tr>
<tr>
<td>Index 1 Tolerance</td>
<td>1.0</td>
<td>Variable</td>
<td>Controls the relative error on algebraic variables compared to differential variables. For example, a value of 10 means that algebraic variables can have 10 times the error of differential variables.</td>
</tr>
<tr>
<td>Initial Hysteresis</td>
<td>1.0 \times 10^{-10}</td>
<td>Variable</td>
<td>The width of the event hysteresis for all event triggers at the start of the simulation. You can specify a floating-point value greater than or equal to zero.</td>
</tr>
<tr>
<td>Scaling</td>
<td>None</td>
<td>Variable</td>
<td>Specifies the method of variable scaling to apply to the system. The available choices are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• None: do not apply scaling</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Minimum: use the minimum nominal value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Maximum: use the maximum nominal value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Geometric: use the geometric mean of the nominal values</td>
</tr>
<tr>
<td>Minimize Events</td>
<td></td>
<td>Variable</td>
<td>This option specifies whether or not to use heuristics to reduce the number of events encountered during your simulation. When selected, the mapping of piecewise transitions into events does not occur.</td>
</tr>
<tr>
<td>Solver Diagnostics</td>
<td></td>
<td>All</td>
<td>When selected, the simulation generates diagnostics describing constraint iterations, constraint residual, event iterations, and step size, and plots them after the simulation is complete in a Solver Diagnostics plot configuration in the Simulation Results window. For systems with the projection option cleared, this incurs additional computational cost.</td>
</tr>
</tbody>
</table>
### Editing Probe Values

In the **Project** tab, the **Probes** palette lists all of the probes that you have added to the current MapleSim model.

If a probe is attached at the top level of your model, **Main** appears in parentheses beside the probe name; otherwise, the subsystem for the attached probe appears beside the probe name. In the image shown above, three probes have been attached to a model: **Probe1** and **Probe2** at the top level of the model and **Probe3** in a subsystem called **Gear Components1**.

You can click the entries in this palette to browse to a probe in the **Model Workspace**, and view and edit the probe values in the **Inspector** tab. You can also right-click (**Control**-click for Macintosh) entries in this palette and manipulate probes using context menus.

For more information, see **Using MapleSim > Simulating a Model > Using Probes > Editing Probe Values** in the MapleSim Help system.

### Storing Parameter Sets to Compare Simulation Results

You can store a group of parameter values that are assigned to a model in a parameter set. You can then run a simulation using one parameter set, replace those parameter values with another parameter set, and run another simulation to compare the results.

For more information, see the **Using MapleSim > Building a Model > Using Parameter Sets > Saving and Applying Parameter Sets** section in the MapleSim Help system.
4.3 Simulation Progress Messages

During a simulation, you can view progress messages in the Console pane located below the Model Workspace. These messages indicate the status of the MapleSim engine as it generates a mathematical model; these messages can help you to debug simulation errors.

![Simulation Progress Messages](image)

Optionally, before running a simulation, you can specify the amount of detail in progress messages by clicking Message Console ( ) at the bottom of the MapleSim window and selecting a level from the drop-down menu.

To clear the messages from the console, click Clear Console ( ).

4.4 Managing Simulation Results and Snapshots

The Stored Results palette in the Simulation Results window allows you to view, save, and export results generated from multiple simulations. In addition, for each of your stored results, you can save and export snapshots that record all of the state variables for your model at a particular time during the simulation.

**Storing Results**

Whenever you simulate a model, the results are saved as Latest Results in the Stored Results palette. This entry contains all the graphs, progress messages, and (if applicable) the 3-D animation generated from your simulation. However, each new simulation overwrites the results stored in the Latest Results entry.

To store a simulation result under a new name, right-click (Control-click for Macintosh) on the Latest Results entry, select Save from the context menu, and then provide a name.
for the stored result. You can save simulation results to compare and refer to multiple graphs generated during the current MapleSim session.

If you save the stored result and then save your model, when you open the model in a future MapleSim session, the stored result will be available in the Stored Results palette. However, Latest Results is not saved when you close and reopen the model.

**Saving and Using Snapshots**

You can save the state information by taking a snapshot of your simulation at a particular time and saving the snapshot as part of a stored result. Saving a snapshot allows you to use the state information in subsequent simulations. Manage snapshots, including creating new snapshots and selecting a snapshot to use in the next simulation, through the Advanced Simulation settings (see Table 4.2).

When you use a snapshot in this way, the information recorded in the snapshot provides the initial conditions for subsequent simulations.

When no snapshot is selected for use in simulation, the Run Simulation icon in the toolbar is . When a snapshot is selected for use in simulation, the Run Simulation icon changes to . When a snapshot is used in a simulation, that information is available in the tooltip of the resulting entry in the Stored Results palette.
4.5 Customizing Plot Window Configurations

By default, probed quantities are plotted in separate simulation graphs in a plot window called **Probe Plots**. In each graph, the quantity values are plotted along the y-axis versus the simulation time values along the x-axis.

You can optionally create custom plot window configurations. You might want to create a custom plot window if, for example, you want to compare multiple quantities in the same graph, plot one quantity versus another, or view a simulation graph for a specific quantity without editing other probe values. You can even compare quantities from two different models. You can further customize a plot window by for instance customizing plot titles and specifying the number of columns to appear in the plot window.

For details on creating a plot window, refer to **Generating a New Plot Window Configuration**. For more information on plot windows, refer to the **Using MapleSim > Simulating a Model > Working with Plot Window Configurations** section of the MapleSim Help System.

When you create a new plot window, it will be populated with data without having to run the simulation again.

**Tip:** When you save and reopen a model with stored results, the plots may initially show the message *No data available*. You can load the plots by right-clicking on an entry in the **Stored Results** palette and selecting **Show Probe Plots**.

If you want to work with your simulation data in another application, you can export your results to a Microsoft Excel (.xls) or comma-separated value (.csv) file. For details, refer to **Exporting Simulation Graph Data**.

In the following examples, you will create custom plot window configurations.
Example: Plotting Multiple Quantities in Individual Graphs

In this example, you will view the **Probe Plots** and then create a plot window configuration in which you will add a second variable to each custom plot.

To view the Probe Plots:

1. Under the **Libraries** tab, browse to the **Examples > Physical Domains > Multibody** menu, and then click the **Double Pendulum** example.

2. Click **Run Simulation** (▶) in the **Main Toolbar**. The Simulation Results window opens displaying the 3-D Playback Window and the Probe Plots. See Figure 4.5.

![Figure 4.5: Simulation Graphs](image)

To create a custom plot window configuration:

1. In the **Plots** palette, double-click on the following plots to hide them from view: Output1.w, Output2.a, Output2.phi, Output2.w. The plots window should now show just two plots, **Output1.a** and **Output1.phi**.

2. Press Shift and click the **Duplicate the Plot Window** button (▶). A new plot window with the name PlotWindow1 is created containing the currently visible plots.

3. In the **Plots** palette, right-click on PlotWindow1, and select **Rename**.
4. Enter the name **Acceleration and Angle Comparison**. Click OK.
   **Tip:** To return the Probe Plots to its original view, right-click on **Probe Plots** in the **Plots** palette and select **Show All Plots**.

5. In the plots window, select the plot **Output1.a** from the **Acceleration and Angle Comparison** plot window.

6. In the **Variables** palette, under **Output2**, select **a**.

7. Click **Add Selected Variable to Selected Plot**. The plot now shows two curves, **Output1.a** and **Output2.a**.

8. In the plots window, select the plot **Output1.phi** from the **Acceleration and Angle Comparison** plot window.

9. In the **Variables** palette, under **Output2**, select **phi**.

10. Click **Add Selected Variable to Selected Plot**. The plot now shows both curves.

11. In the **Plots** palette, under **Acceleration and Angle Comparison**, right-click on **Output1.a** (the name of the first plot), and select **Rename**.

12. Enter the name **Acceleration (a)**. This changes the title of the plot.

13. In the **Plots** palette, under **Acceleration and Angle Comparison**, right-click on **Output1.phi** (the name of the second plot), and select **Rename**.

14. Enter the name **Angle (phi)**.

The resulting plots are shown in **Figure 4.6**.
Example: Plotting One Quantity versus Another

In this example, you will create a custom plot window to plot the X and Y position of each of the links of a double pendulum.

To plot one quantity versus another in a custom plot window:

1. Under the Libraries tab, browse to the Examples > Physical Domains > Multibody menu, and then click the Double Pendulum example.
2. In the Model Workspace toolbar, click Attach Probe (_attach__).
3. Click the right port of the \( L_1 \) shared subsystem.
4. Click on an empty area of the Model Workspace to position the probe.
5. In the Inspector tab, label this probe FirstLink, and then select Length[1] and Length[2].
6. Add another probe that measures the Length[1] and Length[2] quantities to the right port of the \( L_2 \) shared subsystem, and label this probe SecondLink.
7. Click Run Simulation (play) in the Main Toolbar. The Simulation Results window opens displaying the Probe Plots.
8. We want the plots window to only show two plots, FirstLink.r_0[2] and SecondLink.r_0[2], which will be the basis for creating a new plot window configuration. In the Plots palette, double-click on the names of the other plots to hide them from view.
9. Press Shift and click the Duplicate the Plot Window button (_duplicate_plot_window). A new plot window with the name PlotWindow1 is created containing the currently visible plots.
10. In the Plots palette, right-click on PlotWindow1, and select Rename.
11. Enter the name X versus Y. Click OK.
   Tip: To return the Probe Plots to its original view, right-click on Probe Plots in the Plots palette and select Show All Plots.
12. In the Plots palette, under X versus Y, right-click on FirstLink.r_0[2] (the name of the first plot), and select Rename.
13. Enter the name Top Link. This changes the title of the plot.
14. Similarly, change the name of the plot SecondLink.r_0[2] to Bottom Link.
15. In the plots window, select the plot Top Link from the X versus Y plot window.
16. In the Variables palette, select FirstLink: r_0[1].
17. Click Place Selected Variable on x-Axis (_place_on_x_axis). In the plots window, select the plot Bottom Link from the X versus Y plot window.
19. In the Variables palette, select \textbf{SecondLink: r_0[1]}.

20. Click \textbf{Place Selected Variable on x-Axis} (\includegraphics[width=0.1\textwidth]{icons/variable.png}).

21. In the \textbf{Plotting Toolbar}, use the slider to change the number of plot columns to 1. The resulting plots are shown in \textbf{Figure 4.7}.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{figures/figure_4_7.png}
\caption{Plot One Quantity Versus Another}
\end{figure}
The plots above show the motion of the end point of each link in the pendulum. The bottom link follows a more disorderly path because of the interaction with the top link.

4.6 Visualizing a Multibody Model

In MapleSim, the 3-D visualization environment allows you to build and analyze 3-D graphical representations of multibody systems. As you build a model and change its parameters, you can validate the 3-D configuration of the model and visually analyze your simulation results. You can build 3-D models by dragging and connecting objects in the 3-D Workspace, and you can visualize your simulation results by playing animations that depict the movement of the objects.

As you build a block diagram in the Model Workspace, the corresponding changes are automatically reflected in the 3-D representation in the 3-D Workspace. Similarly, when you build a model in the 3-D Workspace, the corresponding changes are automatically reflected in the block diagram in the Model Workspace. Changes that you make in either of the workspaces are shown in both the Model Workspace and 3-D Workspace as you edit your model.

In the 3-D Workspace, you can view your model from any direction. Also, you can attach 3-D shapes to parts of your model to create a realistic-looking system representation. These shapes can either be imported from an external CAD file or selected from the Multibody > Visualization palette in the Libraries tab.

After simulating your model, you can animate your 3-D model in playback mode. You can control playback options to focus on specific components and their motions, for instance by specifying camera tracking options to center an object in the 3-D Playback Window during an animation. You can also attach trace lines to show where components move during an animation.

CAD geometry and visualization shapes are drawn transparent in the 3-D Construct Window and non-transparent in Playback mode.

For more information about adding 3-D shapes and using the 3-D Workspace, see the Using MapleSim > Visualizing a Model section of the MapleSim Help system.

3-D Visualization and Multibody Settings

The parameters used for 3-D visualization of multibody mechanical components are found under the Settings tab in the Multibody and 3-D Visualization sections.
### 3-D Visualization Settings

You can specify the following 3-D Visualization values for models containing multibody mechanical components:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-D Animation</td>
<td>✔</td>
<td>Specifies whether a 3-D animation is generated after running a simulation. When this option is cleared, no 3-D animation is generated. If your model is complex and if you do not plan on animating your model, you may want to clear this option to reduce the time required to run a simulation.</td>
</tr>
<tr>
<td>3-D Playback Time</td>
<td>-</td>
<td>Specifies the playback duration of the 3-D animation in seconds. This value differs from the ( t_d ) value, which in comparison specifies the simulation duration represented in your simulation graphs. You can specify a floating-point value for this option when the 3-D Animation field is selected. You can specify a value in this field to increase or decrease the speed at which an animation is played. For example, if the ( t_d ) value is set to 0.5 seconds, you can set the 3-D Playback Time value to 10 seconds to slow down the animation; an animation of the 0.5 second simulation would then be played back over a span of 10 seconds in real time. If no value is specified in this field, the 3-D Playback Time value is the same as the value entered in the ( t_d ) field: an animation of a 10 second simulation, for example, would be played back over a span of 10 seconds in real time. The number of frames represented in an animation is determined by the value specified in the Plot Points field, and the 3-D Playback Time value multiplied by the 3-D Sampling Rate value.</td>
</tr>
<tr>
<td>3-D Sampling Rate</td>
<td>40</td>
<td>Number of frames per second to include in the 3-D animation playback. You can increase this value to create an animation with smoother playback. You can specify a positive integer for this option when the 3-D Animation field is set to \text{true}. The default value is 40 fps for new models.</td>
</tr>
<tr>
<td>Enable Translational Snapping</td>
<td>❌</td>
<td>When selected, components are positioned at the closest location in 3-D space based on the translation snap delta value.</td>
</tr>
<tr>
<td>Translation Snap Delta</td>
<td>1.0</td>
<td>Specifies the translation snap delta spacing.</td>
</tr>
</tbody>
</table>
When selected, components are positioned at the closest location in 3-D space based on the rotation snap delta value.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Rotational Snapping</td>
<td></td>
<td>When selected, components are positioned at the closest location in 3-D space based on the rotation snap delta value.</td>
</tr>
<tr>
<td>Rotation Snap Delta</td>
<td>0.785398163</td>
<td>Specifies the rotational snap delta spacing.</td>
</tr>
<tr>
<td>Perspective Grid Extent</td>
<td>10.0</td>
<td>Specifies the size of the grid drawn in the perspective view. The grid extends this distance in both directions on the horizontal plane.</td>
</tr>
<tr>
<td>Grid Spacing</td>
<td>1.0</td>
<td>Specifies the space between grid lines.</td>
</tr>
<tr>
<td>Base Radius</td>
<td>0.1</td>
<td>Implicit geometry consists of spheres and cylinders representing multibody components in the 3-D Visualization Area - Construct Mode. Cylinders are drawn using Base Radius, while spheres (for Rigid Bodies and Joints) are drawn using Base Radius * 2.</td>
</tr>
<tr>
<td>Enable View Change Animations</td>
<td>✔</td>
<td>When enabled, a smooth transition occurs when switching between 3-D orthographic and perspective views and when using Fit Scene, Fit Selected, or Fit Animation in the 3-D Construct and Playback modes.</td>
</tr>
</tbody>
</table>

**Multibody Settings**

You can specify the following parameter values for models containing multibody mechanical components:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \vec{g} )</td>
<td>([0, -1, 0])</td>
<td>Direction of gravity.</td>
</tr>
<tr>
<td>( g )</td>
<td>9.81</td>
<td>The acceleration due to gravity at the surface of the Earth. The default units are in ( \frac{m}{s^2} ).</td>
</tr>
</tbody>
</table>

**The 3-D Workspace**

The 3-D Workspace is the area in which you build and view 3-D models in the MapleSim window.

**To enter 3-D construct mode:**

- From the View menu, select Show 3-D Construct Window... The Visualization window opens showing the 3-D construct window. Alternatively, from the MapleSim main toolbar, click Show 3-D Construct Window ( ).
Figure 4.8: 3-D Workspace

Table 4.5: 3-D Workspace Controls

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-D Construct Window</td>
<td>The area in which you build and view a 3-D model. The arrows at the origin indicate the directions of the world axes and are designated by color:</td>
</tr>
<tr>
<td></td>
<td>![Diagram of arrows indicating world axes (X: red, Y: green, Z: blue)]</td>
</tr>
<tr>
<td></td>
<td>You can use the grid as a reference to determine the relative sizes and positions of elements in your 3-D model.</td>
</tr>
<tr>
<td>3-D Toolbar</td>
<td>Contains tools for hiding and displaying components in the 3-D Workspace, toggling between different modes, selecting camera navigation tools, and changing the 3-D model view.</td>
</tr>
<tr>
<td>Construct Mode Controls</td>
<td>Part of the 3-D toolbar, these are controls for building and assembling a 3-D model, and connecting 3-D objects.</td>
</tr>
</tbody>
</table>

You can hover your mouse pointer over any of the buttons on the toolbar to view its tooltip.
Viewing and Browsing 3-D Models

In the 3-D Workspace, you can view and browse a 3-D model from the perspective view or one of the orthographic views using the 3-D View Controls tool.

The perspective view allows you to examine and browse a model from all angles in 3-D space. It allows you to see 3-D spatial relationships between elements in your model. In the perspective view, objects that are closer to the camera appear larger than those that are further away from the camera.

In the following image, a double pendulum model is shown from the perspective view.

You can also view your 3-D model from front, top, and side orthographic views. Orthographic views use parallel projection as opposed to perspective projection, so your 3-D model appears as a flattened object because no depth information is shown. Orthographic views are sometimes referred to as "true length" views because they display undistorted lines and distances in the view plane that is orthogonal to the camera direction; these views are useful for analyzing spatial relationships or clearances between objects.

In the following image, the double pendulum model is shown from the top orthographic view.
You can browse a model and change the model view while an animation is static or playing. In all of the views, you can pan and zoom into or out from your model. In the perspective view, you can also move the camera to view your model from above or below, and from any direction around your model.

**Tip:** Before panning, zooming, or moving the camera around a large 3-D model, hover your mouse pointer over the object that you want to focus on. MapleSim adjusts the navigation controls according to the object on which you place the mouse pointer.

### Adding Shapes to a 3-D Model

#### Adding Implicit Geometry

By default, basic spheres and cylinders called *implicit geometry* appear in the **3-D Workspace** to represent physical components in your model. For example, consider the following double pendulum model, which contains two revolute joints and two subsystems that represent planar links.

In the **3-D Workspace**, the implicit geometry of the fully assembled pendulum model appears as follows.
In this example, the spheres represent the revolute joints and rigid bodies, and the cylinders represent the planar links.

Implicit geometry that is not connected to other implicit geometry is drawn in a light gray color; implicit geometry that is assembled is drawn in a dark gray color, with the exception of joint objects, which are drawn in red.

**Note:** Components that you exclude from a simulation in the Model Workspace do not appear in the 3-D Workspace.

### Adding Attached Shapes

If you want to create a more realistic representation of your model, you can add shapes and lines called *attached shapes* to your model. To do so, you first add and connect attached shape components from the Multibody > Visualization palette to your block diagram in the Model Workspace.

When you simulate your model, the attached shapes appear in the 3-D Workspace, in addition to the implicit geometry. In the following image, attached shapes have been added to represent the pendulum stem and bob pictorially. Also, a trace line—the curved line in the image—can be set to depict the locus of points that will be traced by a particular part of the model during a simulation.
You can customize the color, size, scale, and other visual aspects of the attached shapes by setting parameter values for individual components in the Settings tab before simulating the model.

If you want to view only the implicit geometry in the 3-D Workspace, you can hide the attached shapes by clicking Show/hide attached shapes (赧) in the 3-D Toolbar. If you want to view the attached shapes only, you can hide the implicit geometry by clicking Show/hide implicit geometry (ixels). For more information about attached shape components, see the MapleSim Component Library > Multibody > Visualization > Overview in the MapleSim Help system.

Note: If your model contains Flexible Beam components, deflection of the beam will not be depicted in the implicit geometry of your 3-D model.

Example: Adding Attached Shapes to a Double Pendulum Model

In the following example, you will add cylinder shapes to represent the pendulum stem and a sphere component to represent the pendulum bob. You will also add a Path Trace component to display the path on which the revolute joint will move during an animation.

To add attached shapes

1. Under the Libraries tab, browse to the Examples > Physical Domains > Multibody menu, and then click the Double Pendulum example.
2. Expand the Multibody palette and then expand the Visualization menu.
3. Add two Cylindrical Geometry components below the planar link subsystems in the Model Workspace.
4. Connect the components as shown below.

5. From the same menu, add a Spherical Geometry component and place it to the right of the L2 shared subsystem.
6. Right-click (Control-click for Macintosh) the Spherical Geometry component and select Flip Horizontal.

7. Add a Path Trace component and place it between the two Cylindrical Geometry components.

8. Connect the components as shown below.

9. Select the first Cylindrical Geometry component ($C_1$ in the previous figure) in the Model Workspace.

10. In the Inspector tab on the right side of the MapleSim window, change the radius of the cylinder to 0.2.

11. To select a color for the cylinder, click the box beside the color field and click one of the color swatches.

12. Select the second Cylindrical Geometry component ($C_2$ in the previous figure) in the Model Workspace.

13. Change the radius of this cylinder to 0.2 and change the color.

14. Select the Spherical Geometry component ($S_1$ in the previous figure).

15. Change the radius of the sphere to 0.8 and change the color.

16. To simulate the model, click Run Simulation (play) in the Main Toolbar.

When the simulation is complete, the 3-D Workspace appears. The 3-D Workspace is set to playback mode automatically and displays your model with the attached shapes.
17. To animate the model, click Play (►) below the 3-D Workspace.

For another example of how to use the Path Trace component, under the Libraries tab, browse to the Examples > User's Guide Examples > Chapter 4 menu, and then open the Lorenz Attractor example.

Building a Model in the 3-D Workspace

You can build MapleSim models by adding and connecting objects in the 3-D Construct Window. To add multibody components to a 3-D model, put the 3-D construct window beside the main MapleSim window, then drag the desired components from the Multibody palette, the Favorites palette, a custom library that you created, or from the search pane in the Libraries tab to the 3-D construct window.

In 3-D construct mode, you can add, connect, and lay out 3-D objects, and set initial conditions for joints and other multibody components by using graphical controls in the 3-D Workspace.

Any changes that you make to your 3-D model are automatically shown in the block diagram representation in the Model Workspace and vice versa. For example, if you add and connect a Flexible Beam component in the 3-D Workspace, the block diagram representation of the Flexible Beam with the added connection lines appear in the Model Workspace at the same time.

Notes:

• Subsystems cannot be created in the 3-D Workspace. They must be created in the Model Workspace.

• Components from the multibody Forces and Moments, Sensors, and Visualization component libraries cannot be dragged into the 3-D Workspace. You must add these components in the Model Workspace.

Moving Objects in the 3-D Workspace

In construct mode, you can position individual objects or groups of objects by clicking and dragging the 3-D manipulators in the 3-D Construct Window.

To display the 3-D manipulator for a single unconnected object, click the object once in the 3-D Construct Window. You can then click and drag the blue arrow of the 3-D manipulator.
to move the object along the Z axis, the green arrow to move the object along the Y axis, and the red arrow to move the object along the X axis. You can also click and drag the sphere at the center of the 3-D manipulator to move the object in all directions.

For a group of connected objects, the configuration of your model determines where the 3-D manipulators are located.

- If your 3-D model contains a **Fixed Frame** component, click the square that represents the **Fixed Frame** component to display the 3-D manipulator.

- If your model does not contain a **Fixed Frame** component, click the object that defines the initial conditions for your system to display the 3-D manipulator. For example, if your model contains a **Rigid Body** component with its initial condition parameters set to **Strictly Enforce**, that **Rigid Body** component displays the 3-D manipulator. When a model is moved in the **3-D Construct Window**, the initial conditions are updated for all of the other **Rigid Body** components that depend on the **Rigid Body** component that has its initial conditions set to **Strictly Enforce**.

- If your model does not contain a **Fixed Frame** component or a **Rigid Body** component with its initial conditions set to **Strictly Enforce**, click any of the objects in your 3-D model to display the 3-D manipulator. When you move the group of objects, the initial conditions of all of the multibody components in your model are set to **Treat as Guess**.

**Note:** To display 3-D manipulators, the multibody components in your model must contain numeric parameter values. If custom parameter values defined in a parameter block, global parameter, or subsystem parameter are assigned to a multibody component, no 3-D manipulator will appear when you click that component in the **3-D Construct Window**.

### Assembling a 3-D Model

A 3-D model must be *assembled* before you can animate it. Assembling a 3-D model refers to synchronizing the model that appears in the **3-D Construct Window** with the initial configuration of your model defined by the assigned parameter values and initial condition guess values. The synchronization process occurs automatically when you simulate your model. Alternatively, click **Update 3-D View** ( ) in the **3-D Toolbar** to assemble the model. In the **3-D Construct Window**, assembled implicit geometry is drawn in a dark gray color, with the exception of joint objects, which are drawn in red.

**Note:** You can only assemble 3-D models with a valid configuration and valid connection lines. For example, if you attempt to assemble a 3-D model with missing connection lines, an error message appears in the console pane and no animation is generated.

For more information, see Assembling a 3-D Model in the MapleSim Help system.
Using the Unenforce Constraints Button to Manipulate Joints in the 3-D Workspace

In construct mode, you can select a joint object in the 3-D Workspace and click Unenforce Kinematic Constraints to specify that the kinematic constraints of the joint are not enforced in the 3-D Workspace as you build your model. Joints with unenforced kinematic constraints appear in pink in the 3-D Workspace and their initial conditions are not shown in the 3-D Workspace as you build your model.

You may want to use Unenforce Kinematic Constraints if, for example, you are creating a closed-loop model in the 3-D Workspace and you need a joint to remain in a specific position as you are building and laying out your 3-D model.

Notes:

• The unenforce constraints button does not affect the actual initial conditions specified for your joint components in the Inspector tab; it affects the initial conditions depicted in the 3-D Workspace for display purposes only.

• Initial conditions for other joints with enforced kinematic constraints will be shown in the 3-D Workspace, but will not affect related joints with unenforced kinematic constraints.

For example, consider a double pendulum 3-D model that contains a revolute joint with unenforced kinematic constraints and a second revolute joint with enforced kinematic constraints. If you change the initial angle of the joint with enforced kinematic constraints, the joint with the unenforced kinematic constraints will remain in its original position while the joint with enforced kinematic constraints will be shown at the new initial angle. To display all of the new initial conditions in the 3-D Workspace, you must assemble your model by running a simulation or clicking Update 3-D View.

Displaying Attached Shapes as You Build a 3-D Model

When you connect Cylindrical Geometry, Tapered Cylinder Geometry, Box Geometry, or Spherical Geometry components to your block diagram in the Model Workspace, the corresponding attached shapes appear in both the 3-D Construct Window and the 3-D Playback Window. The attached shape appears in the 3-D Workspace after you connect all of its ports to compatible ports of multibody components in the Model Workspace.

Working with CAD Geometry

CAD geometry can also be shown in both the 3-D Construct Window and the 3-D Playback Window. When you add a CAD Geometry component anywhere in the Model Workspace, the corresponding CAD image appears in the 3-D Workspace regardless of whether the
CAD Geometry component is connected to other components in your model. If a CAD Geometry component is not connected to other components, it will be drawn at the origin of the 3-D grid; if a CAD Geometry component is connected to another component, it will be drawn at the origin of the coordinate frame of the modeling component to which it is attached.

You can define the translational and rotational offset for CAD images either before or after connecting the corresponding CAD Geometry component to your model. To define these offsets, select the CAD Geometry component in the Model Workspace and specify parameter values in the Inspector tab.

**Example: Building and Animating a Double Pendulum Model in the 3-D Workspace**

In this example, you will build and animate a double pendulum model. You will perform the following tasks:

**To build and animate a double pendulum:**
1. Add and move objects in the 3-D Workspace.
2. Connect the 3-D objects.
3. Set initial conditions for the joints in your model.
4. Animate the 3-D model.

**Adding and Moving Objects in the 3-D Workspace**

**To add or move an object:**
1. Open a new MapleSim document.
2. From the MapleSim main toolbar, click Show 3-D Construct Window ( ), and arrange that window beside the main MapleSim window.
3. Under the Libraries tab, expand the Multibody palette, and then expand the Bodies and Frames menu.
4. From the palette, drag a Fixed Frame component into the 3-D Workspace. A gray square, which represents the Fixed Frame component, is added to the 3-D Workspace and its 3-D manipulator appears.
You can use this manipulator to position objects in the **3-D Workspace**.

5. Position the **Fixed Frame** object at the origin of the grid by clicking and dragging the 3-D manipulator arrow controls.

6. From the **Multibody > Joints and Motions** menu, drag a **Revolute** component into the **3-D Workspace** and place it to the right of the **Fixed Frame**.

7. From the **Multibody > Bodies and Frames** menu, drag a **RigidBodyFrame** component into the **3-D Workspace** and place it to the right of the **Revolute** component.

8. From the same menu, drag a **RigidBody** component into the **3-D Workspace** and place it to the right of the **RigidBodyFrame**.

**Tip:** To zoom into and out from the **3-D Workspace**, hover your mouse pointer over the object that you want to focus on and rotate your mouse wheel. When zooming with the mouse wheel, the location under the pointer remains in place, allowing you to zoom in on that location. To pan your model, hold the **Shift** key and drag your mouse pointer in the **3-D Workspace**.
9. From the same menu, drag another **Rigid Body Frame** component into the **3-D Workspace** and place it to the right of the **Rigid Body**. The components for the first pendulum link have been added.

10. Repeat steps 6 to 9 to add components for a second pendulum link to the right of the last **Rigid Body Frame** component that you added.

**Connecting 3-D Objects**

You will now connect the objects that you added in the previous task.
To connect objects:

1. Click Connect ports ( ).

2. Hover your mouse pointer over the Fixed Frame object. A green dot appears.

3. Click the green dot once to start the connection line.

4. Hover your mouse pointer over the first Revolute joint object. The gray panel at the bottom of the 3-D Workspace displays the names of the Revolute joint frames.

5. Click the Revolute joint object once. A context menu displays the names of the frames to which you can connect the line.
6. Select R1.frame_a. The objects are connected in the 3-D Workspace.

Note that the joint component is drawn in red when it is connected.

7. Click Connect ports (⋮) to start the next connection line.

8. Click the sphere that represents the Revolute joint. A context menu displays the frames of the Revolute joint, as well as the Fixed Frame to which it is connected.

9. From the context menu, select R1.frame_b.
10. Drag your mouse pointer to the end of the cylinder that represents the **Rigid Body Frame** and click the green dot.

11. Click **Connect ports** to start a new connection line.

12. Hover your mouse pointer over the other end of the cylinder that represents the **RBF₁** component and click the cylinder once.

13. Drag your mouse pointer to the sphere that represents the first **Rigid Body** component, **RB₁**, and click it once. **RB₁** is now connected to **RBF₁**.

14. In the same way, connect **frame_a** of **RB₁** to **frame_a** of the second **Rigid Body Frame**, **RBF₂**.

**Note:** Click the connect button to start each connection line.

15. Connect **frame_b** of the second **Rigid Body Frame** to **frame_a** of the second **Revolute joint**.

16. Connect **frame_b** of the second **Revolute joint** to **frame_a** of the third **Rigid Body Frame**.
17. Connect third **Rigid Body Frame** to the second **Rigid Body**, and then connect the second **Rigid Body** to the fourth **Rigid Body Frame**. The complete 3-D model appears below.

In the 2-D model workspace, you will see that all of the components are added and connected accordingly.

**Tip:** As you are building a 3-D model, it is a good practice to switch to the block diagram view periodically to check whether the block diagram is laid out the way you want.

**Setting Initial Conditions for the Joint Components**

In construct mode, you can set initial conditions for joint components by using graphical controls in the **3-D Workspace**.

**Note:** Joint components that have been assigned custom parameter values defined in a parameter block, global parameter, or subsystem parameter will not allow the use of graphical controls for setting initial conditions. In these cases, use the fields in the **Inspector** tab to set the initial conditions.

**To set initial conditions:**

1. In the **3-D Workspace**, to set the initial angle of the first revolute joint, click the sphere that represents the first revolute joint in the **3-D Workspace**. The red sphere, which represents the joint component, is removed temporarily from the **3-D Workspace** and the manipulator for the joint appears.
2. Hover your mouse pointer over the manipulator. The manipulator appears in yellow.

3. Click and drag your mouse pointer around the manipulator to display the meter that represents the initial angle value that you want to set for the revolute joint. A pie graph-shaped meter appears in orange.

   ![Manipulator and Meter](image)

When you drag your mouse pointer, you can adjust the initial angle value for the degree of freedom represented by the graphic. The angle value increases if you drag the mouse pointer up or to the right, and decreases if you drag the mouse pointer down or to the left.

4. Release your mouse button when the meter is at the approximate initial condition value that you want. In the Inspector tab, the $\theta_0$ parameter displays the value that you selected and the implicit geometry is set to that value in the 3-D Workspace.

Tips:

- Alternatively, you can set initial conditions for your model by entering a value for the $\theta_0$ parameter in the Inspector tab. Initial conditions that you specify in the Inspector tab will be shown in the 3-D model.

- To specify precise initial angle conditions, turn on snapping by selecting Enable Rotational Snapping under 3-D Visualization in the Settings tab.

**Animating the 3-D Model**

You will now simulate your 3-D model to generate the animation that can be viewed in the playback window.

To animate the 3-D model:

1. Simulate your model by clicking Run Simulation (▶) in the Main Toolbar. When the simulation is complete, the Visualization Window opens, containing both simulation plots and the 3-D Playback Window.

2. View the 3-D Playback Window. (If the playback window is not visible, double-click 3-D Playback Window in the Plots palette in the left pane of the Visualization Window to view it.)

3. To play the animation, click Play (▶) in the Playback Toolbar.
Exporting a Movie of the 3-D Model

The Export Movie feature allows you to export a recorded simulation as an .mpeg file to users who may not have MapleSim. For more information, see Using MapleSim > Visualizing a 3-D Model > Exporting a Simulation as a Movie in the MapleSim Help system.

4.7 Best Practices: Simulating and Visualizing a Model

This section describes best practices to consider when simulating and visualizing a model.

Use an External C Compiler to Run Simulations With Longer Durations

When you set the compiler parameter to true in the Settings tab/Solver, Maple procedures generated by the simulation engine are translated to C code and then compiled by an external C compiler. As a result, the time required to run a simulation can be reduced. In general, when you use a C compiler to simulate a model, the compilation process will be faster in simulations with longer durations.

Compare Results Generated By Sections of Your Model

For debugging purposes, you may want to view simulation results for a specific section or subsystem in your model. By selecting a section in your model and clicking Disable ( ) above the Model Workspace or pressing Ctrl + E (Command + E for Macintosh), you can exclude part of your model from the next simulation that you run. When you simulate your model, results will appear only for the model sections that you did not exclude. This feature allows you to view simulation results generated by specific sections in your model and compare results without having to delete components from the Model Workspace or build multiple models.

For more information, see Using MapleSim > Simulating a Model > Excluding Objects From a Simulation in the MapleSim Help system.
5 Analyzing and Manipulating a Model

In this chapter:
• Overview (page 125)
• Retrieving Equations and Properties from a Model (page 128)
• Analyzing Linear Systems (page 129)
• Optimizing Parameters (page 131)
• Generating and Exporting C Code from a Model (page 133)
• Generating a Custom Component from External C Code/Library (page 141)
• Working with Maple Embedded Components (page 145)
• Working with a Maple Standard Worksheet (page 145)

5.1 Overview

MapleSim is fully integrated with the Maple environment. You can use Maple commands, templates, custom components, embedded components, plotting tools, and many other technical features to analyze and manipulate the dynamic behavior of a MapleSim model or subsystem. For example, you can use Maple to retrieve and work with model subsystems and equations, test input and output values, translate your model into C code, and perform many other advanced analysis tasks. You can then attach a file of any format in the Attachments palette and save it as part of a MapleSim model.

To start working with your MapleSim model in Maple, you can use the templates available in the Create Attachment window by clicking Template ( ) in the Main Toolbar. These templates are Maple worksheets with pre-built tools for model building and analysis tasks: you first create a MapleSim model and open it in one of the available templates to perform an analysis task in Maple.

MapleSim Templates

The following MapleSim templates are available from the Main Toolbar:

<table>
<thead>
<tr>
<th>Template Name</th>
<th>UI Display Name</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>C Code Generation</td>
<td>Code Generation</td>
<td>Translate your model into C code. For more information, see Generating and Exporting C Code from a Model (page 133)</td>
</tr>
<tr>
<td>Template Name</td>
<td>UI Display Name</td>
<td>Task</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
<td>------</td>
</tr>
<tr>
<td>Custom Component Template</td>
<td>Custom Component</td>
<td>Create a custom modeling component based on a mathematical model. For more information, see <em>Creating Custom Modeling Components</em> (page 67).</td>
</tr>
<tr>
<td>Custom Port Template</td>
<td>Custom Port</td>
<td>Create a custom port for a custom component. For more information, see <em>Creating Custom Modeling Components</em> (page 67).</td>
</tr>
<tr>
<td>Discrete State Space Custom Component</td>
<td>Custom Discrete State Space</td>
<td>Define and generate custom components for a MapleSim model from a discrete state space description.</td>
</tr>
<tr>
<td>Discrete Transfer Functions Custom Component</td>
<td>Custom Discrete Transfer Function</td>
<td>Define and generate custom components for a MapleSim model from a discrete transfer function.</td>
</tr>
<tr>
<td>Data Generation Template</td>
<td>Data Generation</td>
<td>Define and generate a data set to be used in MapleSim, for example, a data set for an interpolation table component. For more information, see <em>Creating a Data Set for an Interpolation Table Component</em> (page 58).</td>
</tr>
<tr>
<td>Equation Extraction Template</td>
<td>Equations</td>
<td>Retrieve equations from linear or nonlinear models. For more information, see <em>Tutorial 6: Using the External C Code/DLL Custom Component Template</em> (page 192).</td>
</tr>
<tr>
<td>Excel Connectivity Template</td>
<td>Excel Connectivity</td>
<td>Import MapleSim parameter sets from, or export MapleSim parameter sets to, an Excel spreadsheet.</td>
</tr>
<tr>
<td>External C Code/DLL Definition</td>
<td>External C/Library Block</td>
<td>Define and generate a MapleSim custom component from external C Code/DLL.</td>
</tr>
<tr>
<td>Linear System Analysis Template</td>
<td>Linear System Analysis</td>
<td>View and analyze the equations of a linear system. For more information, see <em>Analyzing Linear Systems</em> (page 129).</td>
</tr>
<tr>
<td>Linearization</td>
<td>Linearization</td>
<td>Create a linear system object from a MapleSim continuous subsystem.</td>
</tr>
<tr>
<td>Custom Component Template: Modelica Code Definition</td>
<td>Modelica Custom Component</td>
<td>Define and generate a MapleSim custom component from Modelica code.</td>
</tr>
<tr>
<td>Monte-Carlo Simulation Template</td>
<td>Monte Carlo Simulation</td>
<td>Define a random distribution for a parameter and run a simulation using the distribution.</td>
</tr>
<tr>
<td>Multibody Analysis Template</td>
<td>Multibody Analysis</td>
<td>Retrieve multibody equations in a form that is suitable for manipulation and analysis.</td>
</tr>
<tr>
<td>Parameter Optimization Template</td>
<td>Optimization</td>
<td>Analyze and edit the parameters of a model and view possible simulation results in a graph. For more information, see <em>Optimizing Parameters</em> (page 131).</td>
</tr>
<tr>
<td>Template Name</td>
<td>UI Display Name</td>
<td>Task</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Random Data Template</td>
<td>Random Data</td>
<td>Define and generate a set of random data points to be used in MapleSim, for example, a data set for an interpolation table component.</td>
</tr>
<tr>
<td>Sensitivity Analysis</td>
<td>Sensitivity Analysis</td>
<td>Perform parameter sensitivity analysis.</td>
</tr>
<tr>
<td>Worksheet</td>
<td>Worksheet</td>
<td>Create a worksheet by opening a MapleSim Model in an embedded component. For more information, see Working with a Maple Standard Worksheet (page 145)</td>
</tr>
</tbody>
</table>

Alternatively, to edit and analyze a model, you can use the MapleSim application programming interface (API) in a Maple worksheet, beginning with the **LinkModel** command, to link to an existing MapleSim model. For more information about the MapleSim API, refer to the MapleSim help page.

Both methods of performing analysis tasks allow you to use commands from any Maple packages, including **MapleSim** and **DynamicSystems**, to work with your model programmatically.

**Note:** After using a MapleSim template, save the .mw file and then save the .msim file to which the .mw file is attached.

**Tip:** The pre-built analysis tools available in each template are Maple embedded components, which allow you to interact with Maple code through graphical interactive components. The code associated with each embedded component uses commands from Maple packages, including **MapleSim** and **DynamicSystems**.

To view the code associated with an embedded component, right-click (Control-click for Macintosh) any of the tools in the Maple worksheet, select **Component Properties**, and click **Edit**. For more information about embedded components, see the **EmbeddedComponents** topic in the Maple help system.

### Working with MapleSim Equations and Properties in a Maple Worksheet

When viewing and working with MapleSim equations or properties in a Maple template, corresponding parameters, variables, connectors, subscripts and superscripts are mapped and represented differently.

### Mapping MapleSim Programmatic Names to Maple

The programmatic names of certain parameters, variables, and connectors displayed in the Maple worksheet differ from the names displayed for the corresponding elements in the MapleSim interface. For example, if an **Inertia** component is included in a model, the parameter for the initial value of the angular velocity appears as $\omega_0$ in the MapleSim interface and $w_{\text{start}}$ in a Maple worksheet. For more information about the mappings of parameter,
variable, and connector names, see the **MapleSim Component Library** in the MapleSim help system.

**Representing MapleSim Subscripts and Superscripts in Maple**

Subscripts and superscripts in the MapleSim interface are represented differently in a Maple worksheet. Subscripts in the MapleSim interface appear with an underscore character in a Maple worksheet. For example, a connector called \( \text{flange}_a \) in the MapleSim interface appears as \( \text{flange}_a \) in a Maple worksheet. Also, superscripts are formatted as regular characters in a Maple worksheet. For example, a variable called \( a^2 \) in the MapleSim interface would be displayed as \( a2 \) in a Maple worksheet.

**Using Subsystems**

The basic structure for exporting models is the subsystem. A template allows you to select a complete subsystem for which you want to analyze and manipulate. By converting your model or part of your model into a subsystem you can more easily identify the set of modeling components that you want to explore, define the set of inputs and outputs for the subsystem, or identify the components that you want to export as a block component. For best practices on creating subsystems in MapleSim, see *Best Practices: Laying Out and Creating Subsystems* (page 59).

For an example of a basic structure for exporting models, under the **Libraries** tab, browse to the **Examples > User’s Guide Examples > Chapter 5** menu, and then open the **Preparing a Model for Export** example.

**Note:** When generating code for a subsystem, any included ports must be real input or real output ports. When generating code for the top-level system, the system is considered to have no inputs, but all probed values are treated as outputs.

**Tip:** If you want to use your complete model, group all of the components at the top level of your model into a single subsystem.

**5.2 Retrieving Equations and Properties from a Model**

You can use the **Equation Analysis Template** to retrieve, define and analyze equations and properties such as parameters and variables in your model. You can also set initial equations, set the level of equation optimization and generate custom equations. By using Maple commands you can perform detailed equation analysis, assign model equations to a variable or parameter, and define additional system variables and parameters. The features within this template are useful in generating reusable equations when there is more than one subsystem.

For a complete tutorial on how to use the **Equation Analysis Template**, see *Tutorial 7: Using the Equations Template* (page 197).
To retrieve equations and properties

1. In MapleSim, open the model for which you want to retrieve equations or properties.
2. Click Templates (_ARB in the Main Toolbar. The Create Attachment window appears.
3. From the list, select Equations.
4. In the Attachment field, enter a name for the template and click Create Attachment.
   Your model opens in the Equation Extraction Analysis Template in Maple.
5. Using the navigation tools above the model diagram, select the subsystem for which you
   want to view equations. If you want to retrieve equations from the complete system,
   click Main.
6. Click Load Selected Subsystem. The model equations are extracted and the system
   parameters and variables are loaded. The system equations appear in the View Core
   Equations area and are automatically stored in the variable DAEs.

You can now manipulate the equations using any Maple packages, for example, Dynamic-
Systems and MapleSim. For more information about these packages, see the DynamicSys-
tems and MapleSim topics in the Maple help system.

5.3 Analyzing Linear Systems

You can use the Linear System Analysis Template to retrieve, view, and analyze the
equations of a linear system, test system input and output values, and view possible simulation
results in a Bode, Nyquist, or root locus plot.

Note: Linear analysis cannot be performed on the entire system. To perform linear analysis
using the tools in the Analysis and Simulation section of the template, you must select a
subsystem.

To analyze a linear system model from MapleSim:

1. In MapleSim, open the linear system model that you want to analyze.
2. Click Templates (_ARB in the Main Toolbar. The Create Attachment window appears.
3. From the list, select Linear System Analysis.
4. In the Attachment field, enter a name for the template and click Create Attachment.
   Your model is opened in the Linear System Analysis Template in Maple.
5. Using the navigation tools above the model diagram, select the subsystem for which you
   want to view equations.
6. Click Load Selected Subsystem.
7. If an error dialog appears, click OK to close the dialog.
The error informs you that no output is defined for the system. You will specify the output for the system in the next step.

8. In the **Causalize Ports** section, specify the system input and output signals.

   - **To specify an input signal:** Enter **input** in either the **Flow Variable** or **Across Variable** column for a port. Alternatively, you can also enter **0** to have the variable be an input with a value of zero.

   - **To specify an output signal:** Enter **output** in either the **Flow Variable** or **Across Variable** column for a port.

9. Click **Load Selected Subsystem**.

   The linear system object is created and the equations for the system are displayed in the **View Equations** section.

**Parameter and Variable Manipulation (optional)**

You can assign new names for the variables and parameters in your system in the **Parameter and Variable Manipulation** section.

**To assign a new name for a variable or parameter:**

1. Enter the new name in the **New Name** column for the variable or parameter you want to reassign.

2. Click **Reassign Equations**.

   The new name is used in the equations for the system in the **View Equations** section.

If you want to revert to the original names, click **Reset Substitutions** in the **DAE Variables** section.

Select **Save new names for variables and parameters in the model** to use the new names for the variables and parameters in other templates associated with this model.

**Analysis and Simulation**

You can use the tools in the **Analysis and Simulation** section to analyze your linear system and to view the effects of different inputs on the outputs of your system.

For analysis, you can use the following tools:

- Bode plot
- Nyquist plot
- root locus plot.
In the Simulation section you can choose an input signal to apply to the system and then see the effects on the output.

**Create Component**

After you have analyzed and configured your system, you can create a custom component based on the system and attach it to your MapleSim model.

**To create a custom component from your system:**

1. Enter the name for your component in the Model Name text box.
2. Enter a description for your component in the Description text box.
3. Click Create.

Your custom component can be found in the Components palette of the Definitions tab of your MapleSim model. In addition, the Linear Systems Analysis template used to create the custom component is attached to your MapleSim model and can be found under the Project tab, in the Attachments > Custom Components palette.

**Note:** If a linear system representation is already listed in the Attachments palette with the same name, the existing file will be overwritten.

**5.4 Optimizing Parameters**

You can use the Parameter Optimization Template to test the model parameters, view simulation plots, and assign parameters to a Maple procedure to perform parameter sweeps and other advanced optimization tasks.

You can also use commands from the Global Optimization Toolbox to perform parameter optimization tasks. This product is not included with MapleSim. For more information, visit the Maplesoft Global Optimization Toolbox web site at http://www.maplesoft.com/products/toolboxes/globaloptimization/.

**To optimize parameters**

1. In MapleSim, open the linear system model that you want to analyze.
2. Click Templates ( ) in the Main Toolbar. The Create Attachment window appears.
3. From the list, select Optimization.
4. In the Attachment field, enter a name for the template and click Create Attachment. Your model is opened in the Parameter Optimization template in Maple.
5. Using the navigation tools above the model diagram, select the subsystem that you want to analyze. Your subsystem appears in the Model Workspace.
6. In the **Parameter Investigation** section of the template, click **Load System**. The model simulation settings are imported.

7. In the **Parameter Values** section, select the parameter that you want to test from the first **choose...** list.

![Parameter Values Section](image)

**Note:** When a parameter is selected, its assigned value is shown in the field next to the slider.

![Parameter Slider](image)

8. In the **Range** fields beside the slider and parameter value field, specify the range of the slider. By default, the range is 0 to 10 unless the selected parameter value is outside of this range.

9. Using the process described above, select other parameters that you want to test.

When you have defined all of the parameters, you can move the sliders to test different values and view possible simulation results in the model by clicking **Update Parameters in MapleSim Model** and running your simulation in MapleSim. You can also generate procedures by assigning the parameters you defined to a Maple procedure to perform further analysis tasks in the **Parameter Optimization** section of the template.

When a procedure is generated you will be able to use that procedure, when called, to run a simulation with the specified parameter values. The procedure returns the simulation result as a Matrix of \(y + I\) values, one column for time and then one column for each probed quantity. This procedure can also be used for parameter sweeps and optimizations.

For more information about Maple procedures, see the Procedures help topic in the Maple help system.
5.5 Generating and Exporting C Code from a Model

If you want to use or test your model in an application that supports the C programming language, you can use the Code Generation Template to translate your model or a subsystem in your model into C code. Access to the basic C code, and the ability to compile and run it, is available in Maple. Extensions of this code are available for a variety of software tools as additional Connector toolboxes.

For a general high-level overview of the MapleSim code export process, refer to Generating Code for Export.

With the Code Generation template, you can define inputs and outputs for the system, set the level of code optimization, generate the source code, and choose the format of the resulting component and library code. You can use any Maple commands to perform task analysis, assign model equations to a variable, group inputs and outputs, and define additional input and output ports for variables.

Note: C code generation now handles all systems modeled in MapleSim, including hybrid systems with defined signal input (RealInput) and signal output (RealOutput) ports.

Whenever you export code or generate equations you often only see a subset of the parameters for that model. The following parameters cannot be exported:

• Multibody parameters cannot be directly exported. Only user-generated parameters that the multibody parameters are assigned using Inspector tab are able to be exported.

• Dependent parameters cannot be exported. If the parameter A is a function of b (A=b, A=sin(b), A=1+3/b, etc.), then A will not be able to be exported. It will be directly substituted for in the equations as a function of b. You will be able to export b.

• Parameters that change the number of equations cannot be exported.

• Parameters for discrete values cannot be exported.

The process of generating C code from a MapleSim model consists of the following steps:

• Preparing the MapleSim model

• Attaching the code generation template

• Loading the subsystem

• Customizing, defining, and assigning parameter values to specific ports
• Selecting the code generation options
• Generating and saving the C code

Preparing the Model for Export in MapleSim

The basic structure for exporting models is the subsystem where you define the input and output signals from the generated code. By creating a subsystem you also improve the visual layout of a system in the **Model Workspace**. The following figure shows a subsystem with a defined input (blue arrow) and a defined output (white arrow). When generating code for a subsystem, all ports must be defined as real input or real output ports.

![Subsystem Diagram](image)

When generating code for the top-level system, there are no inputs, but all probed values are considered as outputs, as shown in the following figure.

![Top-Level System Diagram](image)

**Tip:** If you want to generate code for your complete model, group all of the components at the top level of your model into a single subsystem.

In addition to inputs and outputs, generated code can have user-modifiable parameters defined for it. By default, not all parameters are selected to be modifiable in the exported code. In general, the fewer the parameters left modifiable, the less time it will take to generate and run the exported code. By default, only parameters defined in the exported subsys-
tem are selected to be modifiable in the generated code. In the above example, generating code for the RLC subsystem, only the parameters R, L and C will default to being modifiable in the exported code.

![Image of parameters R, L, C with values 1]

**Note:** Since not all parameters are modifiable in the generated code, parameters that change the structure of the equations, by adding or removing variables from the system, are automatically removed from the list of parameters that can be exported. This is true even if the parameters are defined in the exported subsystem.

**Initialization**

All discrete events initialize to the same values as the corresponding MapleSim model. For example, if a clutch is initialized as 'locked' in the MapleSim model, then the generated code assumes that the clutch starts in the 'locked' configuration. The same is true for continuous variables and their derivatives.

Since exported code obtains its initial conditions from an initialized MapleSim model, that code can only be exported for subsystems that are part of a model that can be simulated.

**Note:** If you are unable to run or initialize your model in MapleSim, you will not be able to export code for that model or any of its subsystems.

**Attaching the Code Generation Template**

To attach your model into the template, click **Templates** in the **Main Toolbar** and select **Code Generation**. In the Attachment field, enter a name for the template, and then click **Create Attachment**. Your model opens in the C Code Generation template in Maple.

**Loading the Subsystem**

This part of the template identifies the subsystems that you want to generate and export code for. After selecting a subsystem, click **Load Selected Subsystem**. All defined input and output ports are loaded.
Customizing, Defining, and Assigning Parameter Values to Specific Ports

The Port and Parameter Management interface lets you customize, define and assign parameter values to specific ports. Subsystem components to which you assign the parameter inherit a parameter value defined at the subsystem level.

**Input Variables.** Contains the model input variables.

**Change Row.** Select the equations with the specified row.

**Output Variables.** Contains the model output variables.

**Export.** Enter "X" to select which variables you want to leave in the symbolic form.

**Change Row.** Select the equations with the specified row.

**Add an additional outport.** Select this option to add an additional port for the selected subsystem state variable.
Parameters. Contains the model parameters.

Value. Displays the value for the system parameter.

Export. Enter "X" to select which parameters you want to export in the symbolic form.

Change Row. Select the equations with the specified row.

After the subsystem is loaded you can group individual input and output variable elements into a vector array and add additional input and output ports for customized parameter values. Input ports can include variable derivatives and output ports can include subsystem state variables.

Note: If the parameters are not marked for export they will be numerically substituted.

Selecting the Code Generation Options

The Generation Options settings specify the advanced options for the code generation process.

Solver Options

In this section you can specify the type of solver.

Optimization Options

Set the level of code optimization to specify whether equations are left in their implicit form or converted to an ordinary differential equation (ODE) system during the code generation process. This option specifies the degree of simplification applied to the model equations during the code generation process and eliminates redundant variables and equations in the system.
Select one of the following options:

**None** (0): no optimization is performed; the default equations will be used in the generated code.

**Partial** (1, 2): removes redundant equations from the system.

**Full** (3): performs index reduction to reduce the system to an ODE system or a differential algebraic equation (DAE) system of index 1, and removes redundant equations.

**Constraint Handling Options**

The **Constraint Handling Options** specify whether the constraints are satisfied in a DAE system by using constraint projection in the generated file. Use this option to improve the accuracy of a DAE system that has constraints. If the constraint is not satisfied, the system result may deviate from the actual solution and could lead to an increase in error at an exponential rate.

Set the **Maximum number of projection iterations** to specify the maximum number of times that a projection is permitted to iterate to obtain a more accurate solution.

Set the **Error tolerance** to specify the desirable error tolerance to achieve after the projection.

Select **Apply projection during event iterations** to interpolate iterations to obtain a more accurate solution.

Constraint projection is performed using the **constraint projection** routine in the External Model Interface as described on The MathWorks™ web site to control the drift in the result of the DAE system.

**Event Handling Options**

The **Event Handling Options** section specifies whether the events are satisfied in a DAE system by using event projection in the generated file. Use this option to improve the accuracy of a DAE system with events. If the constraint is not satisfied, the system result may deviate from the actual solution and could lead to an increase in error at an exponential rate.
Set the Maximum number of event iterations to specify the maximum number of times that a projection is permitted to iterate to obtain a more accurate solution.

Set the Width of event hysteresis band to specify the desirable error tolerance to achieve after the projection.

**Baumgarte Constraint Stabilization**

The Baumgarte constraint stabilization method stabilizes the position constraint equations by combining the position, velocity, and acceleration constraints into a single expression. By integrating the linear equation in terms of the acceleration, the Baumgarte parameters, alpha and beta, act to stabilize the constraints at the position level.

**Baumgarte Constraint Stabilization:**

- **Apply Baumgarte constraint stabilization**
- **Export Baumgarte parameters**

**Alpha:** enter a value for the derivative gain that is appropriate to your model.

**Beta:** enter a value for the proportional gain that is appropriate to your model.

**Export Baumgarte parameters:** select this option to have constants for alpha and beta included in the generated C code. This allows you to change the values of alpha and beta in the source code. You can then recompile your code and run it to see the effect on your model.

**Generating and Saving the C code**

**To generate C code**

1. In MapleSim, open the model for which you want to generate code.

2. In the **Model Workspace**, make sure that the components for which you want to generate code are grouped in a subsystem.

3. Click **Templates ( )** in the **Main Toolbar**. The **Create Attachment** window appears.
4. From the list, select **Code Generation**.

5. In the **Attachment** field, enter a name for the template and click **Create Attachment**. Your model opens in the **Code Generation** template in Maple.

6. From the drop down list, select the subsystem for which you want to generate code. The subsystem and its contents appears in the **Subsystem Selection** window.

7. Click the **Load Selected Subsystem** located directly below the model diagram. The subsystem, along with all input and output variables are now loaded into the Code Generation template.

8. In the **C Code Generation Options** section of the template, choose the solver. By default, the Euler solver is selected.

9. Choose where you want to save the code and the name of the file. The file is automatically given a “c” prefix and a “c” extension.

10. Click **Generate C Code**. After the C code is generated, the code can be viewed in the **View C Code** area at the bottom of the template. The C code is also automatically saved to your specified location.
5.6 Generating a Custom Component from External C Code/Library

MapleSim can call external code directly within your model. By using the External C Code/DLL template you can create a custom component to call external C Code and DLL functions directly into your model or subsystem. You can access the basic C code, and then compile and run the code in Maple. Extensions of this code are available for a variety of software tools as additional Connector toolboxes.

With this template, you can define the external inputs and outputs, specify the function name and arguments, generate the source code, and choose the format of the resulting component and library code. You can use any Maple commands to perform task analysis, assign model equations to a variable, group inputs and outputs, and define additional input and output ports for variables.

Changes to the parameters, inputs and outputs are remembered when you re-load your system using the External C Code/DLL template.

The process of creating an external code custom component for a MapleSim model consists of the following steps:

- Specify the custom component name
• Specify the location of the external C/library
• Define the external C/Library code options
• Specify the directory of the generated Modelica code
• Generate and save the external code custom component

Opening the External C Code/DLL Template

Click Templates in the Main Toolbar and select External C/Library Block. In the Attachment field, enter a name for the template, and then click Create Attachment. The template opens in Maple.

Specifying the C/Library Code Location and Options

Use the External C Code/DLL template to define the library code location, and/or validate and assign the code to a model. You can specify a header file, use an existing C or shared library file, or create a new C file using the text area.

Specifying a Header file

If required you can select Specify Header File and provide the location of the existing header file in the Location of Header File text box.

Using an Existing C or Library File

Provide the location of the existing C or Library file in the Location of C/DLL File text box.
Click **Validate and Save C/Library File** to verify the validity of the provided C or Library file.

Click **Validate and Attach C/Library File to MapleSim Model** to verify the validity of the provided C or Library file, and attach it to the MapleSim model. The attachment is saved in the **Project > Attachments > Other** folder.

*Providing External Code in the Text Area*

Select **Provide External Code using Text Area** to expand the text area. Enter the C code in the text area and specify the file location in the **Save to C File** text box.

Click **Validate and Save C/Library File** to verify the validity of the C file. The file is saved to the location specified in the **Save to C File** text box.

Click **Validate and Attach C/Library File to MapleSim Model** to verify the validity of the provided C file and attach it to the MapleSim model. The attachment is saved to the **Attachments > Other** subpalette located in the **Project** tab.

*Using an Attached C or Library File*

If there is an attached C or Library file you can select **Attached C/DLL/SO** and then choose the specific C or Library file from the drop down list.
Defining the C/Library Code Location and Options

You can define the external C/Library function name, specify the external C/Library prototype, choose the parameter name, data type, whether it is an array, and whether it is an input or an output of the external function. The specified inputs and outputs form the inputs and outputs of the custom component.

If necessary click **Remove Parameter** to remove a parameter by its row ID.

If necessary click **Clear Table** to reset the parameter table.

Generating and Saving the C code

To generate the custom component:
1. Specify where you want to save the generated Modelica custom component code.
2. Click **Generate External Code Component**. After the custom component is generated, the code can be viewed in the Source Details area at the bottom of the template. The
template is also automatically saved to the Components palette located in the Definitions tab.

5.7 Working with Maple Embedded Components

Embedded Components are simple graphical interface elements that you embed into a Maple worksheet or document to view, edit, create actions, display information, and analyze the properties of MapleSim models. You can also associate model properties with other Maple embedded components, including sliders and plots to create custom analysis tools.

For example, you can view and change parameter values using commands in the Document-Tools package. Model or subsystem equations can be retrieved using commands from the MapleSim package and you can manipulate your model as a DynamicSystems object to analyze the model or subsystem behavior using any input functions. Embedded Components are inserted using the Components palette.

For more information about advanced analysis tasks, first open the Sliding Table example from the Examples > User's Guide Examples > Chapter 5 palette under the Libraries tab, and then open the AdvancedAnalysis.mw worksheet attachment (from MapleSim, under the Project tab, browse to the Attachments > Documents menu).

5.8 Working with a Maple Standard Worksheet

After you create an attachment for your MapleSim model, you can further interact with and analyze your model in a Maple worksheet by using the application programming interface (API) commands. The MapleSim API is a collection of specialized procedures for manipulating, simulating, and analyzing a MapleSim model in a Maple standard worksheet.

There are two ways to link to a MapleSim model: linking to a MapleSim model using the LinkModel command or through the embedded component facility. The LinkModel command returns a 'connection module' that allows access to a MapleSim model. For more information on how to use the LinkModel command or the embedded component facility, see MapleSim Application Programming Interface Overview and the examples section in the LinkModel description.
6 MapleSim Tutorials

MapleSim Tutorials help you get started with MapleSim and learn about the key features, tools, templates and systems available in MapleSim, by leading you through a series of descriptive tasks, problems and examples using best practices. Many of these examples can be found in the Examples > User's Guide Examples palette in the Libraries tab on the left side of the MapleSim window, in the order that they are presented in the User's Guide.

In this chapter:

- Tutorial 1: Modeling a DC Motor with a Gearbox (page 147)
- Tutorial 2: Modeling a Cable Tension Controller (page 153)
- Tutorial 3: Modeling a Nonlinear Damper (page 157)
- Tutorial 4: Modeling a Planar Slider-Crank Mechanism (page 164)
- Tutorial 5: Using the Custom Component Template (page 172)
- Tutorial 6: Using the External C Code/DLL Custom Component Template (page 192)
- Tutorial 7: Using the Equations Template (page 197)
- Tutorial 8: Modeling Hydraulic Systems (page 204)

6.1 Tutorial 1: Modeling a DC Motor with a Gearbox

In this tutorial, you will extend a DC motor model and perform the following tasks:

- Add a gearbox to the DC motor model
- Simulate the DC motor with gearbox model
- Group the DC motor components into a subsystem
- Assign global parameters to the model
- Add signal block components and a PI controller to the model
- Simulate the modified DC motor model using different conditions

Adding a Gearbox to a DC Motor Model

In this example, you will build the gearbox by adding and connecting an ideal gearbox component, a backlash component with a linear spring and damper, and an inertia component from the 1-D Mechanical library. You can use the selection tool to drag and position components in the Model Workspace.
To add a gearbox:

1. In the Libraries tab, expand the Examples > User's Guide Examples > Chapter 1 menu, and then open the Simple DC Motor example.

2. Delete the existing probe from the workspace.

3. Perform the following tasks:
   - From the 1-D Mechanical > Rotational > Bearings and Gears menu, add an Ideal Gear component to the Model Workspace and place it to the right of the Inertia component.
   - From the 1-D Mechanical > Rotational > Springs and Dampers menu, add an Elasto-Backlash component to the Model Workspace and place it to the right of the Ideal Gear component.
   - From the 1-D Mechanical > Rotational > Common menu, add another Inertia component to the Model Workspace and place it to the right of the Elasto-Backlash component.

4. Connect the components as shown below.

5. In the Model Workspace, click the Ideal Gear component.

6. In the Inspector tab, change the transmission ratio, \( r \), to 10 and then press Enter to accept the value.

7. Specify the following parameter values for the other components:
   - For the Elasto-Backlash component, in the \( b \) field, change the total backlash value to 0.3 rad. In the \( d \) field, change the damping constant to \( 10^4 \text{ N} \cdot \text{m/s rad} \).
   - For the first Inertia component (I_2), in the \( J \) field, change the moment of inertia value to 10 kg \( \cdot \) m^2.
   - For the second Inertia component (I_3), in the \( J \) field, change the moment of inertia value to 1 kg \( \cdot \) m^2.
   - For the Step source, in the height field, change the value to 100.
Simulating the DC Motor with the Gearbox Model

To simulate the DC motor:

1. From the Model Workspace Toolbar, click Attach Probe (_attach探针_).
2. Hover your mouse pointer over the line that connects the Elasto-Backlash component and the second Inertia component (I₃). The line is highlighted.
3. Click the line once, and then click a spot in the workspace to anchor the probe.
4. Select the probe in the Model Workspace.
5. To include the angle (phi), speed (w), acceleration (a), and torque (tau) values in the simulation graphs, in the Inspector tab, select Angle, Speed, Acceleration, and Torque.
6. Click a blank area in the Model Workspace.
7. Under the Settings tab, set the tᵣ parameter to 10 seconds and press Enter.
8. Click Run Simulation (play) in the Main Toolbar. When the simulation is complete, the following graphs appear.
9. To verify the results, in the Libraries tab, expand the Examples > User's Guide Examples > Chapter 6 menu, and then open the DC Motor with Gearbox example.

**Grouping the DC Motor Components into a Subsystem**

**To group the DC motor components:**

1. Using the Selection Tool ( ), draw a box around the electrical components and the first inertia component.

![Diagram of DC Motor components]

2. From the Edit menu, select Create Subsystem.

3. In the Create Subsystem dialog box, enter DC Motor.

4. Click OK. A white block, which represents the DC motor, appears in the Model Workspace.

![Diagram with DC Motor subsystem]

**Tip:** To view the components in the subsystem, double-click the DC Motor subsystem in the Model Workspace. To browse to the top level of the model, click Main (Main) in the Navigation Toolbar.

**Assigning Global Parameters to a Model**

You can define a global parameter and assign its value to multiple components in your model.
To assign global parameters:

1. Click **Main** in the **Navigation Toolbar** to browse to the top level of the model.
2. From the **Navigation Toolbar**, click **Parameters** to switch to the parameter editor view.
3. In the first row of the **Main subsystem default settings** table, define a parameter called **Rglobal** and press **Enter**.
4. Specify a default value of **24** and enter **Global resistance value** as the description.
5. In the second row of the table, define a parameter called **Jglobal** and press **Enter**.
6. Specify a default value of **10** and enter **Global moment of inertia value** as the description.

7. To switch to the diagram view, click **Diagram** in the **Navigation Toolbar**. The new **Rglobal** and **Jglobal** parameters appear in the **Inspector** tab. You can now assign these parameter values to other components in your model.

8. In the **Navigation Toolbar**, click **Parameters**.
9. In the **I₃ component** table, in the **Value** field for the moment of inertia parameter, enter **Jglobal** and press **Enter**. The moment of inertia parameter now inherits the numeric value of the global parameter **Jglobal** (in this example, 10).
10. Switch to the diagram view and double-click the **DC Motor** subsystem.
11. In the **Navigation Toolbar**, click **Parameters**.
12. In the **EMF₁ component** table, in the **Value** field for the transformation coefficient, enter **Rglobal⋅Jglobal** and press **Enter**.

**Note:** This value is an approximation of the transformation coefficient.
13. In the **R₁ component** table, in the **Value** field for the resistance parameter, enter **Rglobal** and press **Enter**.
14. Switch to the diagram view and browse to the top level of your model.
15. Save the model as DC_Motor2.msim.

Changing Input and Output Values

In this example, you will change the input and output values of the model to simulate different conditions.

To change input and output values:
1. Under the Libraries tab, browse to the 1-D Mechanical > Rotational > Sensors menu and then add the Angular Velocity Sensor component to the Model Workspace and place it below the gearbox components.
2. Right-click (Control-click for Macintosh) the Angular Velocity Sensor component and select Flip Horizontal.
3. Delete the connection line between the Step source and the DC Motor subsystem.
4. From the Signal Blocks > Controllers menu, add the PI component to the Model Workspace and place it to the left of the DC Motor subsystem.
5. From the Signal Blocks > Mathematical > Operators menu, add the Feedback component to the Model Workspace and place it to the left of the PI component.
6. Connect the components as shown below.

To draw a perpendicular line, click a point in the Model Workspace to anchor the line and then move your mouse cursor in a different direction to draw the second line segment.

7. Click the PI component in the Model Workspace.
8. In the Inspector tab, specify a gain of 20 in the k field, and a time constant of 3 seconds in the T field.
9. Simulate the model again. When the simulation is complete, the following graphs appear.
10. Save the model as DC_Motor3.msim.

11. To verify the results, in the Libraries tab, expand the Examples > User's Guide Examples > Chapter 6 menu, and then open the DC Motor Subsystem with Gearbox and PI Controller example.

### 6.2 Tutorial 2: Modeling a Cable Tension Controller

In this tutorial, you will extend the DC motor example to model a cable that is stretched with a pre-defined tension. The tension is defined by a Constant source and the PI controller provides the voltage to drive the motor. You will perform the following tasks:

- Build a cable tension controller model
- Specify component properties
- Simulate the cable tension controller model
Building a Cable Tension Controller Model

In this example, you will build the cable tension controller model using a combination of 1-D mechanical rotational and translational components. You will also group components into a Gear subsystem and add subsystem ports.

To build the cable tension controller:

1. Open the DC_Motor3.msim file that you created in the previous tutorial and save the file as Cable_Tension.msim.
2. Delete the probe attached to the line that connects the Elasto-Backlash and Inertia components.
3. Delete Angular Velocity Sensor component and its connection lines.
4. Select the Ideal Gear, Elasto-Backlash, and Inertia components and group them into a subsystem called Gear Components.
5. Add the following components to the Model Workspace:
   - From the 1-D Mechanical > Rotational > Bearings and Gears menu, add the Ideal Rotation to Translation Gear component and place it to the right of the Gear Components subsystem.
   - From the 1-D Mechanical > Translational > Sensors menu, add the Force Sensor component and place it to the right of the Ideal Rotation to Translation Gear component.
   - From the 1-D Mechanical > Translational > Springs and Dampers menu, add the Translational Spring component and place it to the right of the Force Sensor component.
   - From the 1-D Mechanical > Translational > Common menu, add the Translational Fixed component and place it to the right of the Translational Spring component.
6. Right-click (Control-click for Macintosh) the Translational Fixed component in the Model Workspace and select Rotate Counterclockwise.
7. Delete the Step source and replace it with a Constant source from the Signal Blocks > Sources > Real menu.

Tip: You can connect the Constant source by dragging it onto the unconnected line end.
8. Double-click the Gear Components subsystem. You will now add a port to connect this subsystem with other components.
9. Click the negative (white) flange of the Inertia component and drag your mouse cursor to the boundary that surrounds the subsystem components.
10. Click the line once. The subsystem port is added to the line.

11. Click **Main** in the **Navigation Toolbar** to browse to the top level of your model.

12. Connect the components as shown below.

---

**Specifying Component Properties**

To specify component properties:

1. In the **Model Workspace**, double-click the **Gear Components** subsystem.

2. Specify the following parameter values for the subsystem components:
   - For the **Ideal Gear** component, change the transmission ratio value to **0.01**.
   - For the **Inertia** component, change the moment of inertia value to **0.1 kg m²**.

3. Click **Main** in the **Navigation Toolbar** to browse to the top level of the model.

4. Specify the following parameter values for the other components:
   - For the **Translational Spring** component, in the **c** field, change the spring constant value to **2110 \times 10^9 \frac{N}{m}**.
   - For the **PI** controller, change the **T** value to **0.1s**.
• For the **Constant** source, change the constant output value \( k \) to **77.448**.

**Simulating the Cable Tension Controller**

To simulate the cable tension controller:

1. Click **Attach Probe (_attach)**.
2. Click the line that connects the **Feedback** and **PI** components and then click the workspace to position the probe.
3. Select the probe in the **Model Workspace**.
4. In the **Inspector** tab, select the **Real** quantity and change its name to **Error**.
5. Add another probe that measures the **Real** quantity to the line connecting the **PI** component and **DC Motor** subsystem. Change the quantity name to **Controller**.

![Figure 6.1: Cable Tension Controller](image)

6. Click a blank area in the **Model Workspace**.
7. In the **Settings** tab, specify the following parameters:
   - Set the simulation duration time, \( t_d \), to **5 s**.
   - Select **Variable** from the **Solver Type** drop-down menu.
   - Select **RKF45 (non-stiff)** from the **Solver** drop-down menu.
8. Click the **Run Simulation (run)** in the **Main Toolbar**. When the simulation is complete, the following graphs appear.
9. Save the file as `CableTension.msim`.

### 6.3 Tutorial 3: Modeling a Nonlinear Damper

In this tutorial, you will model a nonlinear damper with a linear spring. This tutorial builds upon the concepts demonstrated in the previous tutorials. You will perform the following tasks:

- Generate a custom spring damper defined by differential equations
- Provide custom damping coefficient values as input signals
- Build the nonlinear damper with linear spring model
- Assign a variable to a subsystem
- Simulate the nonlinear damper with linear spring model

#### Generating a Spring Damper Custom Component

This example uses the Nonlinear Spring Damper Custom Component created in `Example: Creating a Nonlinear Spring-Damper Custom Component (page 81)` in Chapter 3.
Providing Damping Coefficient Values

You can provide custom values for interpolation table components that you add to your model. In this example, you will provide damping coefficient values in an external file.

To create damping coefficient values:

1. Create either a Microsoft Excel spreadsheet (.xls) or comma-separated values (.csv) file that contains the following values:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>750</td>
</tr>
<tr>
<td>2</td>
<td>0.05</td>
<td>500</td>
</tr>
<tr>
<td>3</td>
<td>0.1</td>
<td>250</td>
</tr>
<tr>
<td>4</td>
<td>0.2</td>
<td>75</td>
</tr>
<tr>
<td>5</td>
<td>0.25</td>
<td>250</td>
</tr>
<tr>
<td>6</td>
<td>0.3</td>
<td>650</td>
</tr>
</tbody>
</table>

The first column contains values for the relative displacement of the damper and the second column contains values for the damping coefficients.

2. Save the file as **DamperCurve.xlsx** or **DamperCurve.csv**.

3. In MapleSim, expand the **Attachments** palette located under the **Project** tab.

4. Right-click (Control-click for Macintosh) **Data Sets** and select **Attach File**.

5. Browse to and select the Excel spreadsheet or .csv file that you created, and click **Attach**. The file containing the data set is attached to your model. You will use this file in the next task.

Building the Nonlinear Damper Model

In this example, you will build the nonlinear damper using components from the component library.

To build the nonlinear damper:

1. From the **Definitions** tab, drag the **NonLinearSpringDamper** custom component into the **Model Workspace**.

2. Select the **Libraries** tab, and then add the following components to the **Model Workspace**:
   
   - From the **Signal Blocks > Mathematical > Operators** menu, add a **Gain** component and place it above the **NonLinearMSD** component.
   
   - From the **Signal Blocks > Sources > Real** menu, add a **Constant** component and place it between the **NonLinearMSD** and **Gain** components.
• From the **Signal Blocks > Interpolation Tables** menu, add a **1D Lookup Table** component and place it to the left of the **Gain** component.

• From the **1-D Mechanical > Translational > Sensors** menu, add a **Position Sensor** component and place it to the left of the **1D Lookup Table** component.

3. Connect the components as shown in the following figure.

4. Add the following components to the **Model Workspace**:

   • From the **1-D Mechanical > Translational > Common** menu, add a **Translational Fixed** component, place it to the right of the **NonLinearMSD** component, and then rotate it counterclockwise.

   • From the same menu, add **Mass** and **Force** components and place them to the left of the **Position Sensor** component.

   • From the **Signal Blocks > Sources > Real** menu, add a **Step** source.

5. Connect the components as shown in the following figure.

---

**Figure 6.2: Nonlinear Damper Model**

6. In the **Model Workspace**, select the **1D Lookup Table** component.

7. Under the **Inspector** tab, select **attachment** from the **data source** list.
8. Select the attachment you created (either `DamperCurve.xlsx` or `DamperCurve.csv`) from the data list.

9. In the Model Workspace, select the Constant component.
10. In the Inspector tab, in the Name field, change the component name to Stiffness.

11. Select the Step component, and then set height to 100.
12. Select the Mass component, and then change the mass, \( m \), to 100kg.

13. Using the Selection Tool ( ), draw a box around all of the components in the nonlinear damper model.
14. Group the selected components into a subsystem called **Nonlinear Damper**. The complete model is shown in the following figure.

### Assigning a Parameter to a Subsystem

**To assign a parameter to a subsystem:**

1. In the **Model Workspace**, double-click the **Nonlinear Damper** subsystem.
2. In the **Navigation Toolbar**, click **Parameters** ( ).
3. In the first row of the **Nonlinear Damper subsystem default settings** table, define a spring constant parameter called **Ks**, and then press **Enter**.
4. In the same row, specify a default value of 1000 and enter Spring constant as the description. You can now assign the parameter value Ks to other components in the Nonlinear Damper subsystem.

5. In the Navigation Toolbar, click Diagram ( ). The Ks parameter appears as a field in the Inspector tab with the defined default value.

6. In the Model Workspace, select the Stiffness component and change the constant output parameter, k, to Ks. This component now inherits the numeric value of Ks (in this example, 1000). Therefore, if you edit the numeric value of Ks at the subsystem level, the k parameter also inherits that change.

Simulating the Nonlinear Damper with Linear Spring Model

To simulate the nonlinear damper:

1. Click Main in the Navigation Toolbar to browse to the top level of the model.

2. From the Model Workspace Toolbar, click Attach probe ( ). The cursor changes to the probe icon when you move into the workspace.

3. To attach the probe, click the line that connects the Mass component and the Nonlinear Damper subsystem and then click a spot in the workspace to anchor the probe.

4. In the Model Workspace, select the probe.

5. Under the Inspector tab, select the length, speed, and acceleration quantities.
6. Click a blank area in the **Model Workspace**. The length, speed, and acceleration quantities (s, v, a) appear beside the probe.

7. Now, navigate to the **Nonlinear Damper** subsystem: double-click the **Nonlinear Damper** subsystem.

8. Add a probe to the line that connects the **Gain** and **NonLinearMSD** custom component and then click a spot in the workspace to anchor the probe.

9. In the **Model Workspace**, select the probe.

10. Under the **Inspector** tab, select the **Real** quantity and change its name to **Damping**.

11. Under the **Settings** tab, set the \( t_d \) parameter to 10 seconds.

12. Click **Run Simulation** in the **Main Toolbar**. When the simulation is complete, the following graphs appear.
13. Save the file as **NonLinearMSD.msim**.

### 6.4 Tutorial 4: Modeling a Planar Slider-Crank Mechanism

Using components from the Multibody mechanical library, you will model the planar slider-crank mechanism shown in the following figure.

![Planar Slider-Crank Mechanism](image)

**Figure 6.3: Planar Slider-Crank Mechanism**
This model consists of a revolute joint, $A$, which is attached to a planar link. This planar link is attached to a connecting rod by a second revolute joint, $B$. The connecting rod connects to a sliding mass by a third revolute joint, $C$, and the sliding mass connects to ground by a prismatic joint. In practice, this mechanism converts rotational motion at the crank to translational motion at the sliding mass or vice versa. For the system shown in the diagram, gravity is assumed to be the only external force, acting along the negative Y-axis (the $y$-axis for the inertial frame).

In this tutorial, you will perform the following tasks:

- Create a planar link subsystem
- Define and assign subsystem parameters
- Create the crank and connecting rod elements
- Add the fixed frame, sliding mass, and joint elements to the model
- Specify initial conditions
- Simulate the planar slider-crank mechanism

**Creating a Planar Link Subsystem**

The diagram above shows that the slider-crank has two associated planar links: the crank (the link from point $A$ to $B$) and the connecting rod (the link from $B$ to $C$). In both cases, these links have their longitudinal axis along their local x-axis ($x_1$ and $x_2$, respectively). Therefore, you will first create a generic planar link with two ports. The inboard port (base) will be located $-\frac{L}{2}$ units along the x-axis of the link, and the outboard port (tip) will be located $\frac{L}{2}$ units along the x-axis of the link. In this example, $L$ refers to the length of the link and the center-of-mass is assumed to be in the middle of the link.

**To create a planar link subsystem:**

1. Open a new MapleSim document.
2. Under the **Libraries** tab, browse to the **Multibody > Bodies and Frames** menu, and then add two **Rigid Body Frame** components and a **Rigid Body** component.
3. In the **Model Workspace**, right-click (Control-click for Macintosh) one of the **Rigid Body Frame** components, and then select **Flip Horizontal**.
4. Right-click (Control-click for Macintosh) the **Rigid Body** component, and then select **Rotate Counterclockwise**.
5. Drag the components in the arrangement shown below.
Notes:

- If you cannot see the labels for your components, from the View menu, select Show Labels.

- The labels for your components may differ from the labels in the preceding figure (that is, RB, RBF, and RBF₂). You can change the labels in your model by selecting the component, and then entering the new label in the Name field under the Inspector tab. For this tutorial, the labels shown in the preceding figure will be used when referring to specific components.

6. Draw a connection line between the RB component and the right frame of the RBF component.

7. Draw another connection line between the RB component and the left frame of the RBF₂ component.

8. Using the Selection Tool ( ), draw a box around the components.
9. From the **Edit** menu, select **Create Subsystem**.

10. In the **Create Subsystem** dialog box, enter **Link**, and then click **OK**.

You will now add ports to connect this subsystem to other components.

11. Double-click the **Link** subsystem.

12. Click the left frame of the **RBF** component and drag your mouse pointer to the left of the subsystem boundary.

13. Click the line once. A subsystem port is added.

14. In the same way, using the right frame of the **RBF** component, create another port on the right side of the subsystem boundary.
Defining and Assigning Parameters

In this task, you will define a subsystem parameter, $L$, to represent the length of the link and assign the parameter value as a variable to the parameters of the Rigid Body Frame components. The Rigid Body Frame components will then inherit the numeric value of $L$.

To define and assign parameters:

1. If you are not already in the Link1 subsystem, click Main in the Navigation Toolbar, and then double-click the Link1 subsystem.

2. In the Navigation Toolbar, click Parameters ( ), or from the Inspector tab click Add or Change Parameters. The Link subsystem default settings window appears.

3. In the first row of the Link subsystem default settings table, define a parameter called $L$, and then press Enter.

4. Specify a default value of 1 and enter Length as the description.

5. Scroll down to the RBF component section.

6. In the Value field for $\vec{r}_{XYZ}$ specify a position offset of $\left[ -\frac{L}{2}, 0, 0 \right]$, and then select m from the Units drop-down menu. To enter a fraction, use the forward slash key (/).

7. Scroll down to the RBF2 component section.

8. In the Value field for $\vec{r}_{XYZ}$ specify a position offset of $\left[ \frac{L}{2}, 0, 0 \right]$, and then select m from the Units drop-down menu.

Creating the Crank and Connecting Rod Elements

In this task, to create the crank and connecting rod elements, you will add a Link subsystem definition to your model and create Crank and ConnectingRod shared subsystems. You will also assign a different length value to the connecting rod element.

To create the crank and connecting rod elements:
1. Click Main in the Navigation Toolbar to browse to the top level of your model. The Link1 subsystem appears in the Model Workspace.
2. Right-click (Control-click for Macintosh) the Link1 subsystem, and then select Convert to Shared Subsystem. The Create Shared Subsystem window appears. Click OK. A Link subsystem definition is added to the Definitions tab and the Link subsystem in the Model Workspace is converted to a shared subsystem.
3. Select the Link1 shared subsystem in the Model Workspace and in the Inspector tab, in the Name field, change the name of the shared subsystem to Crank.
4. From the Definitions tab, drag the Link icon to the Model Workspace, placing it to the right of the Crank shared subsystem.
5. In the Model Workspace, select the second copy of the Link shared subsystem.
6. In the Inspector tab, change the shared subsystem name to ConnectingRod and change the value of the Length parameter (L) to 2.

Adding the Fixed Frame, Sliding Mass, and Joint Elements

In this task, you will add a Fixed Frame component, a Rigid Body component to represent the sliding mass, and the Revolute joint components.

To add the fixed frame, sliding mass, and joint elements:
1. Under the Libraries tab, expand the Multibody > Bodies and Frames menu, select the Fixed Frame component, and then place it to the left of the Crank shared subsystem.
2. From the same menu, select the Rigid Body component and place it slightly below and to the right of the ConnectingRod shared subsystem.
3. Add the following joints:
   - From the Multibody > Joints and Motions menu, add a Revolute joint between the Fixed Frame component and the crank, a second Revolute joint between the crank and the connecting rod, and a third Revolute joint between the connecting rod and the rigid body.
   - From the same menu, add a Prismatic joint and place it below the Crank subsystem.
5. Right-click (Control-click for Macintosh) the SlidingMass component and select **Flip Horizontal**. In the same way, flip horizontally the revolute joint that is located between the connecting rod and the rigid body.

6. Connect the components as shown in the following figure.

**Tip:** In this example, the default axes of motion for the revolute and prismatic joints line up with the desired axes of motion. For example, the revolute joints initially assume that they rotate about the z-axis of the inboard frame, which always coincides with the inertial Z-axis for XY-planar systems. If you create nonplanar models, you may need to change these axes to make sure that they allow motion along or about the correct directions.

**Specifying Initial Conditions**

You can specify initial condition values for certain components in your model.

**To specify initial conditions:**

1. For the first revolute joint ($R_1$ in the preceding figure), in the $\theta_0$ field, change the initial angle to $\frac{\pi}{4}$ rad.

   **Tip:** To enter $\pi$, type `pi`, press **Ctrl + Space** (or **Command + Shift + Space** for Macintosh), and then select the $\pi$ symbol from the menu.

2. From the IC$_{\theta_{0,0}}$ drop-down menu, select **Strictly Enforce**.
When MapleSim solves for the initial conditions, the first angle will be set to $\frac{\pi}{4}\text{ rad}$ before the angles are set for the other joints.

**Simulating the Planar Slider-Crank Mechanism**

To simulate the planar slider-crank mechanism:

1. From the **Model Workspace Toolbar**, click **Attach Probe**.
2. In the **Model Workspace**, click the white 1-D translational flange (flange_b) at the top right of the **Prismatic** component icon and position the probe.
3. Click the probe in the **Model Workspace**.
4. In the **Inspector** tab, select the **Length** quantity to measure the displacement.
5. In the same way, add a probe that measures the **Angle** quantity to the white 1-D rotational flange (flange_b) at the top right of the **R1** component icon (that is, the revolute joint between the **Fixed Frame** and **Crank** components).
6. Click a blank area in the **Model Workspace**.
7. In the **Settings** tab, expand **Simulation** and set the $t_d$ parameter to **10** seconds.
8. Click **Run Simulation** in the **Main Toolbar**. When the simulation is complete, the following graphs appear.
9. Click Play to see a video of the simulation in the 3-D Visualization Area.

10. Save the file as SliderCrank.msim.

6.5 Tutorial 5: Using the Custom Component Template

This tutorial describes the use of the Custom Component template in various domains in MapleSim. With this template, you can define system parameters and variables, set the level of equation optimization, generate the equations, and then further analyze the resulting equations. You can use any Maple commands to perform detailed equation analysis, assign model equations to a variable or parameter, and define additional system variables and parameters. These features are especially useful in generating reusable equations when there is more than one subsystem.

The Custom Component Templates contain pre-built embedded components that let you extract, manipulate, and analyze the symbolic system equations generated by any MapleSim model. Using various components from the library, you will create models, set initial conditions and component properties, and assign new values to parameters and variables.
In this tutorial, you will use the Custom Component template to extract the equations for various models by performing the following tasks:

- Create the model
- Attach a Custom Component template for the model
- Enter your governing equations
- Set initial conditions by specifying the component properties
- Assign new values to parameters and variables
- Generate the Equations Template
- View, manipulate, and reassign equations
- Simulate and translate an equation to a transfer function
- Map variables from your equations to the ports
- Specify ports for your block
- Create a custom port using the Custom Port template

For a description of the Custom Component Template see *Creating Custom Modeling Components* (page 67).

**Example: Modeling a Temperature Dependent Resistor**

In this tutorial example, you will create a model of an RL circuit using a custom component for the temperature dependent resistor whose resistance varies as

\[ r(t) = R0 \cdot \left( 1 + \frac{(T(t) - TO)^2}{Tk^2} \right) \],

where \( R0 \), \( TO \), and \( Tk \) are parameters.
To create the custom component:

1. Start a new MapleSim model and select Edit > Create Attachment....

2. Select the Custom Component template and then click Create Attachment. The Maple Custom Component template is loaded.

3. In the Equations section, enter in the following system equations to define your component. Press Enter at the end of the line.

\[
eq := \begin{align*}
    v(t) &= vp(t) - vn(t), \\
    r(t) &= R0 \cdot \left(1 + \frac{(T(t) - T0)^2}{TK^2}\right), \\
    v(t) &= i(t) \cdot r(t), \\
    qdot(t) &= i(t) \cdot v(t)
\end{align*}
\]

4. In the Parameters section, click Refresh All.

5. Scroll down to the Ports section.

6. Click Add Port. A new port appears on the left side. This will become the positive electrical pin.

7. From the Type drop-down list, select Electrical.

8. In the drop-down box below the Signal label, select \(vp(t)\). This assigns the across variable of the port.

9. The variables of this port are listed. In the list box click Current = unassigned and in the drop-down list select \(i(t)\). This assigns the through variable of the port.
10. Click **Add Port**. A new port appears on the right side. This will become the negative electrical pin.

11. From the **Type** drop-down box, select **Electrical**.

12. Click the **Style** radio button labeled -. This changes the port style to an unfilled box.

13. In the drop-down box below the **Signal** label, select \( v(t) \). This assigns the across variable of the port.

14. The variables of this port are listed. In the list box click **Current = unassigned**, in the drop-down box select \( i(t) \), and click the +/- button to negate the sign of the signal.

15. Click **Add Port**. A new port appears on the top edge. Click and drag it to the center of the bottom edge.

16. From the **Type** drop-down box, select **Thermal**.

17. Select \( T(t) \) for the **Temperature** variable and \( qdot(t) \) for the **Heat Flow Rate** variable.

18. Click any **Refresh All** button. This updates entries in the **Type** column of the **Variables** table.

19. In the **Variables** table, the types for \( r(t) \) and \( v(t) \) are still listed as **real**. In the table, change the **Type** entries for \( r(t) \) and \( v(t) \) rows to **Resistance** and **Voltage**, respectively. Click **Refresh All** to ensure these are accepted (if not, they revert to **real**).

20. In the **Parameters** table, enter **Resistance** for the type of \( R_0 \), and **Temperature** for both \( T_0 \) and \( T_k \). Assign the **Default** for \( T_0 \) to 300. (The units are Kelvin.) Click **Refresh All** to ensure these are accepted.

21. Open the **Dimensional Analysis** section and click **Check Dimensions**. The message "no issues found" should appear in the text area.

22. In the **Component Generation** section, change the **Name** to **TempResistor**.
23. Click **Generate MapleSim Component** to create your component and to bring you back into the MapleSim environment. The custom component now appears under the **Definitions** tab, in the **Components** palette.

24. Drag the custom component into your model area.

25. Create the model shown in **Figure 6.4** with the components and settings specified in **Table 6.1**.

**Note:** When you build the model, make sure to include the two probes that measure the electrical and thermal quantities.

**Table 6.1: Temperature Dependent Resistor Components**

<table>
<thead>
<tr>
<th>Component</th>
<th>Symbol</th>
<th>Component Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>TempResistor Custom Component</td>
<td><img src="image" alt="Symbol" /></td>
<td>Definitions &gt; Components</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Sine Voltage</td>
<td><img src="image" alt="Symbol" /></td>
<td>Libraries &gt; Electrical &gt; Analog &gt; Common</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Ground</td>
<td><img src="image" alt="Symbol" /></td>
<td>Libraries &gt; Electrical &gt; Analog &gt; Common</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Inductor</td>
<td><img src="image" alt="Symbol" /></td>
<td>Libraries &gt; Electrical &gt; Analog &gt; Common</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Fixed Temperature</td>
<td><img src="image" alt="Symbol" /></td>
<td>Libraries &gt; Thermal &gt; Sources</td>
<td>Set T = 298K</td>
</tr>
</tbody>
</table>

26. Click **Run Simulation** in the **Main Toolbar**. When the simulation is complete, the following graphs appear.
Example: Compliant Contact and Piecewise Functions

In this tutorial example, you will create a model of a bouncing ball using a custom component to model the compliant ground contact.

Figure 6.5: Falling Ball
The prismatic joint in Figure 6.5 models a falling ball by allowing translation of a rigid body along the vertical y-axis. To change the falling ball into a bouncing ball, a custom component models the compliant ground contact using a spring-damper arrangement. The custom component attaches to the 1D translational ports on the prismatic joint with the following conditions:

- The ball will hit ground at s=0 and cause the spring damper to compress (and hence ball position will be at s<0).
- The spring-damper will impart a restoring force of F(t) to the ball until it is above at s=0.

Figure 6.6 shows a diagram of this process.

![Figure 6.6: Bouncing Ball Dynamics](image)

where

\[ f(x) = Ks(t) + B \frac{ds(t)}{dt}, \text{if } s(t) < 0 \]

\[ f(x) = 0 \text{ if } s(t) \geq 0 \]

To create the custom component:
1. Start a new MapleSim model, and then select Edit > Create Attachment....
2. Select the Custom Component template, and then click Create Attachment. The Maple Custom Component template is loaded.
3. In the Equations area, enter in the following equation, parameters, and initial conditions to define your custom component. Press Enter at the end of the line.

\[ eq := [s(t) = sa(t) - sb(t), 0 = Fa(t) + Fb(t), Fa(t) = \text{piecewise}(s(t) < 0, K \cdot s(t) + B \cdot \text{diff}(s(t), t), 0)] \]

4. Scroll down to Ports.
5. Click Refresh All.
6. Click Add Port.
7. Make the left port a **Translational** type. Use style **a** (the default). Associate its **Position** variable with \( sa(t) \) and its **Force** variable with \( Fa(t) \).

8. Add a second port, to the right side.

9. Make the right port a **Translational** type. Select style **b**. Associate its **Position** variable with \( sb(t) \) and its **Force** variable with \( Fb(t) \).

10. Click **Refresh All**.

11. Scroll up to the **Variables** table.

12. In the table, change the **Type** of \( s(t) \) to **Position**. Click **Refresh All**.

13. Scroll up to the **Parameters** table, and change the **Default** value for \( B \) to 10 and \( K \) to 1000. Leave the types as real, for now.

14. Click **Refresh All**.

15. Open the **Dimensional Analysis** section and click **Check Dimensions**. The following expression appears:

\[
B \frac{d}{dt} s(t) \frac{m}{s} + K s(t) m.
\]

This indicates that the units (dimensions) are not consistent; the units associated with each element in the sum are displayed.

16. You can choose to ignore the inconsistency, and the model will work as desired because MapleSim's engine does not use units. Checking dimensional consistency, however, is an easy way to avoid simple algebraic errors. To eliminate the inconsistency, the proper types must be added to parameters \( B \) and \( K \).

17. In the **Parameters** table, enter **Force/Velocity** and **Force/Distance** for the types for \( B \) and \( K \), respectively. Click **Refresh All**. The types update to the equivalent dimensional types, **TranslationalDampingConstant** and **TranslationalSpringConstant**.

18. Rerun the dimensional analysis and run **Check Dimensions** again. "No issues found" will appear.

19. Click **Generate MapleSim Component** to create your component and to bring you back into the MapleSim environment. The custom component now appears in the **Definitions > Components** palette.
Drag the custom component into your workspace and assemble the components shown in Figure 6.7 using the specified model components and their settings from Table 6.2. Ensure that the prismatic joint translates along the y direction.

Figure 6.7: Bouncing Ball
### Table 6.2: Bouncing Ball Multibody Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Symbol</th>
<th>Component Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Component</td>
<td><img src="image1" alt="Custom Component" /></td>
<td>Definitions &gt; Components &gt;</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Rigid Body</td>
<td><img src="image2" alt="Rigid Body" /></td>
<td>Libraries &gt; Multibody &gt; Bodies and Frames</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Fixed Frame</td>
<td><img src="image3" alt="Fixed Frame" /></td>
<td>Libraries &gt; Multibody &gt; Bodies and Frames</td>
<td>Use default settings</td>
</tr>
</tbody>
</table>
| Prismatic         | ![Prismatic Joint](image4) | Libraries > Multibody > Joints and Motions | For the prismatic joint to translate along the y direction, set \( \hat{e}_1 \) to \([0, 1, 0]\)  
For the prismatic joint to try enforcing your translational initial conditions, set \( \text{IC}_{s,v} \) to Treat as Guess 
For an initial displacement, the prismatic joint requires a value > 0. Set \( s_0 \) to 10m |

21. Click **Run Simulation (▶)** in the **Main Toolbar**. When the simulation is complete, the Simulation Results opens, displaying the probe plot.
22. To play the animation of the bouncing ball, switch to the 3-D Playback Window by selecting 3-D Playback Window from the Plots palette in the Simulation Results window.

23. Click Play ( ) in the Playback Toolbar. To create a smoother animation, set Interpolate Intermediate Frames. For more information, see Animating a 3-D Model with Interpolated Frames.

**Example: Custom Ports**

In this tutorial example you will create a pair of custom ports with causal signals, power, and velocity, that are generated by a dummy vehicle model and combined by a monitor block that computes the force, using the relation \( f(t) = \frac{p(t)}{v(t)} \). For the dummy vehicle model we will assume the power is constant, \( p(t) = P \), and the velocity is given by \( v(t) = v_0 + a \cdot t \), where \( P \), \( v_0 \), and \( a \) are parameters.
Create Custom Ports

We need to create two custom ports, an output port named \textit{bus\_out} and an input port named \textit{bus\_in}.

1. Start a new MapleSim model and click \textit{Edit} > \textit{Create Attachment}....
2. Select the \textbf{Custom Port} template and then press \textit{Create Attachment}. The Maple \textbf{Custom Port} template is loaded.
3. In the \textbf{Signals} section, click \textbf{Add Row} twice to add two rows to the table, one for each signal.
4. In the first row, enter $p$ as the \textbf{Signal, Power} as the \textbf{Type, output} in the \textbf{In/Out/Flow} column and "\textit{Vehicle power}" in the \textbf{Description} column (be sure to include the double-quotes).
\textbf{Tip:} You only need to enter the first letter (i/o/f) in the \textbf{In/Out/Flow} column.
5. In the second row, enter $v$ as the \textbf{Signal, Velocity} as the \textbf{Type, output} in the \textbf{In/Out/Flow} column, and "\textit{Vehicle velocity}" in the \textbf{Description} column.
6. Ensure that none of the edited cells are selected (click outside the table), then click \textbf{Refresh}.
7. In the \textbf{Port Generation} section, enter \textit{bus\_out} in the \textbf{Name} field, \textit{vehicle bus port} as a \textbf{Description}, and click the \textbf{output} style radio button.
8. Click \textbf{Generate MapleSim Port} to create the output port. You will automatically return to your MapleSim model.
9. Return to the same template to modify it to create the input port. (If the template is closed, to reopen it, in the \textbf{Project} tab, in the \textbf{Attachments} palette, under \textbf{Documents}, right-click (\textbf{Control}-click for Macintosh) on \textit{CustomPort1.mw} and select \textbf{View}.
10. In the \textbf{Signals} section, click \textbf{Reverse}. This changes outputs to inputs, and vice-versa.
11. In the \textbf{Port Generation} section, change \textit{bus\_out} to \textit{bus\_in} and click the \textbf{input} style radio button.
12. Click \textbf{Generate MapleSim Port} to create the input port. You will automatically return to your MapleSim model.

The two custom ports you have defined appear in the \textbf{Components} palette of the \textbf{Definitions} tab. See CustomPortsFigure.
Create Engine Model

1. We will first create the dummy vehicle model.
2. In MapleSim, click **Edit > Create Attachment...**
3. Select the **Custom Component** template and then click **Create Attachment**. The Maple **Custom Component** template is loaded.
4. In the **Equations** section, enter in the following system equations to define your component. Press **Enter** at the end of the line.

\[ eq := \left[ p(t) = P, \nu(t) = \nu_0 + a \cdot t \right] \]

5. In the **Parameters** section, click **Refresh All**, then change the types for \( P, a, \) and \( \nu_0 \) to **Power**, **Acceleration**, and **Velocity**, respectively.
6. Scroll down to **Ports** section.
7. Click **Add Port**. A new port appears on the left edge. Drag it to the right edge.
8. From the **Type** drop-down menu, select **Custom**. (It is at the bottom of the list.)
9. In the text area below the **Type** drop-down menu, enter the custom type name: \( bus\textunderscore out \). Click **Apply Custom**.
10. Using the drop-down menu and list box at the bottom of this section, assign the power signal to \( p(t) \) and the velocity signal to \( \nu(t) \). **Figure 6.10** shows the completed Ports section of the template.
11. In the **Dimensional Analysis** section, click **Check Dimensions**. The message *no issues found* should appear.

12. In the **Component Generation** section, change the name to *engine*. Click **Generate MapleSim Component**. The engine component appear in the **Components** palette of the **Definitions** tab.

**Create Monitor Model**

1. In the MapleSim, click **Edit > Create Attachment....**

2. Select the **Custom Component** template and then click **Create Attachment**. The Maple **Custom Component** template is loaded.

3. In the **Equations** section, enter in the following system equation to define your component. Press **Enter** at the end of the line.

\[
eq : = f(t) = \frac{p(t)}{v(t)}
\]

4. In the **Parameters** section, click **Refresh All**.

5. Scroll down to the **Ports** section.

6. Click **Add Port**. A new port appears on the left edge. This will be the bus input.

7. From the **Type** drop-down menu, select **Custom** (at the bottom of the list).

8. In the text area below the **Type** drop-down menu, enter the custom type name: *bus_in*. Click **Apply Custom**.

---

**Figure 6.10: Using a Custom Port**
9. Using the drop-down menu and list box at the bottom of this section, assign the power signal to \( p(t) \) and the velocity signal to \( v(t) \).

10. Click **Add Port**. A new port appears on the right edge. This will be the computed force output.

11. From the **Type** drop-down menu, select **Real Signal**. Click the **out** style radio button. Assign the value signal to \( f(t) \).

12. Click **Refresh All**. In the **Variables** table, change the type of signal \( f(t) \) to **Force**.

13. In the **Dimensional Analysis** section, click **Check Dimensions**. The message \( real_o(t) = f(t) \) N should appear. It indicates that the output port, \( real_o(t) \), is a real signal but is equated to \( f(t) \), which has units of force (Newtons).

14. In the **Component Generation** section, change the name to **monitor**. Click **Generate MapleSim Component**.

**Complete Model**

1. In the MapleSim, drag the **engine** and **monitor** models from the **Definitions > Components** palette into the workspace.

2. Connect the output of the **engine** block to the input of the **monitor** block. Attach a probe to the output of the **monitor** block.
3. Run the simulation. The simulation results show the following probe plot:

![Probe Plot](image)

**Advanced Uses for Custom Components**

You can use the entire range of Maple functionality to derive your system equations in the Custom Component template. This section provides a sample advanced application.

**Example: Modeling a Centrifugal Pump from a Head Flow Rate Curve**

The following hydraulics example demonstrates how to apply extrapolated data from a centrifugal pump into a custom component. Creating a centrifugal pump custom component involves the following tasks.

- Obtain data from a graph
- Generate an equation by fitting the best curve for your data set
- Obtain multi-argument operators
- Apply operators and generate custom component
Figure 6.11: Centrifugal Pump Head Flow Rate Curve

Table 6.3: Centrifugal Pump Data

<table>
<thead>
<tr>
<th>Flow Rate (cubic meters)</th>
<th>Pressure Head (meters)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.01</td>
<td>0.0098</td>
</tr>
<tr>
<td>0.02</td>
<td>0.00874</td>
</tr>
<tr>
<td>0.03</td>
<td>0.00725</td>
</tr>
<tr>
<td>0.04</td>
<td>0.005</td>
</tr>
<tr>
<td>0.05</td>
<td>0.0025</td>
</tr>
</tbody>
</table>

Table 6.4: Circular Pipe Parameters

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>$D$</td>
<td>Pipe hydraulic diameter</td>
<td>0.01 m</td>
</tr>
<tr>
<td>$L$</td>
<td>Pipe length</td>
<td>5 m</td>
</tr>
<tr>
<td>$\epsilon$</td>
<td>Height of internal pipe roughness</td>
<td>1.5 \cdot 10^{-5} m</td>
</tr>
<tr>
<td>$ReL$</td>
<td>Maximum Reynolds number in laminar regime</td>
<td>2000</td>
</tr>
<tr>
<td>$ReT$</td>
<td>Minimum Reynolds number in turbulent regime</td>
<td>4000</td>
</tr>
<tr>
<td>$\rho$</td>
<td>Fluid density</td>
<td>rhoFluid</td>
</tr>
<tr>
<td>$\nu$</td>
<td>Fluid kinematic viscosity</td>
<td>nuFluid</td>
</tr>
</tbody>
</table>
### Table 6.5: Centrifugal Pump Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Symbol</th>
<th>Component Location</th>
<th>Its Use</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atmospheric Pressure</td>
<td><img src="image" alt="Symbol" /></td>
<td>Libraries &gt; Hydraulic &gt; Reference Components</td>
<td>This component defines a base pressure (similar to ground in the electrical domain) and represents a connection to atmosphere.</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Hydraulic Fluid Properties</td>
<td><img src="image" alt="Symbol" /></td>
<td>Libraries &gt; Hydraulic &gt; Reference Components</td>
<td>All hydraulic models need a Hydraulic Fluid Properties component. Similar to a Parameter block, it is placed in the <strong>Model Workspace</strong> to define the following hydraulic fluid properties: • <strong>rhoFluid</strong>: liquid density • <strong>EIFluid</strong>: Bulk Modulus defines the fluid compressibility • <strong>nuFluid</strong>: Kinematic Viscosity defined as dynamic viscosity divided by liquid density</td>
<td><strong>rhoFluid</strong>: $850 \frac{kg}{m^3}$ <strong>EIFluid</strong>: $8.0 \times 10^8 Pa$ <strong>nuFluid</strong>: $0.000018 \frac{m^2}{s}$</td>
</tr>
<tr>
<td>Circular Pipe</td>
<td><img src="image" alt="Symbol" /></td>
<td>Libraries &gt; Hydraulic &gt; Pipes and Valves</td>
<td>The circular pipe defines a pressure drop in the hydraulic line. The pressure drop is given by the Darcy equation.</td>
<td>See Table 6.4</td>
</tr>
<tr>
<td>Custom Component</td>
<td><img src="image" alt="Symbol" /></td>
<td>Definitions &gt; Components</td>
<td>This custom component defines hydraulic pressure and flow rate properties for the hydraulic line.</td>
<td>User defined</td>
</tr>
</tbody>
</table>

![Figure 6.12: Centrifugal Pump Custom Component](image)
To create the custom component:

1. Start a new MapleSim model and click **Edit > Create Attachment...**

2. Select the **Custom Component** template and then click **Create Attachment**. The Maple Custom Component template loads.

3. In the **Equations** section, insert two document blocks (from the main menu, select **Format > Create Document Block** twice).

4. In the first line you added, place the values from Table 6.3 into the following list, and then press **Enter** at the end of the line to register the list.

   \[ L := [[0.01, 0.0098], [0.02, 0.00874], [0.03, 0.00725], [0.04, 0.005], [0.05, 0.0025]] \]

5. On the next line, fit a quadratic curve to the data points using the following Maple command, and then press **Enter** at the end of the line.

   \[ f := unapply(CurveFitting[LeastSquares](L, x, curve = a \cdot x^2 + b \cdot x + c), x) \]

6. Implement the polynomial in a custom component by defining your equations in terms of the regression curve and parameters for the block. That is, enter in the following system equations, parameters, and initial conditions to define your component. Press **Enter** at the end of the line.

   \[ eq := [P(t) = f(Q(t)) \cdot \rho \cdot g, P(t) = Pr(t) - Pl(t), \rho = 1000, g = 9.81] \]

7. Scroll down to **Ports**.

8. Click **Add Port** to add a port on the left edge. Select the **Hydraulic** type, and assign the **Pressure** variable to \( Pr(t) \) and the **Volume Flow Rate** variable to \( Q(t) \).

9. Click **Add Port** to add a port on the right edge. Select the **Hydraulic** type, chose **style** b, assign the **Pressure** variable \( Pl(t) \) and the **Volume Flow Rate** variable \(-Q(t)\) [click the +/- button to change the sign].

10. Click **Refresh All**.

11. In the **Parameters** table, change the default for \( g \) to 9.81 and assign its type **Acceleration**. For rho, change its default to 1000 and its type to **Density**.

12. In the **Variables** table, change the type for \( P(t) \) to **Pressure**.
13. In the **Dimensional Analysis** section, click **Check Dimensions**. The following expression appears:

\[
\frac{517}{50000} - \frac{13}{5} \frac{Q(t)^2}{s^2} - \frac{137}{5000} \frac{Q(t)}{s} m^3.
\]

This indicates a dimensional inconsistency. Because it is benign we can leave it as is. However, if you prefer to remove the inconsistency, you could replace \( Q(t) \) in the original expressions with \( \frac{Q(t)}{Q_1} \), assign the parameter Q1 the default value 1 with type **VolumeFlowRate** and protect it (add an X to the **Protected** column).

14. In the **Component Generation** section, change the **Name** to **CentrifugalPump**.

15. Click **Generate MapleSim Component** to create your component and to bring you back into the MapleSim environment. The custom component now appears in the **Definitions > Components** palette.

16. Drag the custom component into the **Model Workspace** and create the model shown in **Figure 6.12** using the specified model components and their settings from **Table 6.5**.

**Tip:** To attach the probe on the Circular Pipe component, right-click (Control-click for Macintosh) on component, select **Attach Probe**, and then position the probe by clicking on the workspace.

**Note:** To display the pressure and volume flow rate quantities for your output, select the probe, and then select the **Pressure** and **Volume Flow Rate** quantities from under the **Inspector** tab.

17. Click **Run Simulation** (play button) in the **Main Toolbar**. When the simulation is complete, the following graph appears.
6.6 Tutorial 6: Using the External C Code/DLL Custom Component Template

In this tutorial, you will use the External C Code/DLL template to import external C Code parameters and build your model by performing the following tasks:

- Specify the custom component name
- Specify the location of the external C/library
- Define the external C/Library code options
- Specify the directory of the generated Modelica code
- Generate and save the external code custom component
- Build the Simple External Function model

This model consists of three components, a Step function, a Constant Vector, and an External C Code/DLL custom component.

The external C Code parameters are defined by a function that takes in

- a double scalar input
- an input double array of size 2
- an output double array of size 3

and then returns a double scalar

To create the external code custom component:

1. Start a new MapleSim model that will call the external code.
2. Click Templates ( ) in the Main Toolbar. The Create Attachment window appears.
3. From the list, select External C/Library Block.
4. In the Attachment field, enter a name for the template and click Create Attachment. The External C/Library Block template opens in Maple.
5. Provide 'ExternalCode' as a name for the custom component.

Specify the name of the MapleSim custom component to be generated.

Block Name: ExternalCode

6. Select Provide External Code using Text Area and specify the location for the external C/library in Save to C File.
7. For a Windows platform, in the text area, enter the C code using the function declaration as shown in Figure 6.13. For a Unix platform enter the C code using the function declaration shown in Figure 6.14.

```c
//*************************************************************/
double __stdcall f1(double a, double *b, double *c)
{
    c[0] = a*b;
    c[1] = b[0] + b[1];
    c[2] = c[0]*c[1];
    return 1.0;
}
//*************************************************************/
```

Figure 6.13: External C Code Definition for Windows

```c
//*************************************************************/
double f1(double a, double *b, double *c)
```

Figure 6.14: External C Code Definition for Unix

8. Click Validate and Save C/Library File.

9. In the External C/Library Function Name and Definition section, enter 'f1' for the External Function Name.

10. Use the following values for the double scalar input 'a' as follows and then click Add Parameter. The parameter appears in the Arguments Table as shown in Figure 6.15.
11. Use the following values for the input *double* array 'b' of size 2 as follows and then click **Add Parameter**. The parameter appears in the **Arguments Table** as shown in **Figure 6.15**.

12. Use the following values for the output *double* array 'c' of size 3 as follows and then click **Add Parameter**. The parameter appears in the **Arguments Table** as shown in **Figure 6.15**.

13. Use the following values for the C function return parameter.

14. Specify where you want to save the generated Modelica custom component code.
15. Click **Generate External Code Component**. In MapleSim, the custom component appears under the **Definitions** tab, in the **Components** palette, on the left side of the MapleSim window.

To use the external code custom component:

1. Using the specified model components and their settings from **Table 6.6** drag the components into the **Model Workspace** and set their values.

![Diagram of model components](image)

**Note:** Ensure that the model component parameter values are set in your model. When you select a component in the **Model Workspace**, the configurable parameter values for that component appear in the **Inspector** tab located on the right side of the MapleSim window.

**Table 6.6** shows the required components and their settings.
Table 6.6: External C Code DLL Custom Components and Required Settings

<table>
<thead>
<tr>
<th>Component</th>
<th>Symbol</th>
<th>Component Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Component</td>
<td>![C]</td>
<td>Definitions &gt; Components</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Constant Vector</td>
<td>![Vector]</td>
<td>Libraries &gt; Signal Blocks &gt; Sources &gt; Real</td>
<td><strong>Constant output value</strong>, set ( k ) to [5, 8]</td>
</tr>
<tr>
<td>Step</td>
<td>![Step]</td>
<td>Libraries &gt; Signal Blocks &gt; Sources &gt; Real</td>
<td>Height: 4 ( T_0 : 5 ) Offset: 0</td>
</tr>
</tbody>
</table>

2. Connect the **Step** component to custom component **input port a**.

3. Connect the **Constant Vector** component to custom component **input port b**.

4. Attach a probe to the custom component **output port c** and enter the following values:

5. Attach a probe to the custom component **output port r** and enter the following values:

6. Click **Run Simulation** in the **Main Toolbar**. When the simulation is complete, the following graphs appear.
7. To verify the results, in the Libraries tab, expand the Examples palette, expand the User's Guide Examples menu, and then open the Simple External Code Function example.

6.7 Tutorial 7: Using the Equations Template

In this tutorial, you will use the Equations template to extract the equations for a Spring Damper model by performing the following tasks:

• Create the model
• Generate the Equations Template
• View, manipulate, and reassign equations

The Equations Template contains pre-built embedded components that lets you extract, manipulate, and analyze the symbolic system equations generated by any MapleSim model.

With this template, you can define system parameters and variables, set the level of equation optimization, generate the equations, and further analyze the resulting equations. You can use any Maple commands to perform detailed equation analysis, assign model equations to
a variable, and define additional system variables and parameters. These features are useful in generating reusable equations when there is more than one subsystem.

**Template Description**

The Equations Template is a collection of pre-built controls and procedures associated with specific Maple commands to easily generate equations from MapleSim models. When you simulate a model, all parameter units convert to SI units, allowing you to select more than one system of units for parameter values throughout the model.

The Equations Template consists of two main areas, *Equation Display* and *Equation Manipulation*.

**Equation Display Area**

The *Equation Display* area consists of three sections, *Subsystem Selection*, *Parameter and Variable Manipulation*, and *View Equations*. Use this section to extract the equations for an entire model or one of its subsystems.

**Subsystem Selection**

This section loads the MapleSim model and shows all subsystems and their components. From the toolbar you can select a subsystem and load its subsystem equations.

If no subsystem is selected, equations for the whole model will be loaded when you click *Load Selected Subsystems*.

**Step 1: Subsystem Selection**

![Diagram](image)

*Load Selected Subsystem*. Extracts the model equations and loads the system parameters and variables.
Parameter and Variable Manipulation

In this area you can customize and define parameter and DAE variables for the generated equations.

**DAE Variables**

You can rename the DAE variables by specifying a new variable name in the **New Name** column. For example, variable \( s(t) \) can be changed to \( x(t) \).

- **Variables**. Contains the model DAE variables.
- **New Name**. Provide a new name for the DAE variable.
- **Filter**. Select the equations with the specified variable.
- **Clear Filters**. Clears all selections to show all of the equations.
- **Reset Substitutions**. Resets all changes made in the **New Name** columns for the DAE Variables and Parameters sections.

**Parameters**

You can rename the parameters in the **New Name** column. By default, all equation parameters are substituted by their numeric values. You can manually select which parameters you want to leave in the symbolic form by entering “X” under the **Symbolic** column beside the parameter of interest. In the **Filter** column only equations with the selected variable or parameter are shown. Alternatively, if you want all the parameters in symbolic form, select **Toggle Symbolic**. An “X” will appear beside every parameter. After a symbolic parameter is selected for filtering, it will appear in symbolic form.

- **Parameters**. Contains the model parameters.
New Name. Provide a new name for the model parameter.

Value. Displays the new parameter value as specified in MapleSim.

Symbolic. Enter "X" to select which parameters you want to leave in the symbolic form.

Filters. Select the equations by the specified parameter.

Toggle Symbolic. Switches the parameter symbolic setting selection to all or none.

Clear Filters. Clears all selections to show all of the equations.

Simplify returned equations. Invokes the appropriate simplification procedures, rules and symbolic algorithms to reduce the index of the equation, and searches for function calls, square roots, radicals, and powers. For more information, see the GetEquations help page.

Save new names for variables and parameters in the model. Select this option to store the substitutions made in the New Name columns in the MapleSim model.

Reassign Equations. Click Reassign Equations to update the new equation names and show the changes to the variables and parameters.

View Equations

This area shows the system of equations in symbolic form with the assigned parameters. You can select which equations you want to look at by selecting one of the equation types (DAEs, Definitions, Relations, Events, ODEs, AEs). These equations are automatically assigned to their respective equation variables and can be manipulated in the main body of the Maple worksheet. DAEs are assigned to DAEs, Definitions are assigned to Definitions, and so forth. For more information about equation types, in Maple, enter ?GetEquations at a prompt in a worksheet.

Step 2: View Equations

Equations:

<table>
<thead>
<tr>
<th>Equations Types:</th>
<th>DAEs</th>
<th>Definitions</th>
<th>Relations</th>
<th>Events</th>
<th>ODEs</th>
<th>AEs</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAEs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Equation Manipulation Area

You can also use this template to manually generate additional equations using the GetEquations command to get active MapleSim subsystem equations. For additional equation extraction options see the GetEquations help page. Equations in the template are automatically assigned to the variable DAEs, allowing them to be manipulated in the main body of the Maple worksheet.
**Note:** Maple applies simplification rules to equations stored in their respective equation types by using Maple's `simplify` command if the `simplify` option is set to `true`. For large sets of equations this can take significant amounts of time and memory. For these situations set this option to `false`.

**Generating the Equations for the Spring Damper**

This model consists of a prismatic joint (also called a slider or translational joint) attached to a rigid body, both from the Multibody library. The prismatic joint connects to the Fixed Frame and allows one translational degree of motion along the Y-axis. For this system, gravity is assumed to be the only external force, acting along the Y-axis. You will group these components into a subsystem, define the system parameters and reference the subsystem parameters. For the purpose of this tutorial, you will generate sample equations with pre-defined differential equations.

Ensure that the model component parameter values are set in your model. When you select a component in the **Model Workspace**, the configurable parameter values for that component appear in the **Inspector** tab located on the right side of the MapleSim window.

**Table 6.7** shows the required components and their settings.

<table>
<thead>
<tr>
<th>Component</th>
<th>Symbol</th>
<th>Library Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Frame</td>
<td><img src="image" alt="Fixed Frame" /></td>
<td>Libraries &gt; Multibody &gt; Bodies and Frames</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Rigid Body</td>
<td><img src="image" alt="Rigid Body" /></td>
<td>Libraries &gt; Multibody &gt; Bodies and Frames</td>
<td>Mass, set $m$ to 1 kg</td>
</tr>
</tbody>
</table>
| Prismatic      | ![Prismatic](image) | Libraries > Multibody > Joints and Moments | Translational axis in the y direction, set $\dot{e}_y$ to [0,1,0]  
Spring constant, set $K_s$  
Damping constant, set $K_d$ |

**Generating the System Equations**

**To generate the system equations:**

1. Create the following model using the specified model components and their settings from **Table 6.7**.
2. Place the **Prismatic** joint and **Rigid Body** in a subsystem called **sub**. This allows the Equation Template to generate equations specifically for the selected subsystem.

3. Click **Templates** (.CreateDirectoryIcon) in the **Main Toolbar** and select the **Equations** template.

4. In the **Attachment** field, provide a worksheet name and click **Create Attachment**. Your MapleSim model opens in a Maple worksheet, with the **Subsystem Selection** window. The toolbar shows all of the subsystems.
5. From the toolbar select the \texttt{sub}_1 subsystem. The \textit{sub}_1 subsystem components appear.

6. Click \textbf{Load Selected Subsystem}. The \textit{sub}_1 component parameter and variables load automatically in the \textbf{Parameter} and \textbf{Variable Manipulation} areas.

\textbf{View Equations Area}

The system equations appear in the \textbf{View Equations} area.
Manipulating the Equations for the Spring Damper

By default the above equations are automatically stored in the variable DAEs. In the example below, only part of the equation is shown in the Equation Manipulation section.

The above equations are automatically stored in the corresponding variables

> Vector(DAEs);

> Vector(Definitions);

> Vector(Relations);

> Vector(Events);

> Vector(ODES);

> Vector(AES);

For more control, use the GetEquations command directly:

> A := MapleSim:-LinkModel();

> ret := A:-GetEquations('output' = 'all', 'filter' = {}, 'simplify' = true);

> ret[2]:

> ret[3]:

> ret[4]:

> ret[5]:

> ret[6]:

> ret[7]:

> ret[8]:

6.8 Tutorial 8: Modeling Hydraulic Systems

This tutorial provides you with a basic description of hydraulic systems and helps you understand how to model these systems in MapleSim. Using components from the Hydraulic library, you will create models, set initial conditions and component properties, and assign new values to parameters and variables.

The hydraulic components are designed primarily to convert hydraulic flow into mechanical motion, but can also be used to model pure hydraulic circuits.
In this tutorial, you will perform tasks based on the following basic principles and concepts:

- Basic Hydraulic Library Components
- Basic Hydraulic Equations
- Analysis of Simple Hydraulic Networks
- First Principles Modeling
- Mechanical and Hydraulic Systems

The following sections provide conceptual models that you can build using the hydraulic library components.

- Controlling Hydraulic Flow Path
- Actuating Multibody Systems with Hydraulic Components
- Compressibility of Hydraulic Liquids
- Fluid Inertia Models
- Water Hammer Models
- Hydraulic Custom Components

**Computational Issues**

Hydraulic networks tend to be numerically stiff. Generally, the stiff rosenbrock solver is recommended.

**Basic Hydraulic Library Components**

This tutorial uses the following basic Hydraulic library components.
Table 6.8: Basic Hydraulic Library Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Symbol</th>
<th>Library Location</th>
<th>Its Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atmospheric Pressure</td>
<td><img src="image" alt="Atmospheric Pressure Symbol" /></td>
<td>Libraries &gt; Hydraulic &gt; Reference Components</td>
<td>This component defines a base pressure (similar to ground in the electrical domain) and represents a connection to the atmosphere</td>
</tr>
</tbody>
</table>
| Hydraulic Fluid Properties | ![Hydraulic Fluid Properties Symbol](image) | Libraries > Hydraulic > Reference Components | All hydraulic models need a Hydraulic Fluid Properties component. Similar to a Parameter block, it is placed in the **Model Workspace** to define the following hydraulic fluid properties:  
  - rhoFluid: fluid density  
  - EIFluid: Bulk Modulus is the fluid compressibility  
  - nuFluid: Kinematic Viscosity is the dynamic viscosity divided by liquid density |
| Hydraulic Motor          | ![Hydraulic Motor Symbol](image) | Libraries > Hydraulic > Actuators       | Actuators convert hydraulic flow into the motion of a mechanical body. MapleSim offers a Hydraulic Cylinder (for translational motion) and a Hydraulic Motor (for rotational motion). |
| Hydraulic Cylinder       | ![Hydraulic Cylinder Symbol](image) | Libraries > Hydraulic > Actuators       |                                                                                                                                          |
| Fixed Flow Source        | ![Fixed Flow Source Symbol](image) | Libraries > Hydraulic > Sources         | You can specify either the flow rate or the pressure of the hydraulic source (with MapleSim calculating the other quantity). If a Pressure Source is used, then MapleSim balances the load in the hydraulic system against the pressure source to find the flow rate, and vice-versa. |
| Fixed Pressure Source    | ![Fixed Pressure Source Symbol](image) | Libraries > Hydraulic > Sources         |                                                                                                                                          |
| Circular Pipe            | ![Circular Pipe Symbol](image) | Libraries > Hydraulic > Pipes and Valves | The circular pipe introduces a pressure drop in a hydraulic line. The pressure drop is given by the Darcy equation, with the friction factor being determined by using predefined equations. |
Basic Hydraulic Equations

The Bernoulli and the Darcy equations are the fundamental equations necessary to analyze hydraulic systems and define the fluid pressure and flow rate characteristics for any point along a flow. This tutorial uses the following basic fluid equations.

• Bernoulli Equation
• Darcy Equation
• Friction Factor

Bernoulli Equation

The Bernoulli Equation defines the pressure and flow rate characteristics of incompressible fluid flow in a pipe. For any point along a streamline, the following relationship applies.

\[
\frac{p}{\rho \cdot g} + \frac{V^2}{2 \cdot g} + z = \text{constant}
\]

Darcy Equation

For an incompressible fluid flowing through a pipe with a constant diameter, the pressure drop due to pipe friction is given by the Darcy equation.

\[
\Delta P = f \cdot \frac{L \cdot V^2}{D \cdot 2 \cdot g}
\]

Hence

\[
\frac{p}{\rho \cdot g} + \frac{V^2}{2 \cdot g} + z + f \cdot \frac{L \cdot V^2}{D \cdot 2 \cdot g} = \text{constant}
\]
Table 6.9: Bernoulli and Darcy Equation Notation

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>P</td>
<td>Pressure</td>
<td>Pa</td>
</tr>
<tr>
<td>( \rho )</td>
<td>Density</td>
<td>( \frac{kg}{m^3} )</td>
</tr>
<tr>
<td>g</td>
<td>Gravitational constant</td>
<td>( \frac{m}{s^2} )</td>
</tr>
<tr>
<td>V</td>
<td>Velocity</td>
<td>( \frac{m}{s} )</td>
</tr>
<tr>
<td>z</td>
<td>Elevation</td>
<td>m</td>
</tr>
<tr>
<td>L</td>
<td>Pipe length</td>
<td>m</td>
</tr>
<tr>
<td>D</td>
<td>Pipe diameter</td>
<td>m</td>
</tr>
<tr>
<td>f</td>
<td>Friction factor</td>
<td>dimensionless</td>
</tr>
</tbody>
</table>

Hence pressure must be applied to overcome internal frictional effects within the liquid (in laminar flow), and the effect of the surface roughness of the pipe (in turbulent flow). Frictional losses (and any other loads in the system) have to be balanced against the applied pressure to determine the flow rate.

In MapleSim’s mechanical-hydraulic systems, the vertical displacement \( z \) is insignificant compared to the other terms, and is ignored.

**Friction Factor**

In laminar flow, the internal frictional \( f \) effect is determined by the following equations:

\[
f = \frac{64}{Re}
\]

\[
Re = \frac{D \cdot V}{\nu}
\]

where

- \( f \) is the internal friction
- \( Re \) is the Reynolds number
- \( D \) is the pipe diameter
- \( V \) is the fluid velocity and
- \( \nu \) is the dynamic viscosity
In turbulent flow, the frictional effects of the surface roughness of the pipe are characterized by the **Haaland Equation**.

\[
f = \frac{1}{1.8 \log_{10} \left( \frac{6.9}{Re} + \left( \frac{\epsilon}{3.7 \cdot D} \right)^{1.11} \right)^2}
\]

The Reynolds number (\(Re\)) indicates whether flow in a pipe is in laminar or turbulent flow, or is in transition between the two. For example, the circular pipe parameters in **Table 6.10** gives the Reynolds number for laminar (\(Re_L\)) and turbulent (\(Re_T\)) flow. Between these two parameters, the friction factor is determined by linear interpolation.

**Table 6.10: Circular Pipe Parameters**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>Pipe hydraulic diameter</td>
<td>0.01 m</td>
</tr>
<tr>
<td>L</td>
<td>Pipe length</td>
<td>5 m</td>
</tr>
<tr>
<td>(\epsilon)</td>
<td>Height of internal pipe roughness</td>
<td>1.5 \cdot 10^{-5} m</td>
</tr>
<tr>
<td>(Re_L)</td>
<td>Maximum Reynolds number in laminar regime</td>
<td>2000</td>
</tr>
<tr>
<td>(Re_T)</td>
<td>Minimum Reynolds number in turbulent regime</td>
<td>4000</td>
</tr>
<tr>
<td>(\rho)</td>
<td>Fluid density</td>
<td>(\rho_{\text{fluid}})</td>
</tr>
<tr>
<td>(\nu)</td>
<td>Fluid kinematic viscosity</td>
<td>(\nu_{\text{fluid}})</td>
</tr>
</tbody>
</table>

**Analysis of Simple Hydraulic Networks**

This section simulates a simple hydraulic system and analyzes the results from first principles and explains how to:

- Create a simple laminar pipe flow hydraulic system
- Analyze the governing equations by applying various laws (for example, conservation of mass, Bernoulli Equation, Darcy Equation)

**Flow Through a Pipe**

**Figure 6.16** analyzes pressure and laminar flow rate characteristics through a pipe when pressure is applied to overcome internal frictional effects.

**To analyze flow through a pipe:**

1. Create the following model using the specified model components and their settings from **Table 6.11**.
Tip: To attach the probe on the Circular Pipe component, right-click (Control-click for Macintosh) on the component, select Attach Probe, and then position the probe by clicking on the workspace.

![Flow Through a Pipe Diagram](image)

**Figure 6.16: Flow Through a Pipe**

**Table 6.11: Hydraulic Components and Required Settings**

<table>
<thead>
<tr>
<th>Component</th>
<th>Quantity</th>
<th>Symbol</th>
<th>Library Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atmospheric Pressure</td>
<td>2</td>
<td><img src="image" alt="Symbol" /></td>
<td>Hydraulic &gt; Reference Components</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Hydraulic Fluid Properties</td>
<td>1</td>
<td><img src="image" alt="Symbol" /></td>
<td>Hydraulic &gt; Reference Components</td>
<td>( \rho_{\text{Fluid}}: 850 , \text{kg/m}^3 ) &lt;br&gt;( E_{\text{Fluid}}: 8.0 \times 10^8 , \text{Pa} ) &lt;br&gt;( \nu_{\text{Fluid}}: 0.000018 , \text{m}^2/\text{s} )</td>
</tr>
<tr>
<td>Fixed Pressure Source</td>
<td>1</td>
<td><img src="image" alt="Symbol" /></td>
<td>Hydraulic &gt; Sources</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Circular Pipes</td>
<td>1</td>
<td><img src="image" alt="Symbol" /></td>
<td>Hydraulic &gt; Pipes and Valves</td>
<td>See Table 6.10</td>
</tr>
</tbody>
</table>

2. Click the probe and select the **Real** (the instantaneous Reynolds number), **Pressure**, and **VolumeFlowRate** probe parameters.
3. Click **Run Simulation** (play icon) in the **Main Toolbar**. When the simulation is complete, the following graph appears showing the predicted flow rate of \( Q = \frac{3.2 \times 10^{-9}}{s} \) m³.

**Confirming the Modeling Results from First Principles**

When analyzing the system shown in **Figure 6.16**, apply the Darcy Equation,

\[
\frac{\Delta P}{\rho \cdot g} = f \cdot \frac{L \cdot V^2}{D \cdot 2 \cdot g}
\]

Assuming that the system is in laminar flow, then
Hence

\[ f = \frac{64}{\text{Re}} \]

\[
\frac{1}{850 \times 9.81} = \frac{64}{0.01 \times V} \times \frac{5}{0.01} \times \frac{V^2}{2 \times 9.81}
\]

\[ 0.0001199256461 = 2.935779816 \text{ V} \]

Where

\[ V = 0.0000408 \frac{m}{s} \]

Using \( V \) in the flow rate equation yields the following result

\[ Q = \frac{1}{4} \pi D^2 = 0.0000408 \times \frac{\pi \times 0.01^2}{4} = 3.2 \times 10^{-9} \frac{m^3}{s} \]

This is the same value given by MapleSim. Using the calculated value of \( V \) gives \( \text{Re} = 0.02 \). This is far less than the critical value of 2000, and hence the system is in laminar flow.

**Overview of Controlling Hydraulic Flow Path**

A spool valve has a sharp-edged variable area orifice that enables or partially restricts flow in a pipe, and can assist in switching flow from one part of a hydraulic network to another. A spool valve has three ports.

<table>
<thead>
<tr>
<th>Table 6.12: Spool Valve</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Spool Valve</strong></td>
</tr>
<tr>
<td><img src="image" alt="Spool Valve Diagram" /></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

The top port (inp) accepts a signal input that is equal to the open valve area. By regulating the valve area, flow switches on or off. The left and right ports (portA and portB) are hydraulic connectors. In the following diagram, the model switches flow from the top leg to the bottom leg when the simulation time reaches five seconds. That is, initially, the top spool valve is open and the bottom is closed. After 5 seconds, the top spool valve closes, and the bottom opens.
Mechanical and Hydraulic Systems

In the following examples you will use multidomain components to simulate translational motion in mechanical and hydraulic models with the following sources:

- Fixed Flow Rate Source
- Fixed Pressure Source

Simulating Translational Motion with a Fixed Flow Rate Source

The following model converts flow from a fixed flow source to translational motion using the components and their settings from Table 6.13.
Figure 6.18: Fixed Flow Rate Source
Table 6.13: Translational Motion with Fixed Flow Rate Sources

<table>
<thead>
<tr>
<th>Component</th>
<th>Quantity</th>
<th>Symbol</th>
<th>Library Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atmospheric Pressure</td>
<td>1</td>
<td><img src="image" alt="Atmospheric" /></td>
<td>Hydraulic &gt; Reference Components</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Hydraulic Fluid Properties</td>
<td>1</td>
<td><img src="image" alt="Hydraulic Fluid" /></td>
<td>Hydraulic &gt; Reference Components</td>
<td>rho\text{Fluid}: \frac{850}{m^3} \text{kg}\nE\text{I}\text{Fluid}: 8.0 \times 10^8 \text{Pa}\n\nu\text{Fluid}: 18 \times 10^{-6} \frac{m^2}{s}</td>
</tr>
<tr>
<td>Fixed Flow Source</td>
<td>1</td>
<td><img src="image" alt="Fixed Flow Source" /></td>
<td>Hydraulic &gt; Sources</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Hydraulic Cylinder</td>
<td>1</td>
<td><img src="image" alt="Hydraulic Cylinder" /></td>
<td>Hydraulic &gt; Actuators</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Mass</td>
<td>1</td>
<td><img src="image" alt="Mass" /></td>
<td>1-D Mechanical &gt; Translational &gt; Common</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Translational Fixed</td>
<td>1</td>
<td><img src="image" alt="Translational Fixed" /></td>
<td>1-D Mechanical &gt; Translational &gt; Common</td>
<td>Use default settings</td>
</tr>
</tbody>
</table>

**Note:** The Hydraulic cylinder has a cross-sectional area $A$ of $1 \text{ m}^2$, while the Fixed Flow Source has a flow $Q$ of $1 \text{ m}^3 \text{s}^{-1}$.

The cylinder pushes the sliding mass at a speed of

\[
V = \frac{Q}{A} = \frac{\text{m}^3 \text{s}^{-1}}{\text{m}^2} = \text{m} \text{s}^{-1}
\]

This is confirmed by running the simulation and probing the speed of the sliding mass.
Simulating Translational Motion with a Fixed Pressure Source

Replace the Fixed Flow Source with the Fixed Pressure Source component shown in Figure 6.19 and Table 6.14. The following model converts flow from a fixed pressure source to translational motion.

Figure 6.19: Translational Motion with Fixed Pressure Source
Table 6.14: Translational Motion with a Fixed Pressure Source

<table>
<thead>
<tr>
<th>Component</th>
<th>Symbol</th>
<th>Library Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Pressure Source</td>
<td>![Symbol]</td>
<td>Hydraulic &gt; Sources</td>
<td>Use default settings</td>
</tr>
</tbody>
</table>

The force on the Sliding Mass is equal to the cross-sectional area of the hydraulic cylinder $A$ multiplied by the pressure $P$ of the hydraulic fluid.

$$ F = A \cdot P = 1 \, m^2 \cdot 1 \, Pa = 1 \, N $$

The acceleration of the Sliding Mass is given by

$$ F = m \cdot a = 1 \, m^2 \cdot 1 \, Pa = 1 \, N $$

$$ 1 \, N = 1 \, kg \cdot m $$

Therefore

$$ a = \frac{m}{s^2} $$

By probing the acceleration, speed, and displacement of the Sliding Mass, these values are confirmed with the results in Figure 6.20.
Overview of Actuating Multibody Systems with Hydraulic Components

In the following model connect the 1-D translational port on the hydraulic cylinder to the 1-D translational port on the multibody prismatic joint using a Translation Fixed flange and a Rigid Body mass from Table 6.15.
Similarly in the following model, connect the 1-D rotational port on the hydraulic motor to the 1-D rotational port on the multibody revolute joint using a Rotational Fixed flange and a Rigid Body mass from Table 6.15.

![Rotational Fixed Flange Hydraulic component](image)

**Figure 6.22: Rotational Fixed Flange Hydraulic component**

**Table 6.15: Actuating Multibody Components**

<table>
<thead>
<tr>
<th>Component</th>
<th>Symbol</th>
<th>Library Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Flow Source</td>
<td><img src="image" alt="Symbol" /></td>
<td>Hydraulic &gt; Sources</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Rotational Fixed Flange</td>
<td><img src="image" alt="Symbol" /></td>
<td>1-D Mechanics &gt; Rotational &gt; Common</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Translational Fixed Flange</td>
<td><img src="image" alt="Symbol" /></td>
<td>1-D Mechanics &gt; Translational &gt; Common</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Atmospheric Pressure</td>
<td><img src="image" alt="Symbol" /></td>
<td>Hydraulic &gt; Reference Components</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Hydraulic Cylinder</td>
<td><img src="image" alt="Symbol" /></td>
<td>Hydraulic &gt; Actuators</td>
<td>Use default settings</td>
</tr>
</tbody>
</table>
Pascal's Principle

Pascal's Principle states that pressure applied to a closed hydraulic system is transmitted everywhere equally. This principle shows that an applied force can be amplified to move loads that would otherwise not be possible.

The model in Figure 6.23 demonstrates a simple example of Pascal's Principle. A 1 N force (acting on a 0.1 $m^2$ hydraulic cylinder) transmits hydraulic pressure to a 1 $m^2$ hydraulic cylinder, which lifts a 1 kg load vertically. Normally, a 9.81 N force maintains the height of a 1 kg force, but this simple hydraulic system multiplies the magnitude of a 1 N load by a factor of 10 or $\frac{1 m^2}{0.1 m^2}$. 

<table>
<thead>
<tr>
<th>Component</th>
<th>Symbol</th>
<th>Library Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydraulic Motor</td>
<td>![Symbol]</td>
<td>Hydraulic &gt; Actuators</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Prismatic</td>
<td>![Symbol]</td>
<td>Multibody &gt; Joints and Motions</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Rigid Body Frame</td>
<td>![Symbol]</td>
<td>Multibody &gt; Bodies and Frames</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Rigid Body</td>
<td>![Symbol]</td>
<td>Multibody &gt; Bodies and Frames</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Revolute</td>
<td>![Symbol]</td>
<td>Multibody &gt; Joints and Motions</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Fixed Frame</td>
<td>![Symbol]</td>
<td>Multibody &gt; Bodies and Frames</td>
<td>Use default settings</td>
</tr>
</tbody>
</table>
Overview of Compressibility of Hydraulic Liquids

The compliant cylinder and constant volume chamber components (Table 6.17) model the compressibility of hydraulic liquids under high pressure. The compliant cylinder component also models pipe wall compliance. Both have to be attached to a node between pipes or inertias as shown in Figure 6.24.
### Table 6.16: Hydraulic Liquids Compressibility Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Symbol</th>
<th>Library Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Pressure Source</td>
<td><img src="image1" alt="Symbol" /></td>
<td>Hydraulic &gt; Sources</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Atmospheric Pressure</td>
<td><img src="image2" alt="Symbol" /></td>
<td>Hydraulic &gt; Reference Components</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Linear Resistance</td>
<td><img src="image3" alt="Symbol" /></td>
<td>Hydraulic &gt; Pipes and Valves</td>
<td>Use default settings</td>
</tr>
</tbody>
</table>

### Table 6.17: Confined Hydraulic System Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Quantity</th>
<th>Symbol</th>
<th>Library Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compliant Cylinder</td>
<td>1</td>
<td><img src="image4" alt="Symbol" /></td>
<td>Hydraulic &gt; Chambers</td>
<td>Use default settings</td>
</tr>
<tr>
<td>Constant Volume</td>
<td>1</td>
<td><img src="image5" alt="Symbol" /></td>
<td>Hydraulic &gt; Chambers</td>
<td>Use default settings</td>
</tr>
</tbody>
</table>

### Overview of Fluid Inertia Models

The Fluid Inertia component models the inertia of liquid accelerating or decelerating in a pipe and is analogous to mechanical inertia. Fluid Inertia can be significant for large diameter pipes and when the acceleration/deceleration is large. This component is useful when modeling water hammer.

### Table 6.18: Fluid Inertia

<table>
<thead>
<tr>
<th>Component</th>
<th>Quantity</th>
<th>Symbol</th>
<th>Library Location</th>
<th>Required Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fluid Inertia</td>
<td>1</td>
<td><img src="image6" alt="Symbol" /></td>
<td>Hydraulic &gt; Pipes and Valves</td>
<td>Use default settings</td>
</tr>
</tbody>
</table>
System Without Fluid Inertial

Figure 6.25 shows a system without fluid inertia.

![System Without Fluid Inertia](image)

Figure 6.25: System Without Fluid Inertia

System With Fluid Inertial

Figure 6.25 shows a system with fluid inertia.

![System With Fluid Inertia](image)

Figure 6.26: System With Fluid Inertia

Figure 6.27 shows typical system flow rates with (green) and without (red) fluid inertia. Introducing fluid inertia adds a lag into the system.
Overview of Water Hammer Models

Water hammer occurs when a valve suddenly stops (or significantly restricts) flow in a pipe, resulting in a pressure surge due to a momentum change in the fluid inertia. This pressure surge bounces off the closed valve and travels up and down the pipe, potentially causing significant damage to the entire pipe. Water hammer is traditionally modeled by the numerical solution of the following equations.

\[
\frac{dV(x, t)}{dt} + \frac{1}{\rho} \left( \frac{dP(x, t)}{dt} \right) + \frac{fV(x, t) |V(x, t)|}{2D} = 0
\]

\[
\frac{dV(x, t)}{dx} + \frac{1}{Ks} \frac{dP(x, t)}{dt} = 0
\]

\[
Ks = \frac{1}{\frac{1}{K} + \frac{D}{Et}}
\]

Where

\( V(x,t) \) is the pipe velocity

\( P(x,t) \) is the pipe pressure

\( \rho \) is the liquid density
\( D \) is the pipe diameter

\( t \) is the pipe wall thickness

\( K \) is the liquid bulk modulus

\( E \) is Young’s modulus for the pipe

\( \varphi \) is the friction factor

These equations (with the appropriate boundary and initial conditions) are typically solved numerically, requiring custom code to solve the equations using the method of characteristics.

**Example: Water Hammer**

Another method of simulating water hammer involves building a lumped parameter pipeline model. The pipeline model includes effects such as flow inertia, flow resistance (through pipe friction), pipe compliance, and fluid compressibility.

The following figure shows a discretized pipeline with inertial and resistive properties, initially pressurized at one end to create flow. After two seconds, a valve at the other end is closed, resulting in a pressure surge.

![Figure 6.28: Water Hammer](image)

Each subsystem consists of a compliant cylinder, a pipe, and a fluid inertia component as shown in Figure 6.29. A pipeline (of total length \( L \) and volume \( V \)) with \( N \) segments has \( N + 1 \) pipes, each with a length,
\[ \frac{L}{N + 1} \]

N+1 fluid inertia components, each with a length,

\[ \frac{L}{N + 1} \]

N constant volume chambers, each with a volume,

\[ \frac{V}{N} \]

Figure 6.29: Discretized Pipeline Segment

To build the water hammer model:

1. Build the model with the components and connections shown in Figure 6.28 and Figure 6.29.

2. Configure the **Fluid Properties** component with the values specified in Table 6.19.

Table 6.19: Fluid Properties Values

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Symbol</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>rhoFluid</td>
<td>( \rho )</td>
<td>Fluid density</td>
<td>1000 kg m(^{-3})</td>
</tr>
<tr>
<td>ElFluid</td>
<td>( K )</td>
<td>Fluid Bulk Modulus</td>
<td>200 ( 10^6 ) Pa</td>
</tr>
<tr>
<td>nuFluid</td>
<td>( \nu )</td>
<td>Fluid kinematic viscosity</td>
<td>( \frac{10^{-3} \ m^2}{\rho_{\text{Fluid}} \ s} )</td>
</tr>
</tbody>
</table>

3. Configure the parameter block with the parameters and values shown in Table 6.20.
Table 6.20: Water Hammer Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>$N$</td>
<td>Number of pipe segments</td>
<td>20</td>
</tr>
<tr>
<td>$Dia$</td>
<td>Pipe hydraulic diameter (D)</td>
<td>0.1 m</td>
</tr>
<tr>
<td>$Len$</td>
<td>Pipe Length</td>
<td>25 m</td>
</tr>
<tr>
<td>$Em$</td>
<td>Pipe Young's Modulus (E)</td>
<td>$70 \times 10^9$ Pa</td>
</tr>
<tr>
<td>$ef$</td>
<td>Pipe internal roughness</td>
<td>0.0001 m</td>
</tr>
<tr>
<td>$thickness$</td>
<td>Pipe wall thickness (t)</td>
<td>0.001 m</td>
</tr>
</tbody>
</table>

4. For the **Fixed Pressure** component ($FP_2$ in **Figure 6.28**), set the pressure, $P$, to 500 kPa.

5. Configure the **Circular Pipe** components in **Main** and the **HydraulicPipeline** shared subsystem with the following settings.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>$D$</td>
<td>$Dia$</td>
</tr>
<tr>
<td>$L$</td>
<td>$Len$</td>
</tr>
<tr>
<td>$N + 1$</td>
<td></td>
</tr>
<tr>
<td>$\epsilon$</td>
<td>$ef$</td>
</tr>
<tr>
<td>$Re_L$</td>
<td>2000</td>
</tr>
<tr>
<td>$Re_T$</td>
<td>4000</td>
</tr>
<tr>
<td>$\rho$</td>
<td>$rhoFluid$</td>
</tr>
<tr>
<td>$\nu$</td>
<td>$nuFluid$</td>
</tr>
</tbody>
</table>

6. Configure the **Fluid Inertia** components in **Main** and the **HydraulicPipeline** shared subsystem with the following settings.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A$</td>
<td>$\frac{1}{4} \pi Dia^2$</td>
</tr>
<tr>
<td>$L$</td>
<td>$\frac{Len}{N + 1}$</td>
</tr>
<tr>
<td>$\rho$</td>
<td>$rhoFluid$</td>
</tr>
</tbody>
</table>

7. Configure the **Compliant Cylinder** component in the **HydraulicPipeline** shared subsystem with the following settings.
<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>α</td>
<td>0</td>
</tr>
<tr>
<td>L</td>
<td>$\frac{Len}{N}$</td>
</tr>
<tr>
<td>D</td>
<td>$Dia$</td>
</tr>
<tr>
<td>$D_o$</td>
<td>$Dia + 2*\text{thickness}$</td>
</tr>
<tr>
<td>Em</td>
<td>$Em$</td>
</tr>
<tr>
<td>ν</td>
<td>$\nu\text{Fluid}$</td>
</tr>
<tr>
<td>$El$</td>
<td>$El\text{Fluid}$</td>
</tr>
</tbody>
</table>

8. For the **First Order** component, set $T$ to 0.01s and $y_0$ to 0.01.

9. Configure the **Step** component with the following settings.
   - For **height**, enter -0.009999.
   - For **offset**, enter 0.01.
   - For $T_0$, enter 2s.

10. Under the Settings tab, configure the following Simulation parameters.
    - For $t_d$, enter 3s.
    - For **Solver Type**, select **Variable**.
    - For **Solver**, select **Rosenbrock (stiff)**.

**Figure 6.30** plots the pressure and flow rate at the end of a pipe for a valve that rapidly closes after 2 seconds.
Figure 6.30: Water Hammer Pressure Flow Rate

The maximum pressure is about \(5 \times 10^6 \text{Pa}\), with the liquid reaching a flow rate of \(0.099 \frac{\text{m}^3}{\text{s}}\). The maximum pressure can also be calculated using the Joukousky equation,

\[
\Delta P = \rho c \frac{\Delta Q}{A}
\]

\[
c = \sqrt{\frac{K_e}{\rho}}
\]
If you substitute the parameters from Table 6.19 and Table 6.20 into the preceding equations, and then assume

\[ \Delta Q = 0.099 \, \text{m}^3 \text{s}^{-1} \]

you get

\[ \Delta P \approx 5 \times 10^6 \text{Pa} \]

This result agrees with the MapleSim model.

**Example: Attenuating Water Hammer with an Accumulator**

A hydraulic accumulator is a reservoir, often located near a valve, that stores non-compressible hydraulic fluid under pressure. An accumulator acts as a safety valve by allowing fluid to enter the reservoir when the pressure increases beyond a certain threshold value. This action attenuates the magnitude and frequency of the pressure waves.

MapleSim does not have a built-in Accumulator block, but this functionality is easily modeled with the Custom Component template using the following equations. For a complete description on how to create custom components, see *Creating Custom Modeling Components* (page 67).

\[
eq \begin{align*}
q(t) &= \dot{V}F(t), \ VF(t) \\
Ks \ p(t) &= \begin{cases} 
Vpr + (k \cdot (p(t) - ppr)) & ppr < p(t) \quad p(t) < pmax \\
Vmax + (Ks \ (p(t) - pmax)) & pmax \leq p(t)
\end{cases} \\
k &= \frac{(Vmax - Vpr)}{(pmax - ppr)}
\end{align*}
\]

\[\text{params} := \left[ Vmax = 0.1, \ ppr = 10^5, \ pmax = 3 \cdot 10^6, \ Ks = 4 \cdot 10^{-10}, \ Vpr = 0 \right] \]
initial conditions := \[ VF(0) = 0 \]

Table 6.21: Accumulator Parameters Custom Component

<table>
<thead>
<tr>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vmax</td>
<td>0.1 m</td>
</tr>
<tr>
<td>ppr</td>
<td>100000</td>
</tr>
<tr>
<td>Pmax</td>
<td>3000000</td>
</tr>
<tr>
<td>Ks</td>
<td>(10 \times 10^{-10}) m</td>
</tr>
<tr>
<td>Vpr</td>
<td>0</td>
</tr>
</tbody>
</table>

The following figure shows the same pipeline with a pressure accumulator. After two seconds, a valve at the other end is closed, resulting in a pressure surge. Figure 6.31 shows the pressure surge at the end of a pipeline with an accumulator.
Overview of Hydraulic Custom Components

Two examples of hydraulic custom components are centrifugal pumps and vertical pipes. For a complete description on how to create custom components see *Creating Custom Modeling Components* (page 67).

Centrifugal Pumps

Typically, manufacturers provide head flow rate charts for centrifugal pumps, as shown in Figure 6.32.
Data from these charts is easily implemented into a custom component.

**To implement chart data:**

1. Read several sets of head flow rate points from the plot.
2. Fit these data points to a polynomial using the Maple curve-fitting functionality.
3. Implement the polynomial into a custom component. **Figure 6.33**, for example, shows the custom component equations for a centrifugal pump (including the best-fit parameters).

**Note:** Since the equation is a polynomial, several solutions may exist.

\[
\text{eq} := \left[ P(t) = (d + c \cdot Q(t) + b \cdot Q(t)^2 + a \cdot Q(t)^3) \cdot \rho \cdot g, P(t) = P_r(t) - P_l(t) \right] ;
\]

\[
\text{params} := \left[ a = -3.3521 \times 10^{-8}, b = -0.0000039589, c = 0.009948, d = 35.04, \rho = 1000, g = 9.81 \right] ;
\]

**Figure 6.33: Centrifugal Pump Custom Component Equations**

**Note:** Assigning the value rhoFluid to the Density parameter sets the density to be the value defined in the Hydraulic Fluid Properties component.

**Vertical Pipes**

Since gravity head is usually insignificant in mechanical-hydraulic systems, the base pipe component in MapleSim does not model vertical pipe travel. For low-pressure systems, gravity head can be significant. **Figure 6.34** shows the custom component equations to simulate gravity head.
eq := [dP(t) = rho \cdot g \cdot z, Pin(t) = Pout(t) = dP(t), Qin(t) = Qout(t), ]:
params := [z = 0, rho = 1000, g = 9.81 ]:
initialconditions := [ ]:

Figure 6.34: Gravity Head Custom Component Equations
# 7 Reference: MapleSim Keyboard Shortcuts

## Table 7.1: Opening, Closing, and Saving a Model

<table>
<thead>
<tr>
<th>Task</th>
<th>Windows and Linux</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new model</td>
<td>Ctrl + N</td>
<td>Command + N</td>
</tr>
<tr>
<td>Open an existing model</td>
<td>Ctrl + O</td>
<td>Command + O</td>
</tr>
<tr>
<td>Close the active document</td>
<td>Ctrl + F4 (Windows)</td>
<td>Command + W</td>
</tr>
<tr>
<td></td>
<td>Ctrl + W (Linux)</td>
<td>Command + W</td>
</tr>
<tr>
<td>Save the model as an .msim file</td>
<td>Ctrl + S</td>
<td>Command + S</td>
</tr>
</tbody>
</table>

## Table 7.2: Building a Model in the Block Diagram View

<table>
<thead>
<tr>
<th>Task</th>
<th>Windows and Linux</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel operation while drawing a connection</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Rotate the selected modeling component 90 degrees clockwise</td>
<td>Ctrl + R</td>
<td>Command + R</td>
</tr>
<tr>
<td>Rotate the selected modeling component 90 degrees counter-clockwise</td>
<td>Ctrl + L</td>
<td>Command + L</td>
</tr>
<tr>
<td>Flip the selected modeling component horizontally</td>
<td>Ctrl + H</td>
<td>Command + K</td>
</tr>
<tr>
<td>Flip the selected modeling component vertically</td>
<td>Ctrl + F</td>
<td>Command + F</td>
</tr>
<tr>
<td>Group the selected modeling components into a subsystem</td>
<td>Ctrl + G</td>
<td>Command + G</td>
</tr>
<tr>
<td>Reroute the selected connections</td>
<td>Ctrl + D</td>
<td>Command + D</td>
</tr>
<tr>
<td>Reroute all connections</td>
<td>Ctrl + A</td>
<td>Command + A</td>
</tr>
<tr>
<td>Create subsystem</td>
<td>Ctrl + G</td>
<td>Command + G</td>
</tr>
</tbody>
</table>

## Table 7.3: Browsing a Model in the Block Diagram View

<table>
<thead>
<tr>
<th>Task</th>
<th>Windows and Linux</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the selected modeling component or subsystem in detail</td>
<td>Ctrl + M</td>
<td>Command + M</td>
</tr>
<tr>
<td>Zoom into the model workspace</td>
<td>Ctrl + numeric keypad plus key, or</td>
<td>Command + numeric keypad plus key, or</td>
</tr>
<tr>
<td></td>
<td>Ctrl and move the mouse wheel forward</td>
<td>Command and move the mouse wheel forward</td>
</tr>
<tr>
<td>Zoom out from the model workspace</td>
<td>Ctrl + numeric keypad minus key, or</td>
<td>Command + numeric keypad minus key, or</td>
</tr>
<tr>
<td>Task</td>
<td>Windows and Linux</td>
<td>Macintosh</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scale the model diagram to fit in the model workspace</td>
<td>Ctrl + T</td>
<td>Command + T</td>
</tr>
<tr>
<td>Reset zoom factor to the default zoom factor (100%)</td>
<td>Ctrl + 0 (zero)</td>
<td>Command + 0 (zero)</td>
</tr>
</tbody>
</table>

Table 7.4: Browsing a Model in the 3-D View

<table>
<thead>
<tr>
<th>Task</th>
<th>Windows and Linux</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect ports</td>
<td>Ctrl + Shift + C</td>
<td>Command + Shift + C</td>
</tr>
<tr>
<td>Move the camera around a 3-D model in the perspective view</td>
<td>Ctrl + left mouse button click and drag</td>
<td>Command + mouse click and drag</td>
</tr>
<tr>
<td>Panning a 3-D model</td>
<td>Shift + left mouse button click and drag</td>
<td>Shift + mouse click and drag</td>
</tr>
<tr>
<td>Zoom into or out from the 3-D workspace</td>
<td>Alt + left mouse button click and drag, or move the mouse wheel forward (zoom in), or backward (zoom out)</td>
<td>Alt + mouse click and drag, or mouse wheel</td>
</tr>
<tr>
<td>Refresh 3-D view</td>
<td>Shift + F5</td>
<td>Shift + F5</td>
</tr>
</tbody>
</table>

Table 7.5: Simulating a Model

<table>
<thead>
<tr>
<th>Task</th>
<th>Windows and Linux</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run simulation</td>
<td>F5</td>
<td>F5</td>
</tr>
<tr>
<td>View Visualization window (with simulation results and 3-D construct window) if main MapleSim window is in focus, or bring MapleSim window into focus if another window such as the Visualization window is currently in focus</td>
<td>F6</td>
<td>F6</td>
</tr>
<tr>
<td>Toggle enable/disable selected components or connections to exclude selection from the next simulation</td>
<td>Ctrl + E</td>
<td>Command + E</td>
</tr>
</tbody>
</table>
Table 7.6: Modifying the Plot Window Layout

<table>
<thead>
<tr>
<th>Task</th>
<th>Windows and Linux</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tile plot windows</td>
<td>Shift + T</td>
<td>Shift + T</td>
</tr>
<tr>
<td>Cascade plot windows</td>
<td>Shift + C</td>
<td>Shift + C</td>
</tr>
<tr>
<td>Fit plots in plot window. Automaticaly adjust row heights to fit all plots in a plot window in the available vertical space.</td>
<td>Shift + F</td>
<td>Shift + F</td>
</tr>
</tbody>
</table>

For keyboard shortcuts for 2-D math notation, refer to Using MapleSim > Building a Model > Annotating a Model > Key Combinations for 2-D Math Notation.
## Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-D math notation</td>
<td>Formatting option that allows you to enter mathematical text, such as superscripts, subscripts, and Greek characters.</td>
</tr>
<tr>
<td>3-D workspace</td>
<td>The area of the MapleSim window in which you can build and edit a 3-D model.</td>
</tr>
<tr>
<td>Attached shapes</td>
<td>Shapes that you can display in a 3-D model to create a realistic representation of a system model. Attached shapes include cylinders, trace lines, and CAD geometry that you import from another file.</td>
</tr>
<tr>
<td>Camera</td>
<td>The point of view from which a 3-D scene is viewed.</td>
</tr>
<tr>
<td>Camera tracking</td>
<td>The process by which a camera follows the movement of a target 3-D component that you select. The target component is centered in the 3-D playback window during an animation.</td>
</tr>
<tr>
<td>Custom component</td>
<td>A user-defined component that you can create and add to a MapleSim model using the Custom Component Template.</td>
</tr>
<tr>
<td>Custom library</td>
<td>A collection of modeling components and subsystems that can be saved in a user-defined palette and used in a future MapleSim session.</td>
</tr>
<tr>
<td>Embedded component</td>
<td>Configurable graphical controls, buttons, meters, and other interactive components that you can add to a Maple standard worksheet to analyze, manipulate, and visualize equations and Maple commands.</td>
</tr>
<tr>
<td>Implicit geometry</td>
<td>Default cylinders and spheres that are displayed in a 3-D model to represent modeling components.</td>
</tr>
<tr>
<td>Maple package</td>
<td>A collection of routines or commands that can be used in Maple. Most Maple packages provide a set of commands for a particular mathematical or scientific domain, or field of study.</td>
</tr>
<tr>
<td>MapleSim component library</td>
<td>The default collection of domain-specific modeling components included in MapleSim. These modeling components can be found in the gray palettes in the <strong>Libraries</strong> tab.</td>
</tr>
<tr>
<td>Model workspace</td>
<td>The area of the MapleSim window in which you can build and edit a model in a block diagram view.</td>
</tr>
<tr>
<td>Orthographic view</td>
<td>A type of 3-D view that uses parallel projection and displays lines in the view plane at their &quot;true length.&quot; In MapleSim, you can view a model from front, top, and side orthographic views.</td>
</tr>
<tr>
<td>Perspective view</td>
<td>A 3-D view that allows you to examine and browse a model from any direction in 3-D space.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Probe</td>
<td>The tool used to identify quantities of interest in order to simulate a MapleSim model.</td>
</tr>
<tr>
<td>Shared subsystem</td>
<td>A subsystem copy that shares the same configuration as other subsystems. All shared subsystems are linked to a particular subsystem definition, which defines the configuration.</td>
</tr>
<tr>
<td>Stand-alone subsystem</td>
<td>A subsystem that is not linked to a subsystem definition and can be edited and manipulated independent of other subsystems in a model.</td>
</tr>
<tr>
<td>Subsystem</td>
<td>A collection of modeling components grouped in a single block.</td>
</tr>
<tr>
<td>Subsystem definition</td>
<td>A subsystem block that defines the configuration for a series of shared subsystems.</td>
</tr>
</tbody>
</table>
Index

Symbols
2-D math notation, 56
3-D animation, 122
3-D display controls
   3-D manipulators, 112
   adding a trace, 111
   Attached shapes, 109, 114
   Implicit geometry, 108
   Initial conditions, 121
   Trace lines, 110
3-D model construction, 112
3-D Playback Window, 103
3-D view navigation, 107
3-D views
   Orthographic, 107
   Perspective, 107
3-D workspace, 105
   axis designation, 106

A
Acausal Mapping, 75
Acausal modeling, 2, 5, 7
Across Variables, 3
   Custom components, 76
Adding a Probe, 12
Advanced Simulation Settings, 92
Alpha, 93
Animating the 3-D Model, 122
Annotations, 54
API commands, 145
Arrow convention, 60, 62
Attaching Files to a Model, 51
Attachments palette, 51

B
Baumgarte, 93
   Alpha, 93
   Beta, 93
Best Practices, 65
Building 1-D Translational Models, 62
Building Electrical Models, 60
Building Hydraulic Models, 64
Building Multibody Models, 63
Enforcing Initial Conditions, 65
Laying Out and Creating Subsystems, 59
Simulating and Visualizing a Model, 123
Beta, 93
Building a Model
   Adding and Moving Objects in the 3-D Workspace, 115
   Assembling a 3-D Model, 113
   Displaying Attached Shapes as You Build a 3-D Model, 114
   Moving Objects in the 3-D Workspace, 112
   Using the Unenforce Constraints Button, 114

C
CAD Geometry, 114
Causal modeling, 2, 5, 7
Code generation
   C code, 133
   initialization, 135
   subsystem, 134
Compile optimized, 95
Compiler, 95
Connection lines, 20
   Colors, 20
Connection ports, 20
Conserved Quantity Flow
   arrow convention, 16, 62, 90
Constraint Handling Options, 138
Constraint projection, 93, 138
   During event iterations, 94
   Iterations, 93
   Tolerance, 93
Constraint stabilization, 93
Construct mode, 105, 112
Custom components
   Defining equations, 83
   Defining ports, 83
Editing, 81
External C Code/DLL, 143, 195
modeling from extrapolated data, 187
template, 191
Understanding Custom Components, 69
Custom libraries, 51
Custom plot window, 98

D
DAE Variables, 199
Data sets
creating in Maple, 58
generating for model, 51
Debugging console, 34
Diagnostic Messages, 7, 60
Differential algebraic equations, 1
Drawing, 54

E
Embedded components, 145
EMI Component Options, 137
Equations
  Retrieving, 128
template, 203
Error tolerance, 91
Event hysteresis, 94
Event Iterations, 94
Event Projection, 94
Examples
  Adding Attached Shapes to a Double
  Pendulum Model, 110
  Adding Text Annotation to a Model, 55
  Assigning a Subsystem Parameter to a
  Shared Subsystem, 39
  Building a Double Pendulum Model in
  the 3-D Workspace, 115
  Copying and Pasting a Stand-alone Sub-
  system, 35
  Creating a Custom Library from an Exist-
  ing Model, 52
  Creating a Data Set in Maple, 58
  Creating a Parameter Override, 47
Creating a Subsystem, 24
Creating and Using a Parameter Block, 41
Defining and Assigning a Global Parameter, 37
Editing Shared Subsystems that are
Linked to the Same Subsystem Definition, 29
Nonlinear Spring-Damper Custom Com-
ponent, 85
Plotting Multiple Quantities in Individual
Graphs, 99
Plotting One Quantity Versus Another, 101
Removing the Link Between a Shared
Subsystem and its Subsystem Definition, 33
Resolving Warning Messages in the De-
bbugging Console, 34
External C Code/DLL
custom components, 143, 195

F
Fixed time step, 91
Flow direction, 3

G
Global parameters, 150
Grid
  3-D grid, 114
  using CAD geometry, 114

H
Help pane, 18
Hydraulic Systems, 233
  basic hydraulic equations, 207
  basic hydraulic library components, 205, 209
  Bernoulli Equation, 207
  compressibility, 221
custom component, 230, 232
Darcy Equation, 207
fluid inertia, 222
Friction Factor, 208
Joukousky equation, 229
multibody hydraulic, 218
multidomain, 213
Pascal's principle, 220
spool valve, 212
translational motion, 216
water hammer, 224

I
Implicit geometry, 108
Index 1 error control, 94
Index 1 tolerance, 94
Initial conditions, 47
   Best practices for enforcing initial conditions, 65
      overrides, 50
specifying, 22
   Specifying How Initial Conditions Are Enforced, 23
Initial hysteresis, 94
Initialization, 135
Interpolation tables, 158

J
Jacobian, 93

K
Keyboard Shortcuts, 235
Kinematic Constraints, 114

L
Latest results
   From simulation, 96
Linear systems
   Analyzing, 129

M
MapleSim component library, 5, 7, 17
MapleSim Model
   Embedded components, 145
MapleSim Window, 6
Minimize events, 94
Model tree, 19
Model Workspace, 7
Modelica, 87
Modelica Custom Component, 69
Modeling components
   Connecting, 10
Models
   Building, 8
Multibody
      Best Practices for building multibody models, 63
Multibody Parameter Values, 105

P
Palettes, 7, 17
Parameter block, 40
Parameter optimization, 131
Parameter Override, 47
Parameter Sets, 45
Parameter values, 11
Parameters
   Advanced Parameter Settings, 39, 46
   Advanced Variable Settings, 46
   Global parameters, 37
   Parameter sets, 95
   Parameter values, 21
   Subsystem parameters, 39
Physical Components, 77
Physical models
   Analyzing, 125
   Navigating, 19
Playback mode, 103
Plot events, 95
Plot points, 92
Plot Windows, 101
Plots
   Add Second Variable to Graph, 99
   Set X-Axis Variable, 101
Port and Parameter Management, 136
Probes, 89
   Adding, 12
arrow convention, 16, 62, 90
Probes palette, 95
Progress information messages, 96
Projection, 93
Projection Iterations, 93
Projection Tolerance, 93

S
Scaling, 94
Settings
  Advanced Simulation, 92
  Simulation, 90
Sign convention, 3
Signal Flow, 75
Simulating, 95
Simulation
  Initial Conditions, 97
Simulation duration time, 91, 93
Simulation Graphs, 101
Simulation parameters
  Compiler, 95
  Settings, 90
Simulation results
  Clear message console, 96
  Comparing, 96
  Exporting graph data, 98
  Managing, 97
  Progress Messages, 96
  Snapshots, 97
  Storing, 96
  Viewing, 96
Simulation settings, 90
Simulation start time, 91, 93
Snapshots, 97
  Using, 93
Solver, 91
Solver diagnostics, 94
Solver type, 91
Specifying Component Properties, 11
Stand-alone subsystem, 34
State, 97
Step size, 92
Stored results
  From simulation, 96
Subsystem
  code generation, 134
Subsystem(s)
  Adding a Port, 154
  Adding Multiple Copies of a Subsystem
to a Model, 26
  Adding Subsystem Definitions and
Shared Subsystems to a Model, 28
  Creating and Managing, 24, 150
definition, 27
  Editing multiple instances, 29
  linking, 27
  parameters, 39
  shared, 27
  stand-alone, 34

T
Templates
  Code Generation, 133
  Custom Component, 82
  Equation Analysis, 128
  Linear System Analysis, 129
  Parameter Optimization, 131
  Understanding Custom Components, 70
Through Variables, 3
  arrow convention, 16, 62, 90
  custom components, 76
Time
  Simulation duration, 91, 93
  Simulation end, 91, 93
  Simulation start, 91, 93
Time step, 91
Trace lines, 103, 109, 110, 111, 112
Tutorials, 147
  Basic Tutorial: Modeling an RLC Circuit
  and DC Motor, 15

U
Units
  Specifying Parameter Units, 21
Variable scaling, 94
Variable time step, 91
Visualization, 103
    transparency, 103
Visualization parameters
    Settings, 103